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Introduction: MADe Training

PREREQUISITES

Computer

✓Does it meet recommended requirements?

MADe installation & license

✓Does everyone have a license?

✓Is the license floating network or node-locked?

Training PowerPoint

✓Basis for presentation

Additional Material

✓Guides & Workflows in MADe Help

✓Tutorials available online

Minimum System Requirements

Windows® XP Service Pack 2

AMD Athlon II X2 or Intel Core i3. 2.8 GHz or better

4 GB RAM

30 GB available HDD space

1366x768 HD screen resolution or better

Java 8 SE



Introduction: MADe Training

MEET & GREET

➢What is your name?

➢What is your current position & responsibilities?

➢How do you see the MADe software being used in your organization?



Introduction: MADe Training

COURSE OUTLINE

Introduction: MADe Training

Session 1: MADe Modeling

Session 2: Failure Simulation

Session 3: Safety Analyses

Session 4: Reliability Analyses

Session 5: Maintainability Analyses

Session 6: PHM Analyses

Conclusion: Using MADe
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DISCUSSION – WHAT IS MADE?

• MADe is a modeling tool that allows users to generate a variety of analyses across different engineering 
domains

• The main objective in MADe is to create a suitable model of a platform/system that contains enough detail 
to achieve the analyses/outputs the user requires

• MADe currently has four modules:

• Modeling: System and Mission Modeling

• SRA: Safety and Risk Assessment

• RAM: Reliability, Availability and Maintainability

• PHM: Prognostics and Health Management



Introduction: MADe Training

DISCUSSION – MADE MODULES

What can be done in each module? 

• Modeling: System and Mission Modeling

• Functional Hazard Assessment, Functional system modeling, Mission Profile Definition, Dependency mapping

• SRA: Safety and Risk Assessment

• Failure Mode Effects Analysis (FMEA), Common Mode Analysis (CMA), Critical Item Analysis, Fault Trees 

• RAM: Reliability, Availability and Maintainability

• Reliability Block Diagrams (RBD), Reliability Allocation, Reliability Centred Maintenance, Maintenance Cost Estimates, Markov Analysis, Failure Rate 
Prediction

• PHM: Prognostics and Health Management

• Sensor set design, Diagnostic rule generation, Sensor Set trade study



Session 1: 
MADe Modeling

Modeling of Mission Profile 
and System Architecture



Session 1: MADe Modeling

SESSION 1 OUTLINE

1.1: Navigation

1.2: Project Creation

1.3: Mission Profile Definition (Solution-independent)

1.4: Functional Modeling (Functional Hazards Assessment)

1.5: System Modeling (Logical & Physical)

1.6: System Modeling (Functions)

1.7: MADe Library



Session 1: MADe Modeling

SESSION 1 DISCUSSION

Session 1 will take place in the MADe module

Session 1 is focussed on building a functional mode



Session 1.1: Navigation

SESSION 1.1 OUTLINE

1.1.1: Launching MADe

1.1.2: MADe Workbench Layout

1.1.3: Default Viewers

1.1.4: MADe Modules



Session 1.1: Navigation

EXERCISE 1.1.1 LAUNCHING MADE

➢Method 1: 

➢ Select Windows Start 

➢ Select All Programs/Apps

➢ Select the MADe folder

➢ Select MADe

➢Method 2:

➢ Double-click an existing MADe project file

❖Note: Create a desktop shortcut, or pin MADe to the taskbar/start menu for easy access



Session 1.1: Navigation

EXERCISE 1.1.1 LAUNCHING MADE

➢When first launching MADe you will encounter a window to set up user preferences

➢ Select                  to proceed to the next screen where we will input User details

➢ Enter your Name, Company and Department in their respective fields



Session 1.1: Navigation

EXERCISE 1.1.1 LAUNCHING MADE

➢When first launching MADe you will encounter a window to set up a library

➢ Select the No radio button

➢ We will set the library in a later session

➢ Select                  to continue



Session 1.1: Navigation

DISCUSSION 1.1.2 MADE WORKBENCH LAYOUT

• Default MADe Workbench Layout shown below:



Session 1.1: Navigation

TAXONOMY 1.1.3 MADE WORKBENCH LAYOUT

• A list of sections in the MADe Workbench are shown below:
Taxonomy Definition

Menu The menu consists of a series of drop down boxes that allow navigation throughout the MADe software. The 
main menu allows access to all of the key features in MADe.

Toolbar The toolbar provides access to key features in MADe via icons. These icons provide a shortcut to commonly 
used features for convenience.

Diagram A diagram is one of the main windows in the MADe software. A diagram allows editing of content via a 
graphical representation.

Editor An editor is another main window in MADe. An editor allows the user to write information to the model.

Viewer A viewer is used to display or provide information to the user. Generally viewers allow reading or access of 
data but no ability to edit.

Dialog A pop-up window used to provide additional information. 

Wizard A pop-up window used to provide additional information and perform an action. 



Session 1.1: Navigation

TAXONOMY 1.1.3 DEFAULT VIEWERS

• Table below lists default viewers when opening MADe for the first time:

Taxonomy Definition

Project Explorer Displays system model hierarchy. This may be used to navigate through the system model. 

Failure Concepts Contains the complete failure taxonomy in the MADe software. 

Library Contains a list of all of the user modelled parts, components and systems.

Outline Contains a list of exemplar PHM modelled parts, components and systems.

Palette Contains a list of exemplar PHM modelled parts, components and systems.

Problems Displays all of the current warnings and errors associated with the model.

Properties Contains a concise list of the most used properties of the selected item and provides limited editing capability.



Session 1.1: Navigation

DISCUSSION 1.1.4 MADE MODULES

• What is a Module?

• Modules are groupings of different perspectives or tool-sets in MADe

• Why is it important to select the MADe module?

• Each module is used to conduct specific types of analyses

• Access is enabled/disabled depending on the current active module

• What modules do I have access to?

1. Maintenance Aware Design Environment (MADe) Modeling

2. Safety & Risk Assessment (SRA)

3. Reliability, Availability & Maintainability (RAM)

4. Prognostics & Health Management (PHM)



Session 1.1: Navigation

EXERCISE 1.1.4 MADE MODULES

To select a module:

➢Method 1:

➢ Locate the main toolbar

➢ Select the required module

➢Method 2:

➢ Select View → Open Module → MADe 

❖Note: Hover over a module icon in the main toolbar for a tool-tip



Session 1.1: Navigation

SESSION 1.1 SUMMARY

✓1.1.1: Opening MADe

✓1.1.2: Layout Types in MADe

✓1.1.3: Default Layouts

✓1.1.4: Select MADe module



Session 1.2: Project Creation

SESSION 1.2 OUTLINE

1.2.1: Creating a MADe Project

1.2.2: Project Properties

1.2.3: Project & Application Preferences

1.2.4: Annotation 



Session 1.2: Project Creation

DISCUSSION 1.2.1 CREATING A MADE PROJECT

• What is a Project?

• Projects are the MADe file (or archive) that stores the MADe model and information relevant to a model

• Users can edit and save this file – similar to how a CAD file is updated

• What is the difference between a project and a system?

• A system is the top level item within a project



Session 1.2: Project Creation

EXERCISE 1.2.1 CREATE A NEW PROJECT

To create a new MADe project: 

➢ Select File from the main menu

➢ Select

❖Note: You can open an existing project by selecting File → Open in the main menu or     from the icon toolbar



Session 1.2: Project Creation

EXERCISE 1.2.1 CREATE A NEW PROJECT (CONTINUED)

➢ In the New Project dialog, select                  to select a directory to save the model (e.g. Desktop)

➢Complete the dialog with the following information: 

➢ Project Name: MADe Training

➢ System Name: Vehicle System

➢ Your Name & Organization

➢ Select the appropriate currency from the drop down menu

➢ Select                      



Session 1.2: Project Creation

DISCUSSION 1.2.2 PROJECT PROPERTIES

• What can be edited in the project properties?

• How is version control accomplished in MADe?

EXERCISE 1.2.2 PROJECT PROPERTIES

To access & edit the Project Properties dialog:

➢ Select Edit → Project Properties from the main menu

➢ Populate the following fields: 

➢ Model Version: 1

➢ Department: Engineering

➢ Select 



Session 1.2: Project Creation

DISCUSSION 1.2.3 PROJECT & APPLICATION PREFERENCES

• What is the difference between project and application preferences?

• Application preferences: Settings applied to all projects opened by a specific user profile

• Project preferences: Applied only to a specific or individual MADe Project

• What are the preferences used for?

• Save settings for reuse in future MADe instances



Session 1.2: Project Creation

DISCUSSION 1.2.3 PROJECT PREFERENCES

• Bond Analysis: Bond properties 

• Criticality: Used to adjust default values for criticality

• Currency: Used to change currency for the project

• FCM Analysis: Used to select the FCM Threshold Type

• Naming Templates: Used to customize naming for Functions, Failure Concepts and Flow Property

• Reliability: Used to adjust reliability precision

• Reporting: Reporting information for AIAG/SAE Template



Session 1.2: Project Creation

EXERCISE 1.2.3 PROJECT PREFERENCES

To edit currency in the Project Preferences:

➢ Select Preferences → Project Preferences from main menu

➢ Select Currency tab in the left column

➢ Set or verify currency settings

➢ Select 



Session 1.2: Project Creation

EXERCISE 1.2.3 APPLICATION PREFERENCES

To display flow labels on the system diagram:

➢ Select Preferences → Application Preferences from main menu

➢ Select Modeling in the left column

➢ Select Show Flow Connection Label on Out Flows

➢ Select 



Session 1.2: Project Creation

EXERCISE 1.2.3 ORGANIZATION PREFERENCES

To edit Organization details:

➢ Select Preferences → Application Preferences 
from the main menu

➢ Select Organization Details tab in the left column

➢ Input the Organization details

➢ Organization name, Postal address, Phone number, 
Fax number, Email address, Website

➢ Expand the Organization Details in the tree to 
show ‘Organization Logo’

➢ Upload your Organization Logo which will be used 
in the reports



Session 1.2: Project Creation

DISCUSSION 1.2.4 ANNOTATIONS

• Annotations are used to source and trace model decisions and information

• Annotations can be used to review data quality

• Annotations can be used to trace what work was done, when, and by who



Session 1.2: Project Creation

EXERCISE 1.2.4 ANNOTATIONS PREFERENCES

Annotation policies can be set to adjust confidence in the model 

Custom policies can be created to exclude parameters which users may not want to track

To open the Annotations policy preference page: 

➢ Select Preferences → Annotation Policy from the main menu

➢ Three default policies are provided and MADe Hybrid is set as default
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EXERCISE 1.2.4 ANNOTATIONS PREFERENCES

To create a custom Annotations policy: 

➢ Select Preferences → Annotation Policy from the main menu

➢ Select               

➢ Populate the fields with data as below: 

➢ Policy name: PHMT Annotation Policy 

➢ Description: Custom annotation policy for demonstration purpose

➢ Confidence level of source: Pessimistic

➢ Select                  to save policy and close the window

➢ Check the PHMT Annotation Policy check box

➢ Select



Session 1.2: Project Creation

SESSION 1.2 SUMMARY

✓1.2.1: Creating a MADe Project

✓1.2.2: Project Properties

✓1.2.3: Project & Application Preferences

✓1.2.4: Annotation Preferences



Session 1.3: Mission Profile Definition

SESSION 1.3 OUTLINE

1.3.1: Mission Profile Overview

1.3.2: Mission Profile Editor

1.3.3: Overview / Management Page

1.3.4: Mission Profile Landing Page

1.3.5: Mission Phases and Segments

1.3.6: Mission Success Metrics



Session 1.3: Mission Profile Definition

DISCUSSION 1.3.1 MISSION PROFILE OVERVIEW

• What is the Mission Profile?

• How does this relate to the System / Project?

• Why do Mission Profile before the Model?

• What does solution-independent Mission Profile mean?
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EXERCISE 1.3.2 MISSION PROFILE EDITOR

To open the Mission Profile Editor:

➢Method 1:

➢ Select Modeling→Mission Profile Definitions
from the menu bar

➢Method 2:

➢ Right-click system in the Project Explorer viewer

➢ Select Mission Profiles from the menu



Session 1.3: Mission Profile Definition

DISCUSSION 1.3.3 OVERVIEW/MANAGEMENT PAGE

• The Mission Profile Overview page is where missions are defined

• It also provides a summary of the profile as it is built



Session 1.3: Mission Profile Definition

EXERCISE 1.3.3 OVERVIEW/MANAGEMENT PAGE

To create and begin defining a new mission profile:

➢ Select   to create a new mission profile in the Mission Profiles list

➢ Once a new mission profile is created this will automatically load the New Mission Profile page

❖ Note: You can also open a mission profile/group by double-clicking the item in the table



Session 1.3: Mission Profile Definition

DISCUSSION 1.3.4 MISSION PROFILE LANDING PAGE

• This page is used to add Mission Details, Documents/Images and define key Mission Parameters

❖Note: An Active Mission Profile refers to one currently assigned to the model



Session 1.3: Mission Profile Definition

EXERCISE 1.3.4 MISSION PROFILE LANDING PAGE

To enter Mission Profile Definition Details, in the Mission Profile Details section:

➢ Edit Mission Profile name to: Regular Trip

➢ Verify Number of Mission Cycles as: 1.00

➢ Enter mission profile description: A short duration trip for the vehicle, assuming a benign 
environment and low operational loading.
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EXERCISE 1.3.4 MISSION PROFILE LANDING PAGE (CONTINUED)

To attach documents/images under the Related Documents and Images section: 

➢ Select the add button       to attach a document file

➢ Select the open button       to open an attached file

➢ Select the export button       to export an attached file

➢ Select the delete button       to delete a selected file
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EXERCISE 1.3.4 MISSION PROFILE LANDING PAGE (CONTINUED)

To create a Mission Parameter from the Mission Parameters section:

➢ Select the add button      to create a new Mission Parameter

➢ Enter a Mission Parameter name: Distance

➢ Enter units as: Kilometers

➢ Enter Initial value as: 0.00

➢ Select the Include parameter in Mission Profile Graph check box 

➢ Select the Set this Mission Parameter as an Aggregate Parameter check box

➢ Select
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DISCUSSION 1.3.5 MISSION PHASES & SEGMENTS

• Phases & Segments are defined to divide a mission profile into smaller blocks of time

• Item Duration of Operation is defined based on durations of Phases/Segments & Duty Cycle allocation

• Used to allocate Environment & Environmental Characteristics to Phase/Segments

• Used to track and edit Mission Parameters for each Phase/Segment
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EXERCISE 1.3.5 MISSION PHASES & SEGMENTS

To define Phases, in the Mission Phases and Segments table:

➢ Select      to create a new phase

➢ Enter a phase name: Start-up

➢ Verify Duration is 0.000 minutes (will be inherited from Segment)

➢ Enter description: A mission phase for actions required to start-up the vehicle for use.
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EXERCISE 1.3.5 MISSION PHASES & SEGMENTS (CONTINUED)

To define a Segment, in the Mission Phases and Segments table:

➢ Select Start-up Phase in Mission Phases & Segments Table

➢ Select      to create a new segment

➢ Enter a Phase name as: Ignition

➢ Enter duration as 5 seconds (verify Start-up phase inherits duration)

➢ Enter description: A mission segment for igniting the engine.
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EXERCISE 1.3.5 MISSION PHASES & SEGMENTS (CONTINUED)

➢ Verify Environment as Benign Environment

➢ Verify Environmental Characteristics field is empty

➢ This will be covered in Session 2.3: MPD Groups

➢ Verify Mission Parameters Current Value is 0.00

➢ Reasoning: No distance is travelled during startup/ignition.

➢ Verify Time Profile Graph shows Phase & Segment details
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EXERCISE 1.3.5 MISSION PHASES & SEGMENTS (CONTINUED)

➢ Create additional Phases and Segments using the table below to complete this mission profile:

➢ Current Distance can be modified in the Mission Parameters section

Phase Segment Duration Current Distance

Start-up 0.00 km

Ignition 5 seconds 0.00 km

Acceleration 1 minute 0.50 km

Cruise 15 minutes 10.50 km

Turning 1 minute 11.00 km

Cruise 2 1 hour 111.00 km

Deceleration 1 minute 112.00 km

Shut-down 5 seconds 112.00 km
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EXERCISE 1.3.5 MISSION PHASES & SEGMENTS (CONTINUED)

➢ Verify that the Time Profile graph has the layout & details below:
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DISCUSSION 1.3.6 MISSION SUCCESS METRICS

• Mission Success Metrics refer to requirements or targets that need to be fulfilled for the given mission

• These can be used to identify & map system functions (flow properties) in a completed system model
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EXERCISE 1.3.6 MISSION SUCCESS METRICS

To create a new Mission Success Metric:

➢ Select the Mission Success Metrics tab to open the page

➢ Select to create a new mission success metric

➢ Populate the following details:

➢ Name: Transport Personnel

➢ Success criteria: 5 people and luggage

➢ Minimum success criteria as: 2 people and luggage

❖ Note: System Flow Properties table shows flow properties only when a system model with system-level function and 
flows are created
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EXERCISE 1.3.6 MISSION SUCCESS METRICS (CONTINUED)

➢ Verify that the newly created Metric is displayed in the Mission Success Metrics table
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SESSION 1.3 SUMMARY

✓1.3.1: Mission Profile Overview

✓1.3.2: Mission Profile Editor

✓1.3.3: Overview/Management Page

✓1.3.4: Mission Profile Landing Page

✓1.3.5: Mission Phases and Segments

✓1.3.6: Mission Success Metrics



Session 1.4: Functional Modeling (FHA)

SESSION 1.4 OUTLINE

1.4.1: Functional Hazards Assessment (FHA) in ARP4761 Context

1.4.2: Opening Functional Modeling Editor

1.4.3: Functional Model Editor Layout

1.4.4: Creating Functions

1.4.5: Creating Connections



Session 1.4: Functional Modeling (FHA)

DISCUSSION 1.4.1 FUNCTIONAL HAZARDS ASSESSMENT (FHA) IN ARP4761 CONTEXT

• ARP4761 Standard: Guidelines & methods of performing safety assessment for certification of civilian 
aircraft

• FHA Definition: A Functional Hazard Assessment is defined as a systematic, comprehensive examination of 
functions to identify and classify failure conditions of those functions according to their severity

• Identify Functions

• Identify Failure Conditions related to each Function

• Classify Failure Conditions by Severity

• Performed during Concept and Preliminary Design Stages

• FHA is performed at 2 levels: Platform (e.g. Aircraft) Level & System Level

• Functions are assigned Development Assurance Levels (DALs) to classify the severity of failure effects or 
development errors
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EXERCISE 1.4.2 OPENING FUNCTIONAL MODELING EDITOR

To access Functional Diagram: 

➢ Select ‘Vehicle System’ in the Project Explorer

➢ Select Modeling→ Functional Diagram from main menu

➢ Alternatively, right-click ‘Vehicle System’ in Project Explorer then select Functional Diagram



Session 1.4: Functional Modeling (FHA)

DISCUSSION 1.4.3 FUNCTIONAL MODEL EDITOR LAYOUT
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DISCUSSION 1.4.3 FUNCTIONAL MODEL EDITOR LAYOUT

The default layout of the Functional Model editor consists of:

• Vertical Tabs (Left): Show Functional Model & active Failure Condition pages

• Functional Model canvas (Centre): The main area where Functions and Functional connections are defined

• Palette (Right): Contains a list of modeling tools, functional connections and function types

• Functions List (bottom): A collapsible area where functions & function details are summarised

• Domain Editor: Option to add external events relating to the functional model



Session 1.4: Functional Modeling (FHA)

DISCUSSION 1.4.3 FUNCTIONAL MODEL EDITOR LAYOUT

There are two types of function blocks in the Functional Model:

• Function: Represents a description of an operation to be performed by the system

• External event: An occurrence which has its origin distinct from the aircraft of the system
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DISCUSSION 1.4.3 FUNCTIONAL MODEL EDITOR LAYOUT

There are 6 selections in the Palette view of FHA:

• Select – used to select items on the Functional model canvas

• Marquee – used to select multiple items on the Functional model canvas

• New Function – used to create new functions

• Import Function – used to import functions from a different hierarchy

• Import Domain Function – imports external functions onto the Functional model canvas

• Connection – creates connections and link functions
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EXERCISE 1.4.4 CREATE FUNCTIONS

There are two methods to create a function: 

➢Method 1: 

➢ Select New Function from the Palette 

➢ Select on the Functional model canvas to create a Functions on this level

➢ Using the Properties viewer, rename the function to Control Vehicle

➢Method 2: 

➢ Right click on the Functional model canvas

➢ Select New → New Function 

➢ Using the Properties viewer, rename the function to Provide Thrust



Session 1.4: Functional Modeling (FHA)

EXERCISE 1.4.4 CREATE FUNCTIONS

The FHA Model is a hierarchical model. Functions can be created beneath the higher level functions. 

To access the lower level FHA Model:

➢ Double click on the Control Vehicle function to view the lower level Functional Diagram

➢ Create the following functions under the Control Vehicle function:

➢ Control Vehicle Direction

➢ Decelerate Vehicle
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EXERCISE 1.4.4 CREATE FUNCTIONS (CONTINUED)

➢ On the Vehicle System Functional Diagram, right click on the Provide Thrust function 

➢ Select Functional Diagram

➢ Create the following functions under the Provide Thrust function:

➢ Convert Fuel to Mechanical Motion

➢ Distribute Mechanical Motion



Session 1.4: Functional Modeling (FHA)

DISCUSSION 1.4.5 EXTERNAL FUNCTION

• External functions can be captured using the Domain editor. This can be accessed by selecting Domain 
Editor button in the top right corner of the FHA window. 

• The external functions can be assigned to various domains. 

• By default, Environment, Human Factors and Support Systems are provided. 
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EXERCISE 1.4.5 EXTERNAL FUNCTION

To input External Functions: 

➢ Select 

➢Within the Support Systems list select       
to add 2 external functions 

➢ Rename the external functions using the 
Properties viewer

➢ Air/Ground Determinations

➢ Crew Alerting



Session 1.4: Functional Modeling (FHA)

DISCUSSION 1.4.4 IMPORT FUNCTIONS

• When functions are not located in the same Functional diagram, they can be imported and linked to other 
functions. 

• Functions and External functions can be linked using                           and  



Session 1.4: Functional Modeling (FHA)

EXERCISE 1.4.5 IMPORTING FUNCTIONS

We can import both functions and external functions to associate them to a function block. 

In the Control Vehicle function, to import a function: 

➢ Select 

➢ Select the Distribute Mechanical Motion check box

➢ Select 

➢ Select on the canvas to add the Function to the diagram
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EXERCISE 1.4.5 IMPORTING FUNCTIONS (CONTINUED)

To import an external function: 

➢ In the Control Vehicle functional diagram, select

➢ Check the Crew Alerting box

➢ Select 

➢ Select on the canvas to add the External Function to the diagram
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EXERCISE 1.4.5 CREATE CONNECTIONS

To create a connection, select                  from the Palette then click and 
drag from one function to another (including external functions). 

➢ In the Control Vehicle functional diagram, create connections to relate:

➢ Control Vehicle Direction to Distribute Mechanical Motion

➢ Select                   and link Control Vehicle Direction and Decelerate Vehicle to 
Distribute Mechanical Motion

➢ Select the connection between Control Vehicle Direction to Distribute 
Mechanical Motion and using the Properties viewer, rename the connection 
name to Steering

➢ Decelerate Vehicle to Distribute Mechanical Motion

➢ Select on the connection between Decelerate Vehicle to Distribute 
Mechanical Motion and using the Properties viewer, rename connection 
name to Decelerate Vehicle to Braking
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EXERCISE 1.4.5 CREATE CONNECTIONS (CONTINUED)

➢ Create connections to relate:

➢ Air/Ground Determinations to Control Vehicle

➢ In the Vehicle System functional diagram where Control Vehicle is located, select 

➢ Select Air/Ground Determinations and Crew Alerting

➢ Select on the system canvas to add to the diagram

❖Note: If you import multiple external functions, you may need to extend the Domain window to see all 
imported external functions
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EXERCISE 1.4.5 CREATE CONNECTIONS (CONTINUED)

➢ Create connections to relate:

➢ In the Vehicle System functional diagram

➢ Select                   and link Air/Ground Determinations to Control Vehicle (click on the source and link to target)

➢ Create a connection between Crew Alerting and Provide Thrust
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EXERCISE 1.4.5 CREATE CONNECTIONS (CONTINUED)

➢ In the Provide Thrust functional diagram, create a connection to relate:

➢ Convert Fuel to Mechanical Motion to Distribute Mechanical Motion

➢ Rename connection label to Force

➢ In Control Vehicle functional diagram, connect Crew Alerting to Control Vehicle Direction



Session 1.4: Functional Modeling (FHA)

SESSION 1.4 SUMMARY

✓1.4.1: Functional Hazards Assessment (FHA) in ARP4761 Context

✓1.4.2: Opening Functional Modeling Editor

✓1.4.3: Functional Model Editor Layout

✓1.4.4: Creating Functions

✓1.4.5: Creating Connections



Session 1.5: System Modeling (Logical & Physical)

SESSION 1.5 OUTLINE

1.5.1: Advanced Properties

1.5.2: System Model & Boundary

1.5.3: Modeling Subsystems & Components (Logical Blocks)

1.5.4: Modeling Parts (Physical Blocks)



Session 1.5: System Modeling (Logical & Physical)

DISCUSSION 1.5.1 ADVANCED PROPERTIES

• The Advanced Properties Overview page shows where high-level/detailed information of a system or item 
can be stored.
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EXERCISE 1.5.1 ADVANCED PROPERTIES

To open the Advanced Properties editor:

➢ Right-click ‘Vehicle System’ in the Project Explorer

➢ Select Advanced Properties

➢ Populate the following fields:

➢ Item Number: VS1

➢ Physical Description: A land vehicle consisting of a driveline 
and power generation system.

➢ Enter a Model Year/Program: 2020
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DISCUSSION 1.5.2 SYSTEM MODEL & BOUNDARY

• System Model is the canvas for all MADe modeling work

• Shows the contents (children) of an item and the boundary MUX bars for that item

• Defines the scope of the system

• Represented by Input and Output MUX bars

• MUX Bars define the input and output flows for the item
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EXERCISE 1.5.2 SYSTEM MODEL & BOUNDARY

To open the System Model:

➢ Right-click the ‘Vehicle System’

➢ Select System Model

➢ Select the IN & OUT MUX bars

➢ Shift it away from End Effect Item text

❖Note: Double-clicking ‘Vehicle System’ will also open the System Model

❖Note: Select the grid icon       in the toolbar to show gridlines
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DISCUSSION 1.5.3 MODELING SUBSYSTEMS & COMPONENTS (LOGICAL BLOCKS)

• What does system modeling involve?

• Representing the structure and functionality of system of interest in MADe

• Does system modeling require defined hardware?

• Before beginning modeling the user should decide how detailed the model needs to be based upon 

• System complexity 

• Required analyses

• How does system modeling differ from functional modeling?

• A functional model is a simplistic model outlining the functions a system should achieve

• System modeling in MADe includes a hierarchical structure of items

• Items have functions associated with them and interact with one another via causal relationships between the 
functions



Session 1.5: System Modeling (Logical & Physical)

DISCUSSION 1.5.3 MODELING SUBSYSTEMS & COMPONENTS (LOGICAL BLOCKS)

• A taxonomy of system elements in the System Model is shown in the table below:

Term Icon Definition

System
A grouping of sub-systems, components  and parts which interact to fulfil a common function. A system 
is the highest level of indenture within a MADe project.

Subsystem A grouping of components or parts that work together to fulfil a common function.

Component A model item that performs a function and forms part of a larger system.

Pair
The combination of two parts, created by assigning a physical connection between them. A pair 
possesses functions and failures, and may be connected up to the failure of a component. 

Part The lowest possible level of hierarchy in MADe. A part on its own cannot perform a function. 



Session 1.5: System Modeling (Logical & Physical)

EXERCISE 1.5.3 MODELING SUBSYSTEMS & COMPONENTS (LOGICAL BLOCKS)

To model Subsystems:

➢ Right-click on the white-space on the system model

➢ Select New → Subsystem

➢ Select the Subsystem and using the Properties viewer, 
Rename the Item name to Power Generation

❖ Note: You can move a model item by clicking and dragging it



Session 1.5: System Modeling (Logical & Physical)

EXERCISE 1.5.3 MODELING SUBSYSTEMS & COMPONENTS (LOGICAL BLOCKS) (CONTINUED)

➢ Right-click the ‘Power Generation’ and select System Model

➢ Right-click the system canvas and select New→ Component

➢ Select the new component and using the Properties viewer
edit the name to ‘Fuel Tank’



Session 1.5: System Modeling (Logical & Physical)

EXERCISE 1.5.3 MODELING SUBSYSTEMS & COMPONENTS (LOGICAL BLOCKS) (CONTINUED)

➢Right-click the ‘Power Generation’ subsystem in the project explorer and select: New → Component

➢Using the Properties viewer, edit the name to ‘Control Unit’

❖Note: You can create a new component by selecting       in the icon toolbar 



Session 1.5: System Modeling (Logical & Physical)

EXERCISE 1.5.3 MODELING SUBSYSTEMS & COMPONENTS (LOGICAL BLOCKS) (CONTINUED)

➢Create a new subsystem in ‘Vehicle System’

➢Rename the subsystem to ‘Driveline’

➢Open the ‘Driveline’ system model and create the following 7 driveline components:

➢ Transmission

➢ Driveshaft

➢ Differential

➢ Half Shaft Front 

➢ Half Shaft Rear

➢ Planetary Gearbox Front 

➢ Planetary Gearbox Rear



Session 1.5: System Modeling (Logical & Physical)

DISCUSSION 1.5.4 MODELING PARTS (PHYSICAL BLOCKS)

• Parts represent the most granular, physical level of detail in a MADe System Model

• Loading characteristics, features and environmental factors are attributed to part-level items

• Parts do not perform individual functions – instead part-pairs perform a function

• Parts interact with the logical model via failure diagram – do not connect directly to MUX bars



Session 1.5: System Modeling (Logical & Physical)

EXERCISE 1.5.4 MODELING PARTS (PHYSICAL BLOCKS)

To create parts: 

➢ Open the ‘Fuel Tank’ System Model 

➢ Create two new parts

➢ Edit the names of the parts to: ‘Inlet’ and ‘Outlet’

➢ Use the Palette window and search for ‘Lining’

➢ Drag this Palette part onto the canvas

To create a part-pair Connection:

➢Select      from the toolbar to create a connection

➢Left-click from the ‘Inlet’ to the ‘Lining’

➢Repeat for the ‘Lining’ and ‘Outlet’



Session 1.5: System Modeling (Logical & Physical)

SESSION 1.5 SUMMARY

✓1.5.1: Advanced Properties

✓1.5.2: System Model & Boundary

✓1.5.3: Modeling Subsystems & Components (Logical Blocks)

✓1.5.4: Modeling Parts (Physical Blocks)



Session 1.6: System Modeling (Functions)

SESSION 1.6 OUTLINE

1.6.1: Functional Modeling

1.6.2: System & Subsystem Functions and Flows

1.6.3: Component Functions and Flows

1.6.4: Pair Functions and Flows

1.6.5: Connecting Model Items



Session 1.6: System Modeling (Functions)

DISCUSSION 1.6.1 FUNCTIONAL MODELING

• Objective: Defining the functions and flows for a system and its items

MADe has a defined functions taxonomy to assist modeling and increase model repeatability

• Functions: A description of an operation to be performed by a device, artifact or item, expressed as a verb

• A list of MADe function categories found is listed below:

Category Definition

Branch To cause a material or energy to no longer be joined or mixed.

Channel To cause a material or energy to move from one location to another location.

Connect To bring two or more energies or materials together.

Control To alter or govern the size or amplitude of material, signal or energy.

Convert To change from one form of energy or material to another.

Provide To accumulate or provide material or energy.

Signal To provide information.

Stop To cease, or prevent, the transfer of a material, signal or energy.

Support To firmly fix a material into a defined location, or secure an energy into a specific course.



Session 1.6: System Modeling (Functions)

DISCUSSION 1.6.1 FUNCTIONAL MODELING (CONTINUED)

• MADe has a defined flows taxonomy to assist modeling and increase model repeatability

• Flow: A change in material, energy or signal with respect to time, expressed as the object of a function

• Flows represent the interfaces throughout the system

• A list of MADe flow categories is listed below:

Category Definition

Energy Any flow that is characterized by the exchange of energy.

Material Any flow that is characterized by the exchange and/or interaction of material.

Signal Any flow that is characterized by the exchange of information.



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.2 SYSTEM & SUBSYSTEM FUNCTIONS AND FLOWS

To assign functions and flows: 

➢Right-click on the ‘Vehicle System’ in the Project Explorer and select Functions 

➢This action will open the Functions window where the following are defined: 

➢System Function 

➢Flow Property (In Flows and Out Flows)



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.2 SYSTEM & SUBSYSTEM FUNCTIONS AND FLOWS (CONTINUED)

➢Locate the Convert function

➢Click-and-drag to grey area to assign function



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.2 SYSTEM & SUBSYSTEM FUNCTIONS AND FLOWS (CONTINUED)

➢Locate and select the Flows tab (this will be automatic selected after adding the first function)

➢Click-and-drag into the In Flows:

➢Liquid (Material) 

➢Gas (Material)

➢Electrical (Energy)

➢Click-and-drag into the Out Flows:

➢Mechanical – rotational (Energy) (x2)



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.2 SYSTEM & SUBSYSTEM FUNCTIONS AND FLOWS (CONTINUED)

➢The completed functions editor should look like the image on the left

➢System Model shows IN/OUT mux bars with a function and input & output flows



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.2 SYSTEM & SUBSYSTEM FUNCTIONS AND FLOWS (CONTINUED)

➢Repeat function editor steps for the ‘Power Generation’ & ‘Driveline’ subsystem using the table below

Subsystem Functions Input Flows Output Flows

Power Generation Convert Liquid Mechanical – rotational 

Gas

Electrical

Driveline Branch Mechanical – rotational Mechanical – rotational

Branch Mechanical – rotational 



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.2 SYSTEM & SUBSYSTEM FUNCTIONS AND FLOWS (CONTINUED)

➢Completed functions editors for ‘Power Generation’ & ‘Driveline’ subsystems are shown below



Session 1.6: System Modeling (Functions)

DISCUSSION 1.6.3 COMPONENT FUNCTIONS AND FLOWS

• Functional modeling is a top-down process however connecting flows are a bottom-up process

• E.g. Define System Functions, then Subsystem, then Components etc.

• E.g. Flows between components are connected, then subsystem flows, then flows to the system

• Component functions should relate to subsystem functions

• E.g. If a subsystem function is to ‘provide torque’, then a component function could be to ‘convert torque’

• Flow properties represent the measurable attributes of a flow

• Causality is defined in components based on the relationship between input and output flows

• Once connected together a subsystem will inherit flow paths from its children items



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.3 COMPONENT FUNCTIONS AND FLOWS

➢Open the system model for the ‘Power Generation’ subsystem

➢Right-click the ‘Fuel Tank’ and select Functions

➢Assign the Provide Function

➢Assign the Material - Liquid flow into the In Flows

➢Assign the Material - Liquid flow into the Out Flows

➢Left-click and drag the Flow rate property in the In Flows 
to the Static pressure property in the Out Flows

❖Note: The functional description will read as Provide Liquid Static pressure



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.3 COMPONENT FUNCTIONS AND FLOWS (CONTINUED)

➢Right-click the ‘Control Unit’ from the Project Explorer and select Functions

➢Assign the flows as indicated in the table:

❖Note: The Process function is located within the Signal folder. Alternatively, use the Search bar to search for Process

➢Connect the Electrical – Voltage input flow to the Continuous – Amplitude output flow

Subsystem Functions In Flows Out Flows

Control Unit Process Energy - Electrical Signal - Continuous



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.3 COMPONENT FUNCTIONS AND FLOWS (CONTINUED)

➢Right-click the ‘Transmission’ from the Project Explorer and select Functions

➢Assign the Distribute function

➢Assign Energy – Mechanical - rotational flow into the In Flows

➢Assign Energy – Mechanical - rotational flow into the Out Flows

➢Connect the Torque In Flow property to Angular Velocity Out Flow property

❖Note: This will read as Distribute – Mechanical – rotational Angular velocity



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.3 COMPONENT FUNCTIONS AND FLOWS (CONTINUED)

To model the ‘Driveline’ subsystem:

➢ Create components in the ‘Driveline’ subsystem using the table below:

Component Function In Flow Out Flow

Transmission Distribute Mechanical – Rotational Torque Mechanical – Rotational Angular Velocity

Driveshaft Support Mechanical – Rotational Angular Velocity Mechanical – Rotational Torque

Differential Divide Mechanical – Rotational Torque Mechanical – Rotational Angular Velocity

Half Shaft (2 instances) Transmit Mechanical – Rotational Angular Velocity Mechanical – Rotational Torque

Planetary Gearbox (2 instances) Store Mechanical – Rotational Torque Mechanical – Rotational Angular Velocity



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.3 COMPONENT FUNCTIONS AND FLOWS (CONTINUED)

➢Additional components required for the driveline: 2x Wheel components

➢This requires accessing the Palette viewer:

➢ Search for the Wheel component

➢ Drag out two Wheel components to the ‘Driveline’ system model

➢ Rename them as ‘Wheel Front’ & ‘Wheel Rear’



Session 1.6: System Modeling (Functions)

DISCUSSION 1.6.4 PAIR FUNCTIONS AND FLOWS

• How are functions assigned for a pair?

• A part is a discrete singular unit that cannot by itself work functionally. It needs to work in combination with one 
or more other parts

• Why are pair functions necessary?

• A pair is the functional use of two parts

• How do pair functions relate to a component?
• Unlike the relationship between components and subsystems, part-pair functions aren’t directly connected to 

their parent component’s functions

• Parts represent the physical base units of a system, whereas components and above are representing the logical 
structure of the system

❖Note: The failure diagram (later session) will further explore relationship between parts and components



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.4 PAIR FUNCTIONS AND FLOWS

To assign a Pair Function & Flow:

➢Open the system model for the ‘Fuel Tank’ component

➢Right-click the Inlet-Lining pair and select Functions

➢Assign a function: Contain

➢Assign a flow: Material – Liquid

➢Select the property: Flow rate 

➢Right-click the Lining-Outlet pair and select Functions

➢Assign a function: Supply

➢Assign a flow: Material – Liquid

➢Select the property: Static Pressure



Session 1.6: System Modeling (Functions)

DISCUSSION 1.6.5 CONNECTING MODEL ITEMS

• Connecting items in the system model is used for:

• Propagation of an injected failure

• Path analysis of failures for reporting outputs e.g. FMEA, FMECA

• Simulating dependencies between items using Bond Graph or FCM simulation methods



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.5 CONNECTING MODEL ITEMS

➢Connect the ‘Driveline’ components as shown in the diagram below:

➢ The connection between the ‘Planetary Gearbox’ and ‘Wheel’ components can not be made due to 
mismatched flow properties

➢ To resolve this, change the ‘Wheels’ in flow properties to Angular velocity to connect the model



Session 1.6: System Modeling (Functions)

EXERCISE 1.6.5 CONNECTING MODEL ITEMS (CONTINUED)

➢ Connect the ‘Power Generation’ & ‘Driveline’ subsystems in the first Level of Indenture



Session 1.6: System Modeling (Functions)

SESSION 1.6 SUMMARY

✓1.6.1: Functional Modeling

✓1.6.2: System & Subsystem Functions and Flows

✓1.6.3: Component Functions and Flows

✓1.6.4: Pair Functions and Flows

✓1.6.5: Connecting Model Items



Session 1.7: MADe Library

SESSION 1.7 OUTLINE

1.7.1: MADe Library

1.7.2: Setting up a new MADe User Library



Session 1.7: MADe Library

DISCUSSION 1.7.1 MADE LIBRARY

• What does the MADe Example library contain?

• MADe example library contains example systems modelled by PHMT 

• Used as guides for how to model and accelerate the modeling process

• How should the MADe Example library be used?

• Repeatability

• Transferability

• What does the Palette contain?

• The palette contains a database of exemplar components and parts

• Used to speed up modeling 

• Suggest correct function for an item



Session 1.7: MADe Library

EXERCISE 1.7.1 MADE LIBRARY

To complete the ‘Power Generation’ subsystem:

➢Select Library viewer and search for the ‘Diesel Engine’

➢Select the ‘Diesel Engine’ under MADe Example Systems →Mechanical → Vehicle System

➢Drag this item into the ‘Power Generation’ system model



Session 1.7: MADe Library

EXERCISE 1.7.1 MADE LIBRARY (CONTINUED)

➢We can now connect all items in the ‘Power Generation’ subsystem. 

❖Note: MADe will automatically prevent connection of dissimilar flows



Session 1.7: MADe Library

DISCUSSION 1.7.2 SETTING UP A NEW MADE USER LIBRARY

• A user library is used to save MADe model items for re-use in future projects

• Libraries are created and managed in the preferences

• Once a model is complete any number of items can be saved to a library

• Companies may choose to establish company or project specific libraries



Session 1.7: MADe Library

EXERCISE 1.7.2 SETTING UP A NEW MADE USER LIBRARY

To set up a new MADe User Library: 

➢ Select Preferences → Library Management

➢ Select

➢ Choose a location to save the library



Session 1.7: MADe Library

EXERCISE 1.7.2 SETTING UP A NEW USER LIBRARY (CONTINUED)

➢ Set the library name as: Training Library

➢ Set the database name as: Training Database

➢ Validate the settings to ensure no duplication with existing database name

➢ Select

➢ Select the checkbox next to the new library to set it to automatically connect on starting MADe 

➢ Select



Session 1.7: MADe Library

EXERCISE 1.7.2 SETTING UP A NEW USER LIBRARY (CONTINUED)

To save items to the new User Library:

➢ Click-and-drag to select the ‘Power Generation’ and ‘Driveline’ subsystems

➢ Right-click on a highlighted item and select Save to Library

➢ Expand the Training Library folder to reveal the folders

➢ Click-and-drag the subsystems into the Systems folder

➢ Select



Session 1.7: MADe Library

SESSION 1.7 SUMMARY

✓1.7.1: MADe Library

✓1.7.2: Setting up a new MADe User Library



Session 1: MADe Modeling

SESSION 1 SUMMARY

✓1.1: Navigation

✓1.2: Project Creation

✓1.3: Mission Profile Definition (Solution-independent)

✓1.4: Functional Modeling (Functional Hazards Assessment)

✓1.5: System Modeling (Logical & Physical)

✓1.6: System Modeling (Functions)

✓1.7: MADe Library



Session 2: 
Failure Simulation

Verifying the MADe model 
& Analysing Failure Modes and Effects



Session 2: Failure Simulation

SESSION 2 OUTLINE

2.2: Failure Simulation

2.3: Mission Profile (Solution-dependent) & Groups

2.4: Failure Analysis

2.5: Features & Characteristics



Session 2: Failure Simulation

SESSION 2 DISCUSSION

• Session 2 will take place in the MADe module.

• This session will focus on: 

• Annotations

• Mission Profile 

• Additional part level modeling

• Failure simulation



Session 2.1: Annotations

SESSION 2.1 OUTLINE

2.1.2: Dashboard

2.1.3: Model Parameters

2.1.4: Narratives

2.1.5: Assumptions

2.1.6: Comments

2.1.7: Annotations Report



Session 2.1: Annotations

EXERCISE 2.1.1 ANNOTATIONS

Top open the Annotations Editor:

➢Method 1: To open the Annotations editor, select 
Modeling → Annotations from the main menu

➢Method 2: Double-click Annotations icon in bottom 
left corner of MADe



Session 2.1: Annotations

DISCUSSION 2.1.2 DASHBOARD

The Dashboard shows the following metrics:

• Analysis Quality Index: Coverage, Quality and resulting Confidence level of the model output 

• Data sources: Visual breakdown of the types of data sources

• Recent Events: Changes to parameters in a model that are tracked



Session 2.1: Annotations

DISCUSSION 2.1.3 MODEL PARAMETERS

• Used to annotate any changes in the model

• Can also be used to search for annotations and filter by various properties



Session 2.1: Annotations

EXERCISE 2.1.3 MODEL PARAMETERS

To search for a model parameter:

➢ Enter Mission Profile into the Item/Event Description search box

➢ Find the event Mission Profile Name Changed

➢ Double-click on the Mission Profile Name Changed annotation 
event in the table

➢ This opens the Annotation Details editor

➢ Select Engineer from the Information Source drop down menu

➢ Enter the following narrative: Mock Mission Profile scenario 
provided for training purposes.

➢ Select 



Session 2.1: Annotations

EXERCISE 2.1.3 MODEL PARAMETERS (CONTINUED)

To enter annotations for multiple model parameters:

➢ Type Item into the Item/Event Description field

➢ Left-click the top result then shift-click the bottom result

➢ Right-click a highlighted change

➢ Select

➢ Select the source as: OEM

➢ Enter the source as: From OEM schematics.

➢ Select



Session 2.1: Annotations

DISCUSSION 2.1.4 NARRATIVES

• Used to add additional information to the model e.g. Functional Narrative



Session 2.1: Annotations

EXERCISE 2.1.4 NARRATIVES

To enter a new narrative:

➢ Select        to open the Narrative Types editor

➢ Ensure all narratives are selected, then select

➢ Enter into the Item Name/Narrative Text search box: Fuel Tank

➢ Double-click the Fuel Tank with the Category Item to open the 
Edit Narrative Text editor

➢ Enter the following text: Modelled as a tank that contains return 
fuel and supplies fuel for operation.

➢ Select



Session 2.1: Annotations

DISCUSSION 2.1.5 ASSUMPTIONS

• Used to capture any assumptions or constraints of the model

• Can be used to document modeling decisions



Session 2.1: Annotations

EXERCISE 2.1.5 ASSUMPTIONS

To enter a new assumption:

➢Select the      button to the left of the table to open the Add New 
Assumptions editor

➢Expand the Item Type tree to MADe Training → Vehicle System

➢Select the Vehicle System

➢Enter the narrative: Only select subsystems have been modelled 
for this concept system to reduce modeling
time for MADe training.

➢Select



Session 2.1: Annotations

DISCUSSION 2.1.5 COMMENTS

• Used to pass general information to other modellers/users

• Used as notes/reminders for the modeling tasks



Session 2.1: Annotations

EXERCISE 2.1.5 COMMENTS

To add comments: 

➢Select the      button to the left of the table to open the Add New 
Comment editor

➢Expand the Item Type tree to MADe Training → Vehicle System →
System Model

➢Select the System Model

➢Enter the narrative: The simulation parameters are not added to the 
model, they will be added in training session 2.2.

➢Select 



Session 2.1: Annotations

DISCUSSION 2.1.6 EVENT LOG

• Lists all annotation actions based on a date range



Session 2.1: Annotations

DISCUSSION 2.1.7 ANNOTATIONS REPORT

• Summarises annotations by item, type, status and source

• Displays information from:

• Dashboard

• Model Parameters Table



Session 2.1: Annotations

EXERCISE 2.1.7 ANNOTATIONS REPORT

To generate an Annotations report:

➢ Select Reports → Report Wizard from the main menu

➢ Under Data Quality Analysis select Annotation Report

➢ Select   to proceed to item selection page

➢ Select ‘Vehicle System’ item

➢ Select                   to set report formatting 

➢ Select                   to run report



Session 2.1: Annotations

SESSION 2.1 SUMMARY

✓Understand the Annotations dashboard

✓Search and create annotated events

✓Create a narrative for more model information

✓Create an assumption on a model item

✓Create a comment on the system model

✓Understand how to review the event log



Session 2.2: Failure Simulation

SESSION 2.2 OUTLINE

2.2.1 Introduction to Failure Simulation in MADe

2.2.2 FCM Simulation Parameters

2.2.3 FCM Simulation

2.2.4 FCM Step Table

2.2.5 Response Simulation Viewer

2.2.6 FCM Simulation Threshold Types

2.2.7 Bond Graph Simulation

2.2.8 Bond Graph Model

2.2.9 Bond Graph Response Simulation



Session 2.2: Failure Simulation

DISCUSSION 2.2.1 INTRODUCTION TO FAILURE SIMULATION IN MADE

• Failure simulation involves editing simulation-specific properties in the model

• E.g. Causal Strength, Initial Value, Internal Damping for FCM Simulation

• E.g. Bond Types & Passive Variables for Bond Simulation

• These properties are used to simulate the effects and failure propagation in the system model



Session 2.2: Failure Simulation

DISCUSSION 2.2.1 INTRODUCTION TO FAILURE SIMULATION IN MADE

MADe utilises two response simulation methods that allow analysis of failures and performance:

• Fuzzy Cognitive Maps (FCM)

- Uni-directional flow of information (failure is propagated downstream only)

- Signal, material, and energy flows incorporated into model

• Power bond modeling (Bond)

- Bi-directional flow of information (failure is propagated both upstream and downstream of an item)

- Energy (power) flows incorporated into model



Session 2.2: Failure Simulation

DISCUSSION 2.2.1 INTRODUCTION TO FAILURE SIMULATION IN MADE

Which simulations should be used for a system model? Questions to ask include:

• What type of system behaviour is being represented?

- Bond graphs model bi-directional information exchange typical of energy relationships

- FCM model unidirectional information exchange typical of signal relationships 

• What is/are the engineering domains in the system?

- Bond allows multiple energy domains to be analyzed and integrated into the same model

- E.g. Power transfer between energy flow types such as mechanical, electrical, hydraulic etc.

- FCM allows different flow domains to be analysed

- E.g. Energy, Material & Signal flow types

• What is the analysis being undertaken?

- FCM is ideal for FMEA / FMECA reports or as the basis for reliability analysis

- Bond is ideal when undertaking PHM analysis



Session 2.2: Failure Simulation

DISCUSSION 2.2.2 FCM SIMULATION PARAMETERS

• Fuzzy Cognitive Mapping (FCM) uses causal strength & polarity to define causality between two items

• FCM is used to define the relationship between input and output of an item

• E.g. A drop in Fuel flow rate inflow affecting the fuel flow rate output of an item

❖Note: For more information refer to FCM Simulation & Theory Guide in MADe Help



Session 2.2: Failure Simulation

DISCUSSION 2.2.2 FCM SIMULATION PARAMETERS

To perform an FCM analysis, FCM parameters need to be edited in the MADe model

• FCM parameters are accessed from several locations:

• Causal connection between input and output flow properties (Functions Editor)

• Output Flow Properties (Functions Editor)

• Right-click menu in the system model

FCM Parameter Location in MADe Description

Initial Value Output Flow Property Augments the nominal value of a flow during a simulation

Internal Damping Output Flow Property Internal feedback of an item (Resistance, damping, friction)

Polarity Causal Connection Relationship between a cause and effect (in and out flow)

Causal Strength Causal Connection The likelihood that an input flow perturbs the connected output flow

Response Filter Causal Connection A filter applied to internal flow perturbations

Perturbation/Failure Injection Item (Right-click menu) An introduced failure response (high or low) from the nominal state



Session 2.2: Failure Simulation

EXERCISE 2.2.2 FCM SIMULATION PARAMETERS

To edit FCM Parameters:

➢ Open the ‘Power Generation’ system model

➢ Open the ‘Diesel Engine’ system model

➢ Open the Functions editor of ‘Coupling 1’

➢ Select the causal connection between 
Torque & Angular Velocity

➢ Add a Block Positive response filter in the 
Properties Viewer



Session 2.2: Failure Simulation

EXERCISE 2.2.2 FCM SIMULATION PARAMETERS (CONTINUED)

➢ Open the ‘Control Unit’ Functions editor 
(‘Power Generation’ subsystem)

➢ Toggle the Enabled flow properties icon

➢ Select the Voltage to Amplitude causal connection

➢ Set Polarity to Negative

➢ Set the Causal strength to 5.00

❖Next section will demonstrate the results of these parameters



Session 2.2: Failure Simulation

DISCUSSION 2.2.3 FCM SIMULATION

• FCM Simulation looks at the propagating effects of a simulated failure due to an initiating failure introduced 
by the user

• A failure must first be ‘injected’ in the system model before FCM Simulation can occur

• System response is observed using methods below:

• Sequentially (System Model or Step Viewer – see right) 

• Graphically for all time steps (Response Simulation Viewer below)



Session 2.2: Failure Simulation

DISCUSSION 2.2.3 FCM SIMULATION

• Failures in MADe are classified deviations from an item’s nominal behaviour/state

• E.g. A Pump provides a flow rate for an operating mode – flow rate outside of this range is considered a failure

• Nominal behaviour/state is represented as a ‘zero’ value 

• Magnitude of a deviation (per step) is calculated from 3 parameters:

• Causal Strength (Weighting Matrix, W)

• Initial Value (Initial State Vector, A0)

• Perturbation (Perturbation Vector, P)

• System State Vector* is expressed as: 𝐴𝑡 = 𝐴𝑡−1 ∙ 𝑊 + 𝑃

Reference*: FCM Simulation & Theory User Guide in MADe Help



Session 2.2: Failure Simulation

EXERCISE 2.2.3 FCM SIMULATION

To inject a Failure:

➢ Open the ‘Diesel Engine’ system model

➢ Right-click ‘Coupling 1’

➢ Select Failure Injection →Mech…Angular Velocity → Down

➢ Verify Functional Perturbation is injected into the system 
model with text string:  Couple Mechanical – rotational 
Angular Velocity (Coupling 1)



Session 2.2: Failure Simulation

DISCUSSION 2.2.4 FCM STEP TABLE

• Injected Failures are displayed in the system model

• Item State Vectors are listed in the Step Table viewer

• Step Table Icons                         are used to control the 
failure propagation

• Failure Propagation ‘Steps’ can be traced throughout 
the system once a failure is fully propagated 
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EXERCISE 2.2.4 FCM STEP TABLE

To step a failure through the system:

➢ Select       to move forwards one step & repeat until system reaches equilibrium

➢ When last column ‘=‘ in Step Viewer is filled out

➢ Select       to go back one step

➢ Select       to reset stepping to its initial state

➢ Select       to run all steps automatically until system equilibrium

➢ Select       to clear all steps and injected failure in system
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DISCUSSION 2.2.5 RESPONSE SIMULATION VIEWER

• Response Simulation Graph displays the response of failure/s at each step until equilibrium

• Shows the change over time (steps) due to failure

• Graph consists of 3 parts:

1. Initial Equilibrium Region (Blue region on left)

2. Failure Activation (Vertical line) representing steps where perturbation is introduced

3. Post-Failure Response Region (White region) 
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EXERCISE 2.2.5 RESPONSE SIMULATION VIEWER

To view response simulation of the Injector Pump component: 

➢ Right-click the ‘Injector Pump’ 

➢ Select Response Simulation → Liquid Dynamic pressure

➢ Verify response graph transitions from nominal (0) to a ‘low’ failure (-1.0)

➢ Select other flows to see additional graph overlays
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DISCUSSION 2.2.5 FCM SIMULATION THRESHOLD TYPES

• FCM Simulation Thresholds are used to ensure:

• Failure simulation graphs are not divergent (unstable response)

• Amplitude detail resolution is maintained

• There are currently 5 Threshold Types:

• Bivalent: Graph results range between nominal (0) and high (+1)

• Bivalent Sigmoid: Graph results range between nominal (0) and high (+1) with a sigmoid curve acting as a 
smoothing function

• Trivalent: Graph results range between nominal (0) and low (-1) to  high (+1)

• Trivalent Sigmoid: Graph results range between nominal and low (-1) to high (+1) with a sigmoid curve acting as a 
smoothing function

• No Threshold: User can set a specified limit value to the graph
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DISCUSSION 2.2.6 FCM SIMULATION THRESHOLD TYPES (CONTINUED)

• 5 Threshold Types Graphed:

• Bivalent

• Bivalent Sigmoid
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DISCUSSION 2.2.6 FCM SIMULATION THRESHOLD TYPES (CONTINUED)

• Trivalent

• Trivalent Sigmoid

• No Threshold



Session 2.2: Failure Simulation

DISCUSSION 2.2.6 FCM SIMULATION THRESHOLD TYPES (CONTINUED)

Notes on Sigmoid Charts (Bivalent & Trivalent):

• Accessed from FCM Analysis page in Project Preferences by selecting

• Sigmoid curve is adjusted by setting the sigmoid threshold value

• Smaller Sigmoid Threshold equates to a lower returned value for input value <1

• E.g. For a Threshold of 1.1, Input Value of 1.0 gives a returned value of 0.8

• Larger Sigmoid Threshold equates to a higher returned value for input value <1

• E.g. For a Threshold of 2.0. Input Value of 1.0 gives a returned value of 0.964

• Trivalent curve looks at returned value ranges between -1.0 and 1.0

• Bivalent curve looks at returned value ranges between 0.0 and 1.0
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EXERCISE 2.2.6 FCM SIMULATION THRESHOLD TYPES

To set FCM Threshold: 

➢ Select Preferences → FCM Threshold Preferences

➢ Set Threshold Type to Trivalent Sigmoid 1.0

➢ Repeat Failure Injection for ‘Coupling 1’

➢ Clear all failure injections (Select      )

➢ Right-click ‘Coupling 1’

➢ Select Failure Injection →Mech…Angular Velocity → Down

➢ Right-click the ‘Injector Pump’

➢ Select Response Simulation → Liquid Dynamic pressure

➢ Note difference between Trivalent & Trivalent Sigmoid responses – what does this mean?
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DISCUSSION 2.2.7 BOND GRAPH SIMULATION

• A Bond graph is an energy model of a dynamic system

• Bond graph modeling represents bi-directional exchange of energy

• Bond graph models use equations for each item to determine the net change in energy

• Power bonds are used to link different elements together
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DISCUSSION 2.2.7 BOND GRAPH SIMULATION

• Bond graph analysis requires editing of Bond graph properties

• These are accessed from the Properties viewer when selecting an item

• In MADe the user needs to:

• Define the system model configuration

• Assign bond groups to items

• Taxonomy for Bond Graph parameters is in the table below:

Bond Graph Parameter Location Description

Bond Type Properties Viewer → Bond tab Selection of bond type and junction represented by each item

Passive Variables Properties Viewer → Bond tab Contains fields for setting capacitor, inductor and resistor values & effort limits
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DISCUSSION 2.2.7 BOND GRAPH SIMULATION

• Modeling system model items for Bond simulation is the same process for FCM simulation

• The only limitation is that all flows used must be energy flows



Session 2.2: Failure Simulation

EXERCISE 2.2.7 BOND GRAPH SIMULATION

There are two methods of assigning Bond Types:

Method 1:

➢ Open the functions editor for the ‘Driveshaft’ component 
(in the ‘Driveline’ subsystem)

➢ Select the function Support

➢ Select Bond tab the Properties viewer

➢ Select Bond type (0 – C) Compliance from drop down menu

➢ Verify Capacitance and Initial Value are set to 0.90 & 0.00
respectively
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EXERCISE 2.2.7 BOND GRAPH SIMULATION (CONTINUED)

Method 2:

➢Select the ‘Transmission’ (in the ‘Driveline’ subsystem)

➢Navigate to the Properties viewer and select the Bond tab

➢Select the function Distribute

➢Select Bond Type: (1 - IR) Rotational Inertia Mass and Resistance

➢Verify Values for Inductor is set to 0.90

➢Verify Values for Resistor is set to 0.25

➢Verify Inductor Initial Value is set to 0.00
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EXERCISE 2.2.7 BOND GRAPH SIMULATION (CONTINUED)

➢ Assign the remaining components according to the table below with the appropriate Bond Type:

Item Bond Type

Transmission Rotational Inertia Mass and Resistance (1-IR)

Driveshaft Compliance (0-C)

Differential Rotational Inertia Mass and Resistance (1-IR)

Half Shaft (Front & Rear) Compliance (0-C)

Planetary Gearbox (Front & Rear) Rotational Inertia Mass, Compliance and Resistance (1-IRC)

Wheel (Front & Rear) Rotational Inertia Mass and Resistance (1-IR)
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EXERCISE 2.2.8 BOND GRAPH MODEL

There are 2 ways of generating the Bond Graph model:

1. From main menu: Modeling → Bond Graph

2. Right-click the system model, then select Bond Graph
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EXERCISE 2.2.8 BOND GRAPH MODEL (CONTINUED)

➢ Verify that there are 4 junction errors & 6 causal stroke errors 
due to incompatible causal strokes (bond types)

➢ These are indicated by red lines/numbers on the Bond Graph

➢ You may also find these in the Problems window under Errors 

➢ Causal strokes do not match the bond graph assigned to …
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EXERCISE 2.2.8 BOND GRAPH MODEL (CONTINUED)

➢ To fix the error, split each ‘Wheel’ component into two components: 
‘Wheel Resistance’ & ‘Wheel’ by copying the ‘Wheel’ components 
and renaming accordingly

➢ Set ‘Wheel Resistance’ function: Rotate Mechanical – Rotational 
Angular Velocity

➢ Set ‘Wheel Resistance’ & ‘Wheel’ Bond Types as (0 – R) & 
(1 – I) respectively

➢ Re-run Bond Graph model to verify no causality errors are present
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EXERCISE 2.2.8 BOND GRAPH MODEL (CONTINUED)

➢ The current Bond Graph model shows 3 warnings: 

1. Bond Model is not Controllable (Bond Graph editor)

2. Vehicle system has no defined Sources (Problems viewer under Warnings)

3. Vehicle system has no defined Sinks (Problems viewer under Warnings)

➢ To resolve the first warning, convert both the Half Shaft Front and Half Shaft Rear components to a (0 – CR) Bond Type
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EXERCISE 2.2.8 BOND GRAPH MODEL (CONTINUED)

➢ To resolve warning regarding sources & sinks, create two new components at the top level of indenture:

➢ ‘Coupling’ component, set as an Effort Source (SE) Bond type

➢ ‘Vehicle’ component set as an Effort Sink (SES) Bond type

➢ Details of the component functions & flows are listed in the table below:

Component Function In Flow Out Flow Bond Type

Coupling Couple Mechanical – rotational Torque Mechanical – rotational Torque Effort Source

Vehicle Connect Mechanical – rotational Angular velocity Mechanical – rotational Angular velocity Effort Sink

Connect Mechanical – rotational Angular velocity Mechanical – rotational Angular velocity Effort Sink
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EXERCISE 2.2.8 BOND GRAPH MODEL (CONTINUED)

➢ Connect the model as shown below 
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DISCUSSION 2.2.9 BOND GRAPH RESPONSE SIMULATION

• Bond graph response simulation is similar to FCM but only uses Bond properties

• Bond graph simulation provides more accuracy in terms of model behaviour due to equations and bi-
directional feedback (leading to more detailed responses)

• Bond graph response simulation is used to validate the Bond graph model

• Bond graph simulation can be tested against quantitative simulations, such as:
• AMESIM

• MATLAB Simulink
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EXERCISE 2.2.9 BOND GRAPH RESPONSE SIMULATION

To inject a failure in a Bond Graph model:

➢ Right-click the ‘Transmission’ component

➢ Select Failure Injection → Torque differential → Down
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EXERCISE 2.2.9 BOND GRAPH RESPONSE SIMULATION (CONTINUED)

➢ In the Response Simulation viewer locate ‘Wheel Front’

➢ Select check box for Wheel Front Angular Velocity → SES Vehicle Angular Velocity

➢ Review the graph: Wheel Angular Velocity drops momentarily as a result of Transmission loss

➢ Try other perturbations & corresponding simulation responses
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SESSION 2.2 SUMMARY

✓2.2.1 Introduction to Failure Simulation in MADe

✓2.2.2 FCM Simulation Parameters

✓2.2.3 FCM Simulation

✓2.2.4 FCM Step Table

✓2.2.5 Response Simulation Viewer

✓2.2.6 FCM Simulation Threshold Types

✓2.2.7 Bond Graph Simulation

✓2.2.8 Bond Graph Model

✓2.2.9 Bond Graph Response Simulation
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SESSION 2.3 OUTLINE

2.3.1 Environment Profiles: System Baseline

2.3.2 Mission Phase/Segment-specific Environments

2.3.3 Mission Success Metrics: System Flow Properties

2.3.4 Functional Profile

2.3.5 Special Conditions

2.3.6 Duty Cycles

2.3.7 Mission Profile Groups

2.3.8 Mission Profile Definition Reports
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DISCUSSION 2.3 MISSION PROFILE & GROUPS

This session will focus on aspects of the Mission Profile that are solution-specific :

1. Operating environment

2. Functional Profile for each Mission Profile

3. Duty Cycles

4. Mission Groups

• Since the system model is now defined the mission profile from Session 1.3 can be further developed and 
applied to the system
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DISCUSSION 2.3.1 ENVIRONMENTAL PROFILES: SYSTEM BASELINE

• Environmental profiles are divided into System Baseline & Mission Phase / Segment-specific

• System Baseline: Intended environment that the system is designed to operate within

• Mission-Based: Actual environment experienced during a Mission Profile

• Each environmental profile includes the impact of environmental factors likely to be encountered

• E.g. Acceleration, Pressure, Contamination etc.

• This information is useful in determining the system susceptibility to these factors

• System Baseline is accessed from the Advanced Properties editor but relates to MPD
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DISCUSSION 2.3.1 ENVIRONMENTAL PROFILES: SYSTEM BASELINE (CONTINUE)

• Environmental Profiles are stored in the Environmental Library 

• Environmental Library contains:

• Pre-defined Library: MIL-HDBK-217F, Telcordia

• User-defined Category & Profiles

• System Sensitivity to define relative impact of one environmental factor to another
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EXERCISE 2.3.1 ENVIRONMENTAL PROFILES: SYSTEM BASELINE

➢ To create a new Environmental Profile in the Environmental Library:

➢ Select Modeling→ Environment Library from the main menu

➢ Select      from the icon toolbar 
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EXERCISE 2.3.1 ENVIRONMENTAL PROFILES: SYSTEM BASELINE (CONTINUE)

➢ Select User Library folder then select Add an Environment icon

➢ Enter ID & Name: GM1, Ground – Urban 

➢ Enter Description: A ground based environment in city or urban environments.

➢ Select

➢ Select Solid Contamination Environmental Factor

➢ Set rating to High (7.0)

➢ Select Env. Characteristic: Exposure to Salt and Dust
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EXERCISE 2.3.1 ENVIRONMENTAL PROFILES: SYSTEM BASELINE (CONTINUE)

➢ Select Temperature Environmental Factor

➢ Set rating to High (7.0)

➢ Select Env. Characteristic: High Temperature

➢ Set all other Environmental Factor Ratings to Low (3.0)
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EXERCISE 2.3.1 ENVIRONMENTAL PROFILES: SYSTEM BASELINE (CONTINUED)

➢ Right-click on ‘Vehicle System’ and select Advanced Properties

➢ Select the Environment tab

➢ Select              to set a baseline environment 

➢ Expand the User Library folder and select [GM1] Ground – Urban
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EXERCISE 2.3.2 MISSION PHASE/SEGMENT-SPECIFIC ENVIRONMENTS

Now that we have set up environmental profiles, we can assign them to specific mission phases or segments.

➢ Open Regular Trip in the Mission Profile Editor

➢ Open the Mission Phases and Segments page

➢ Select the Ignition Segment

➢ From the Segment Details section:

➢ Select Ground – Urban Environment from the drop down menu

➢ Select the Environment Characteristics icon

➢ Select Exposure to Salt and Dust & High Temperature

➢ Select 

➢ Repeat previous steps for Acceleration & Shut-down Phases
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EXERCISE 2.3.3 MISSION SUCCESS METRICS: SYSTEM FLOW PROPERTIES

➢ Navigate to the Mission Success Metrics page

➢ Select check boxes for both Convert Mechanical – rotational Angular velocity functions

❖Note: Selected flow properties are included in the Functional Profile page
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DISCUSSION 2.3.4 FUNCTIONAL PROFILE

• This page associates system functions to mission success metrics – both related to mission phases

• Acceptable upper/lower limits for each individual function per phase

• This page is used to determine importance of each success metric is for each mission phase

• This page is output in the Mission Profile & Mission Effective Functions List (MEFL) reports
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EXERCISE 2.3.4 FUNCTIONAL PROFILE

To set the Functional Profile:

➢ Navigate to the Functional Profile tab

➢ Enter the acceptable limit values below

➢ Set functional importance for each phase as shown below
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DISCUSSION 2.3.5 SPECIAL CONDITIONS

• Special Conditions are used to capture platform configurations resulting from emergency/abnormal 
conditions

• E.g. Aircraft scenarios: Ditching, Engine Out, Loss of Communications, Depressurisation etc.

• E.g. Vehicle scenarios: high traffic, low visibility, road surfaces etc.

• Special conditions are conditions a system must meet that do not fall under mission phases or 
environmental profile
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EXERCISE 2.3.5 SPECIAL CONDITIONS

To add Special Conditions: 

➢ Navigate to the Special Conditions tab

➢ Select      to add a Special Condition

➢ Rename special condition as: Very Low Visibility

➢ Enter Description: Visibility of less than 100 metres (330 ft) is usually reported as zero.

➢ Select Phase check boxes: Acceleration & Deceleration
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DISCUSSION 2.3.6 DUTY CYCLES

• This table defines the time duration each model item is operating for a mission profile

• Duty cycle is entered based on a percentage of each mission phase

• Duty cycles inheritance is top-down

• E.g. A subsystem operates for 50% of a mission phase

• One item within the subsystem operating with a 50% duty cycle = 25% of the mission phase duration

• Duty cycle % is translated into ‘duration of operation’ used for RAM analyses

• Duty cycles will lead into residual life estimation
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EXERCISE 2.3.6 DUTY CYCLES

To set duty cycles:

➢ Select the ‘Driveline’ and in Phase 1 and set it to: 0%

➢ Select the ‘Driveline’ and in Phase 2 and set it to: 100%

➢ Select the ‘Driveline’ and in Phase 7 and set it to: 0%

➢ Set the ‘Power Generation’ and in Phase 1 and set it to: 50%

➢ Set the ‘Power Generation’ and in Phase 2 and set it to: 100%

➢ Set the ‘Power Generation’ and in Phase 7 and set it to: 50%
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DISCUSSION 2.3.7 MISSION PROFILE GROUPS

• Mission Profile Group allows aggregation of multiple mission profiles

• Groups are important for performing trade studies on reliability or maintenance costs for longer timespans

• Mission profiles can be stored and changed on demand to run new analyses later

• Mission Profile Groups are also used earlier in design for mission planning



Session 2.3: Mission Profile & Groups

EXERCISE 2.3.7 MISSION PROFILE GROUPS

To create a new group:

➢ Create a second mission profile using the following steps

➢ Navigate to the Overview/Management tab

➢ Copy the Regular Trip mission & rename the copy as Long Trip

➢ Set Mission Cycles to 4
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EXERCISE 2.3.7 MISSION PROFILE GROUPS (CONTINUED)

➢ Select                 in the Overview/Management page 

➢ Select 

➢ Select both Regular Trip and Long Trip missions in the Mission Profile Groups table

➢ Set Group Cycles of the Regular Trip to 50 

➢ Set Group Cycles of the Long Trip to 5

❖Note: Selecting the Use proportional mission durations check box enables user to edit Group Ratio column
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EXERCISE 2.3.7 MISSION PROFILE GROUPS (CONTINUED)

➢ Set this New Group as the Active Mission Profile in the Overview/Management page

➢ Right-click on the new group and select Set as Active Mission Profile

➢ Verify item duration of operations now reflect currently assigned Mission Group

➢ Open the Advanced Properties of any item in the model

➢ View Operational section of Advanced Properties page
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DISCUSSION 2.3.8 MISSION PROFILE DEFINITION REPORTS

There are 2 mission reports & 2 environment reports to output Mission Profile/Group data:

1. Mission Effective Functions List (MEFL)

This report details the critical components for a capability in a Mission Profile / Mission Group

2. Mission Profile Report

This report presents general outcomes of a selected Mission Profile / Mission Group (mission details, operating scenarios, defined 
objectives and capabilities, operating modes, and environmental profile)

3. Operating Environment Report

This report shows selected environments, environmental factors, ratings & system sensitivity details

4. Operating Environment Comparison Report

This report provides a comparative analysis of two or more selected Operating environments which compares environmental factors
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SESSION 2.3 SUMMARY

✓2.3.1 Environment Profiles: System Baseline

✓2.3.2 Mission Phase/Segment-specific Environments

✓2.3.3 Mission Success Metrics: System Flow Properties

✓2.3.4 Functional Profile

✓2.3.5 Special Conditions

✓2.3.6 Duty Cycles

✓2.3.7 Mission Profile Groups

✓2.3.8 Mission Profile Definition Reports
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SESSION 2.4 OUTLINE

2.4.1: Functional Failures

2.4.2: System & Subsystem Failure Diagrams

2.4.3: Component Failure Diagrams

2.4.4: Part Failure Diagrams

2.4.5: Response Paths

2.4.6: Propagation Table
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DISCUSSION 2.4 FAILURE ANALYSIS

• This session will cover all aspects of how failures are generated in MADe

• We will cover the difference between functional and physical failures

• We will use failure diagrams to define more detail of a failure

• We will generate response paths to look at all of the generated failures by the software

• We will look at the propagation table for responses generated by the software
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DISCUSSION 2.4.1 FUNCTIONAL FAILURES

• Failures are automatically derived from functions and flows

• Deviations from the nominal state are considered failures in MADe

• We consider these Functional Failures

• Flow typically have two failure responses: High or Low deviation

• Different domains (flows) have different linguistic terms:

• Flow rate & Contamination use Increase or Decrease

• Flow direction uses Misdirected +/-

• Timing uses Advanced +/Delayed –

• Contamination only has High as a failure response

• Also see: Alignment, Position, Shape, Timing

• These failure responses can be managed from the Properties viewer
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EXERCISE 2.4.1 FUNCTIONAL FAILURE

To edit a functional failure:

➢ Open the system model of the ‘Diesel Engine’

➢ Select the ‘Primary Fuel Filter’

➢ Navigate to the Properties Viewer and select Functional Failures tab

➢ Tick the Override failure diagram check box

➢ Disable the High Fuel Flow rate

➢ This overrides the failure analysis failure paths with the selected functional failure: Low Flow Rate
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DISCUSSION 2.4.2 FAILURE DIAGRAMS

• Failure diagrams look at the causes & progression of failure

• Failure diagrams are focussed on physical aspect of failures

• Failure diagrams use a peer-reviewed taxonomy to assist in definition

• Taxonomy for failure concepts are shown below
Failure Concept Symbol Definition

Cause The abnormal state of input, loading or environment that leads to the degradation of an item.

Mechanism The chemical, electrical, mechanical or software processes which causes physical degradation of a system element and 
results in a fault.

Fault The physically degraded state of a system element or a change in its behaviour which will result in a failure mode or the 
inability to carry out its function.

Symptom The response of a failed system element or a loss generated by a failure process that can be used to detect a failure mode.

Failure Conditions A Failure Condition describes the behaviour of a failure mode and its potential effects. 

Failure Mode The observable manner in which a system or system element fails to fulfil its function, expressed in terms of the deviation 
of its output flow from the specified or nominal limits.
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DISCUSSION 2.4.2 SYSTEM & SUBSYSTEM FAILURE DIAGRAMS

• Systems and Subsystems can have failure diagrams assigned to them 

• The System and Subsystem failure diagrams represent the system and subsystem’s failures without knowing 
the root causes of failure
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EXERCISE 2.4.2 SYSTEM & SUBSYSTEM FAILURE DIAGRAMS

To activate a system or subsystem diagram: 

➢ Select Modeling→ Activate Failure Diagram from the main menu

➢ A pop-up dialog will appear listing the System and Subsystems in the model

➢ Select the ‘Power Generation’ subsystem check box to activate the failure diagram

➢ Confirm selection by selecting 
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EXERCISE 2.4.2 SYSTEM & SUBSYSTEM FAILURE DIAGRAMS

To construct a subsystem diagram: 

➢ Right click on the ‘Driveline’ subsystem from the Project Explorer

➢ Select Failure Diagram

➢ A prompt will appear asking to activate failure diagram 

➢ Select                   to activate Subsystem Failure Diagram
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EXERCISE 2.4.2 SYSTEM & SUBSYSTEM FAILURE DIAGRAMS (CONTINUED)

➢ Select Mechanisms      in the Failure Concepts viewer

➢ Select the Impact Fracture mechanism from 
the Failure Concepts window

➢ This can be located under the Fracture folder

➢ Alternatively, use the Search bar and search for Impact Fracture

➢ Drag the failure concept onto the Failure Diagram canvas 

➢ Connect the Fractured and Cracked faults to both failure modes
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EXERCISE 2.4.3 COMPONENT FAILURE DIAGRAMS

To construct a component failure diagram:

➢ Open the system model for the ‘Power Generation’ subsystem

➢ Right-click the ‘Control Unit’ component 

➢ Select Failure Diagram from right-click menu

➢ Select Mechanisms      in the Failure Concepts viewer

➢ Under Electrical category, click-and-drag Burnout & Dielectric Breakdown mechanisms onto the failure diagram editor
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EXERCISE 2.4.3 COMPONENT FAILURE DIAGRAMS (CONTINUED)

➢ You will find that there is a repeat of Over-current and Over-Voltage Causes and Open circuit fault

➢ We can simplify the failure diagram by deleting duplicates

➢ Delete repeated failure concepts: Over-voltage, Over-current and Open circuit

➢ Connect all faults to the Functional failure mode

❖Note: When selecting mechanisms, we can hold Ctrl and select. When multiple mechanisms are selected and placed 
onto the failure diagram canvas, it will be automatically simplified. 
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EXERCISE 2.4.3 COMPONENT FAILURE DIAGRAMS (CONTINUED)

Failure diagrams have an underlying taxonomy, however, users may choose to edit the display name to better 
represent or provide additional information to the failure. 

To change the display name of the Transient electrical loads:

➢ Select the Transient electrical loads cause

➢ Using the Properties viewer, edit the Name field to: Transient electrical loads due to varying power source



Session 2.4: Failure Analysis

DISCUSSION 2.4.3 COMPONENT FAILURE DIAGRAMS

• Failure condition describes the behaviour of the failure and is connected to the fault. 

• It can be direct or consequential to the failure causing adverse operational conditions. 
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EXERCISE 2.4.3 COMPONENT FAILURE DIAGRAMS

To add a failure condition to the Control Unit failure diagram:

➢ Select the failure condition icon in Failure concepts

➢ Select and drag the Intermittent Operation failure concept to the failure diagram

➢ Delete the connection between Dielectric strength decreased and the Functional failure mode

➢ Connect the Dielectric strength decreased fault to the failure condition 

➢ Connect the failure condition to the failure mode
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DISCUSSION 2.4.4 PART FAILURE DIAGRAMS

• Part-level failure diagrams capture a more accurate 
location of failures

• Part-failure failure diagrams contain the most amount of 
detail on a failure

• Part-failure diagrams allow for better understanding of 
failures

• Better informed root cause analysis & diagnosis of failures

• Maintenance actions e.g. repair can be conducted more 
quickly and successfully as the root cause is identified 

• Part failure diagrams describe how physical failures 
result in a component’s loss of function/s
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EXERCISE 2.4.4 PART-LEVEL FAILURE DIAGRAMS

To construct part-level failure diagrams:

➢ Open the system model for the ‘Fuel Tank’

➢ Right-click the ‘Inlet’ part and select Failure Diagram

➢ From the Failure Concepts viewer select the Corrosive attack mechanism and add to the canvas
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EXERCISE 2.4.4 PART-LEVEL FAILURE DIAGRAMS (CONTINUED)

➢ Open the system model for the ‘Fuel Tank’

➢ Right-click the ‘Lining’ part and select Failure Diagram

➢ For simplicity, we will modify the failure diagram and delete the mechanisms Abrasive wear, Thermal Fatigue and 
Thermal degradation 

➢ To tidy up the failure diagram, delete the unconnected faults and causes
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EXERCISE 2.4.4 PART-LEVEL FAILURE DIAGRAMS (CONTINUED)

➢ Open the system model for the ‘Power Generation’

➢ Right-click the ‘Fuel Tank’ and select Failure Diagram

➢ Select      to expand the failure diagram of 
the Inlet_Lining and Lining_Outlet part-pairs

➢ Connect the faults in both the ‘Lining’ and ‘Inlet’ to 
the part-pair function

➢ Connect the part-pair function with the ‘Fuel Tank’ 
component function
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DISCUSSION 2.4.5 RESPONSE PATHS

• Since MADe is model-based, a list of all failures in the 
model are generated on-demand

• Failures are captured as discrete paths through the system 
to the End Effect Item

• Failure Diagrams split functional failure paths into multiple 
branches

• Failure Pathing can be checked at any time while modeling

• We use the Response Paths feature to accomplish this
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EXERCISE 2.4.5 RESPONSE PATHS

To generate response paths in the model:

➢ Right-click ‘Power Generation’ in the Project Explorer

➢ Select: Response Paths → FCM 

➢ In the Response Paths – FCM tab, expand item tree to view all of the model response paths

❖Note 1: The cause shows the ‘start’ of each path that MADe calculates

❖Note 2: Pathing is used for all FMEA/FMECA analyses
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DISCUSSION 2.4.6 PROPAGATION TABLE

• The Propagation Table shows the flow responses of items (columns) in the system that occur due to each 
individual functional failure (rows)

• Responses are shown in terms of High and Low responses

• Also shown: % of Detectable Failures, Threshold details
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EXERCISE 2.4.6 PROPAGATION TABLE

To generate the Propagation Table: 

➢ Select the Propagate All icon      from the icon toolbar

➢ Confirm Analysis Type: FCM

➢ Left-click to select all flows in the Propagation Focuses

➢ Select               to generate the Propagation Table
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EXERCISE 2.4.6: PROPAGATION TABLE (CONTINUED)

➢ The propagation table shows high and low failure responses for each item

➢ Based on the nominal state of each item

➢ Propagation table can be exported with linguistic or numerical responses
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SESSION 2.4 SUMMARY

✓2.4.1: Functional Failures

✓2.4.2: System & Subsystem Failure Diagram

✓2.4.3: Component Failure Diagrams

✓2.4.4: Part Failure Diagrams

✓2.4.5: Response Paths

✓2.4.6: Propagation Table
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SESSION 2.5 OUTLINE

2.5.1 Part Features

2.5.2 Part & Part-Pair Characteristics

2.5.3 Part Internal Environment
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DISCUSSION 2.5 FEATURES & CHARACTERISTICS

• Part & Pair Characteristics provide additional information on the operation and usage of an item

• Features are used to define specific locations of a part where a failure mechanism acts on

• Environmental Characteristics allow the user to define the local conditions impacting a part

• All 3 modeling capabilities are accessible for parts (only pair characteristics for part-pairs)
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DISCUSSION 2.5.1 PART FEATURES

• Features are used to identify specific areas or aspects of a part

• Main purpose is to provide additional detail to a failure diagram

• E.g. a crack occurred on the keyway of a shaft

• Provided with a features taxonomy to assist user

• New features can be added if no default features are applicable
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EXERCISE 2.5.1 PART FEATURES

To assign part features:

➢ Open the system model for the ‘Fuel Tank’

➢ Right-click the ‘Lining’ and select Features

➢ Select the Inner Surface feature

➢ Select
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EXERCISE 2.5.1 PART FEATURES (CONTINUED)

➢ Open the Failure Diagram for the ‘Lining’ part

➢ Right-click the Corrosive attack mechanism and select Features 

➢ Verify Feature dialog opens

➢ Select Inner Surface and then select

• The mechanism will now show it is occurring on the inner surface of the lining
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DISCUSSION 2.5.2 PART & PART-PAIR CHARACTERISTICS

• Characteristics are used to identify the specific operation of a part or pair

• They can be used to identify the loading types and states

• The loading can advise potential methods of failure

• E.g. a part in torsion, is likely to be susceptible to torsion or shearing mechanisms

• Future enhancements will look at automatically recommending failure concepts based on characteristics
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EXERCISE 2.5.2 PART & PART-PAIR CHARACTERISTICS

To specify part characteristics: 

➢ Right-click the ‘Lining’ part and select Characteristics

➢ Select Internal Pressure as the loading type

➢ Select Transient Load for the loading factor

➢ Select Low for the time factor

➢ Select

➢ Navigate to the Failure Diagram of the ‘Lining’

➢ Note the Characteristics in the bottom-right corner

➢ The characteristics are used to inform the user of the appropriate failure concepts to build
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DISCUSSION 2.5.3 PART INTERNAL ENVIRONMENT

• Internal environment is used to identify the local operating temperature of the item

• The internal environment is supposed to define internal environment while the system environment 
defines the external environment

• Bottom-up vs. top-down

• The environment can advise potential failures

• E.g. high temperature may lead to temperature induced mechanisms

• Future enhancements will look at automatically recommending failure concepts based on internal 
environment
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EXERCISE 2.5.3 PART INTERNAL ENVIRONMENT

To assign an internal environment:

➢ Right-click the ‘Lining’ and select Environment

➢ Select Corrosive Environment from Liquid and Solid Contamination

➢ Select the operating temperature as: Medium

➢ Select temperature time factor as: Steady

➢ Select 
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EXERCISE 2.5.3 PART INTERNAL ENVIRONMENT (CONTINUED)

➢ Navigate to the Failure Diagram of the ‘Lining’ part

➢ Note the Environment in the bottom-right corner

➢ Search the Mechanism Failure Concepts for Contamination

➢ Drag Buildup of debris into the Failure Diagram editor

➢ Note: This mechanism is located in the Material transfer folder

➢ Simplify the failure diagram (Insufficient Cleaning cause)
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SESSION 2.5 SUMMARY

✓2.5.1 Part Features

✓2.5.2 Part & Part-Pair Characteristics

✓2.5.3 Part Internal Environment
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SESSION 2 SUMMARY

✓2.1: Annotations

✓2.2: Failure Simulation

✓2.3: Mission Profile (Solution-dependent) & Groups

✓2.4: Failure Analysis

✓2.5: Features & Characteristics



Session 3: 
Safety Analyses

Using a MADe Model 

to generate key analyses from 

Safety & Risk Management domains
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SESSION 3 OUTLINE

3.1: Failure Mode & Effects Analysis (FMEA)

3.2: Criticality Analysis

3.3: Revised FMECA

3.4: Critical Item Analysis

3.5: Failure Conditions (FHA)

3.6: Common Mode Analysis (CMA)

3.7: Functional Fault Tree Analysis (FTA)
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SESSION 3 DISCUSSION

• Session 3 will take place in the SRA module.

• This session will focus on general safety assessments including: 

• FMEA

• Criticality Analysis

• FMECA

• Failure conditions in FHA

• Common Mode Analysis

• Functional Fault Tree
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SESSION 3.1 OUTLINE

3.1.1: Failure Mode & Effects Analysis Definition

3.1.2: FMEA Analysis in MADe

3.1.3: Generating a FMEA Report

3.1.4: Override Failure Diagrams – Functional Failure Settings
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DISCUSSION 3.1.1 FAILURE MODES & EFFECTS ANALYSIS DEFINITION

• MIL-STD-1629A

• Analyse each failure mode

• Determine their effects on the system

• Classify failure modes according to severity
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DISCUSSION 3.1.1 FAILURE MODE DEFINITION

• MIL-STD-1629A Failure Mode = MADe Failure Mode (Functional Failures only)

• How are physical failures captured in a MADe FMEA?
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DISCUSSION 3.1.1 FAILURE MODE DEFINITION (CONTINUED)

• A Failure Mode in a MADe model can have multiple Failure Paths (Physical Failures)



Session 3.1: FMEA

DISCUSSION 3.1.2 FMEA ANALYSIS IN MADE

• MADe generates a FMEA report based on the MADe system model created

• Each row represents one failure path and failure mode (including local, next & end effects)

• Severity Classification of each row is calculated from the Failure Mode Severity of the End effect Item
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EXERCISE 3.1.2 SETTING AN END EFFECT IN THE SYSTEM MODEL

Method 1: 

➢ Right-click the ‘Fuel Tank’ item in the Project Explorer

➢ Select End Effect Item from the menu

➢ Result: End effect is now the ‘Fuel Tank’ item (upward-pointing arrow     )

Method 2:

➢ Right-click the ‘Power Generation’ system on the System canvas

➢ Select End Effect Item from the menu

➢ Result: End effect will be set to the ‘Power Generation’ System

➢ Set the ‘Vehicle System’ to the End Effect using either method
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EXERCISE 3.1.2 EDIT THE END EFFECT ITEM SEVERITY

To change the Severity factor:

➢ Locate the ‘Power Generation’ subsystem in the Project Explorer 

➢ Expand the System Tree until Mechanical – rotational Torque is visible then select this item

➢ From the Properties viewer select the Criticality tab
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EXERCISE 3.1.2 EDIT THE END EFFECT ITEM SEVERITY (CONTINUED)

➢ Verify that the Failure Mode response (top tab) is set to: Low

➢ Change the Severity value to: 6.0

➢ Change the Failure Mode response (top tab) to: High

➢ Change the Severity value to: 9.0

➢ Save changes
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DISCUSSION 3.1.3 FMEA (MIL-STD-1629A) REPORT

There are 2 different FMEA reports available in MADe: 

• Component/Subsystem FMEA

• Component / Subsystem FMEA report is generated from any source and any selected end effect

• This report is a condensed report that can be used to report only on select component / subsystem

• System FMEA

• The system FMEA report is generated on all components for the entirety of the system 

• This report is a full report which captures all component and subsystem effects on the end effect 
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EXERCISE 3.1.3 GENERATE A FMEA (MIL-STD-1629A) REPORT

To generate a FMEA (MIL-STD-1629A) Report: 

➢ Select Reports → Report Wizard from the main menu

➢ Under Failure Mode Effects Analysis select FMEA (MIL-STD-1629A)

➢ Select        to proceed to next page

➢ Set the Level of Analysis to System

➢ Ensure Propagation Method is set to FCM

➢ Select                  to generate the report
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EXERCISE 3.1.3 GENERATE A FMEA (MIL-STD-1629A) REPORT (CONTINUED)

➢ Select Reports → Report Wizard from the main menu

➢ Under Failure Mode Effects Analysis select FMEA (MIL-STD-1629A)

➢ Select     to proceed to next page

➢ Set the Level of Analysis to Component/Subsystem

➢ Select the ‘Vehicle System’ item from the System Model list and 
select       to set as end effect

➢ Select the ‘Air Filter’ component from the ‘Diesel Engine’ 
Subsystem and select

➢ This will report on the ‘Air Filter’ component

➢ Select                  to generate the report



Session 3.1: FMEA

EXERCISE 3.1.3 GENERATE A FMEA (MIL-STD-1629A) REPORT
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EXERCISE 3.1.3 FMEA SEVERITY CLASSIFICATION
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DISCUSSION 3.1.4 OVERRIDE FAILURE DIAGRAMS – FUNCTIONAL FAILURE SETTINGS

Override failure diagram option is available for items with Failure Diagrams

• Override is selected: FMEA/FMECA does not report Failure Paths, only Failure Mode responses

• Override is not selected: FMEA/FMECA reports Failure Paths AND Failure Mode responses (additional rows)
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SESSION 3.1 SUMMARY

✓3.1.1: Failure Mode & Effects Definition

✓3.1.2: FMEA Analysis in MADe

✓3.1.3: Generating a FMEA Report

✓3.1.4: Override a Failure Diagram
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SESSION 3.2 OUTLINE

3.2.1: Criticality Analysis Definitions

3.2.2: Criticality Analysis – Risk Priority Number (RPN)

3.2.3: Assigning RPN Criticality Parameters in MADe

3.2.4: Generating a FMECA (RPN) report

3.2.5: Alternative Criticality Analyses in MADe

3.2.6: Criticality Profile Editor
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DISCUSSION 3.2.1 CRITICALITY & CRITICALITY ANALYSIS DEFINITION (MIL-STD-1629A)

• Criticality: A relative measure of the consequences of a failure mode and probability of occurrence

• Criticality Analysis (CA): A procedure by which each potential failure mode is ranked according to 
the combined influence of severity and probability of occurrence

Types of Failure Mode, Effects & Criticality Analysis (FMECA) in MADe:

• Risk Priority Number (RPN)

• Fuzzy Risk Priority Number (Fuzzy RPN)

• Criticality Analysis (MIL-STD-1629)

• Hazard Risk Index (HRI)
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DISCUSSION 3.2.2 CRITICALITY ANALYSIS – RISK PRIORITY NUMBERS (RPN)

• Risk Priority Number (RPN) is calculated using 3 criticality parameters: 

1) Occurrence (How often does it fail?)

2) Severity (How bad are the failures?)

3) Difficulty of Detection (How hard is it to detect these failures?)

Example: 

Risk Priority Number =  O × S × D = Failure Path Criticality No.

Occurrence (8)      × Severity (4)      × Difficulty of Detection (9) = 288

[Local Failure Mode] [End Effect Severity]               [Local Failure Mode]
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DISCUSSION 3.2.3 ASSIGNING RPN CRITICALITY PARAMETERS IN MADE

• Criticality factors are assigned to Faults & Failure Modes in the MADe model

• The table below shows where the Occurrence, Severity and Difficulty of detection parameters are editable 
for a RPN FMECA report

*Local Failure Mode severity is overwritten by End Effect Item Failure Mode severity

Failure Concepts Occurrence Severity Difficulty of Detection

Fault (Local Item) Yes No Yes

Failure Mode (Local Item) Yes Yes* Yes

Failure Mode (End Effect Item) Yes Yes Yes
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DISCUSSION 3.2.3 ASSIGNING RPN CRITICALITY PARAMETERS IN MADE

• Criticality factors are assigned to Faults & Failure Modes in the MADe model

• The criticality calculation for each failure mode follows the following procedure

Start

Use the end effect item to 

determine the severity

Take the earliest value of the 

visible path to determine 

occurrence

Take the earliest value of the 

visible path to determine 

difficulty of detection

O S D

RPN = O X S X D

End
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DISCUSSION 3.2.3 ASSIGNING CRITICALITY PARAMETERS FOR RPN (CONTINUED)

• Criticality Parameters for Faults & Failure conditions:

• Criticality Parameters for Failure Modes:
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EXERCISE 3.2.3 SET FUEL TANK CRITICALITY

To edit criticality values, open the Criticality editor by:

➢ Select Analyses→ Criticality & Reliability Editor from the menu bar

➢ Expand the System Tree to show the Corroded fault for the ‘Lining’ part in the ‘Fuel Tank’ component

➢ Change their Difficulty of Detection value to 6.0 and Occurrence value to 9.0
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EXERCISE 3.2.3 SET COUPLING CRITICALITY

➢ Expand the System Tree and select: Mechanical – rotational – Angular Velocity failure mode of the ‘Coupling 1’ 
component in the ‘Diesel Engine’

➢ Change Difficulty of Detection value to: 5.0

➢ Under the High section set Occurrence to: 1.0

➢ Under the Low section, set Occurrence to: 6.0
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EXERCISE 3.2.3 SET CONTROL UNIT CRITICALITY

➢ Expand the System Tree to show the Dielectric strength decreased faults in the ‘Control Unit’ component

➢ Change Difficulty of Detection value to 7.0 and Occurrence value to 7.0
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EXERCISE 3.2.4 GENERATE A FMECA (RPN) REPORT

To generate a FMECA (RPN) report: 

➢ Select Reports → Report Wizard from the menu

➢ Under Criticality select FMECA (RPN, PHMT)

➢ Set Level of Analysis to System

➢ Set ‘Power Generation’ as the End-Effect item

➢ Select after each page

➢ Confirm Report Format customizations

➢ Confirm Company Details

➢ Select to generate the report
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EXERCISE 3.2.4 GENERATING A RPN FMECA REPORT (CONTINUED)



DISCUSSION 3.2.5 ALTERNATIVE CRITICALITY ANALYSES IN MADE

• FMECA (MIL-STD-1629A) uses a different set of criticality parameters (see table below)

• In order to edit these values using the Reliability Editor you must be in the RAM 
module

¹Criticality Parameter is overwritten when Failure Diagram is present

²Criticality Parameter is overwritten when Mission Profile is present

Location

Criticality Parameters

Failure Effect Probability
(β)

Failure Mode Ratio (α) Failure Rate (λp) Operating Time (t)

Fault (Local Item) Yes Yes¹ No No

Failure Mode (Local Item) Yes¹ Yes No No

Reliability Editor (Local Item) No No Yes Yes²

Mission Profile No No No Yes

Session 3.2: Criticality Analysis
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EXERCISE 3.2.5 ALTERNATIVE CRITICALITY ANALYSES IN MADE
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DISCUSSION 3.2.6 CRITICALITY PROFILE EDITOR

• Criticality Profile Editor is used to manage default and user-defined Criticality profiles.

• Criticality profiles can be application-based or project-based

• Project-based = saved to a specific MADe project file

• Application-based = saved to a user profile / local PC

• There are 4 default Criticality Profiles:

• PHMT Fuzzy Criticality

• PHMT ISO26262 Criticality

• PHMT Risk Assessment Criteria (FAA)

• PHMT Risk Assessment Method (RAC)

• User can create & edit an Application Profile then set it as a Project Criticality Profile
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DISCUSSION 3.2.6 CRITICALITY PROFILE EDITOR (CONTINUED)

• Criticality Profile Editor is divided into:

1. Overview/Management page – where Criticality Profiles are managed

2. Criticality Profiles landing pages shows a summary of:

• Criticality factors

• Range charts

• Fuzzy Membership Graphs

• Severity terms

3. Criticality Profile sub-pages

• Setup for individual criticality factors

• Setup for fuzzy rule base
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EXERCISE 3.2.6 CREATE A CRITICALITY PROFILE – FUZZY RPN

To create a Criticality Profile:

➢ Select Preferences→ Criticality Profile Editor

➢ Under the Application Profiles section, create a new profile (Select )

➢ From the dialog, enter Profile Name: Custom RPN Profile

➢ Select Criticality Profile Type: Fuzzy RPN

➢ Select 
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EXERCISE 3.2.6 CREATE A CRITICALITY PROFILE – FUZZY RPN (CONTINUED)

➢ Double-click Custom RPN Profile in table or right-click on the Custom RPN Profile and select Open Profile

➢ Select the unlock icon to allow editing of fuzzy memberships (     → )
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EXERCISE 3.2.6 CREATE A CRITICALITY PROFILE – FUZZY RPN (CONTINUED)

To apply the Custom RPN Profile to the project: 

➢ On the Criticality Profile Editor Overview/Management page, right click the Custom RPN Profile under the Application 
Profiles section

➢ Select Copy profile to project 

➢ Under Project Profiles, select Custom RPN Profile as the Active Project Profile
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DISCUSSION 3.2.6 FUZZY RPN CRITICALITY FACTORS

• Fuzzy RPN is calculated from 3 factors:

• Apparent Occurrence, based on:

1. Causal Probability

2. Occurrence

• Apparent Severity, based on:

3. Progression Rate

4. Severity

• Difficulty of Detection, set from:

5. Fault

6. Item FFM

❖Note 1: Difficulty of Detection is taken from Fault if present, otherwise FFM

❖Note 2: Causal Probability is taken from highest causal connection present in Failure Diagram

#1, #3

#2, #5

#1

#4, #6
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DISCUSSION 3.2.6 FUZZY RPN CRITICALITY FACTORS (CONTINUED)

• Apparent Occurrence is a compound factor based on Causal Probability & Occurrence

• Causal Probability is set from 4 causal connections:

1. Mechanism & Fault

2. Mechanism & Failure condition

3. Failure condition & Fault

4. Fault & Functional Failure Mode

• Occurrence is set from 3 failure concepts:

1. Faults

2. Failure conditions

3. Item Functional failure modes (FFM)
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EXERCISE 3.2.6 SET CAUSAL PROBABILITY MEMBERSHIPS

To set the causal probability memberships:

➢ Select the Causal Probability figure under the Fuzzifiers section

➢ There are 3 linguistic terms: Low, Moderate, High

➢ Change the Low linguistic term colour to green
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EXERCISE 3.2.6 SET CAUSAL PROBABILITY MEMBERSHIPS (CONTINUED)

➢ Open ‘Air Filter’ Failure Diagram

➢ Select causal connection between the Abrasive Wear mechanism & Perforated fault

➢ Set Causal Probability slider to 2.00
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EXERCISE 3.2.6 SET OCCURRENCE MEMBERSHIPS

To set Occurrence memberships:

➢ Select the Occurrence figure under the Fuzzifiers section

➢ Verify that there are 5 linguistic terms

➢ Open ‘Air Filter’ Failure Diagram

➢ Select the Perforated fault

➢ Under Criticality Tab in the Properties Viewer, verify that 
the Causal Probability slider has:

➢ The same colour schema

➢ The same linguistic terms

➢ Set Occurrence slider to 9.0
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EXERCISE 3.2.6 SET APPARENT OCCURRENCE MEMBERSHIPS

To set Apparent Occurrence membership:

➢ Select the Apparent Occurrence figure under the Fuzzifiers section

➢ Simplify the Linguistic terms by deleting Very Low & Very High using the button

➢ For the Low Linguistic Term:

➢ Set Point 1 to X-Y Coordinates (0.0, 0.0) – select table cells for X or Y coordinates

➢ Set Point 2 to X-Y Coordinates (1.0, 1.0)

➢ For the High Linguistic Term:

➢ Set Point 3 to X-Y Coordinates (9.0, 1.0)

➢ Set Point 4 to X-Y Coordinates (10.0, 0.0)
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EXERCISE 3.2.6 TEST APPARENT OCCURRENCE MEMBERSHIPS

To test the Apparent Occurrence memberships:

➢ Select the Apparent Occurrence tab

➢ To verify Apparent Occurrence is providing the required results:

➢ Enter Causal Probability as 7.6

➢ Enter Occurrence as 6.5

➢ Select

➢ Note the following:

➢ Apparent Occurrence is 6.5

➢ Membership is 0.5

➢ Linguistic Term is Moderate
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DISCUSSION 3.2.6 APPARENT OCCURRENCE RULES

• Rules page is used to associate Apparent Occurrence terms with:

• Occurrence (Rows)

• Causal Probability (Columns)

• Changes are made by hovering over each grid square:

• The GUI shows an arrow indicating which shade (linguistic term) a grid square can be changed to

• Example: Selecting the rectangle for Moderate Causal Probability & Moderate Occurrence will yield two arrows 
enabling the user to change it to either high or low
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EXERCISE 3.2.6 SET APPARENT OCCURRENCE RULES

To set Apparent Occurrence rules: 

➢ Select the Rules tab under Apparent Occurrence

➢ Change the grid squares from the default selection (left figure) to a new rule setup (right figure)
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EXERCISE 3.2.6 TEST UPDATED APPARENT OCCURRENCE MEMBERSHIPS

To test the Apparent Occurrence Memberships:

➢ Select the Apparent Occurrence

➢ To verify Apparent Occurrence rules have been updated:

➢ Enter Causal Probability as 7.6

➢ Enter Occurrence as 6.5

➢ Select

➢ Note the following:

➢ Apparent Occurrence is 6.80

➢ Membership is 0.81

➢ Linguistic Term is High
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DISCUSSION 3.2.6 FUZZY RPN CRITICALITY FACTORS

• Apparent Severity is a compound factor based on Progression Rate & Severity

• Progression rate set from causal connection between a Mechanism & Fault

• Severity is set from an item FFM
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EXERCISE 3.2.6 SET PROGRESSION RATE MEMBERSHIP

To set the Progression Rate membership: 

➢ Select the Progression Rate figure under the Fuzzifiers section

➢ Verify that there are 4 linguistic terms: Low, Moderate, High, Very High

➢ Open ‘Air Filter’ Failure Diagram

➢ Select causal connection between the Abrasive Wear mechanism & Perforated fault

➢ Set Progression rate to 4.0 (Moderate)
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EXERCISE 3.2.6 SET SEVERITY MEMBERSHIP

To set the Severity membership: 

➢ Select the Severity figure under the Fuzzifiers section

➢ Verify that there are 5 linguistic terms

➢ Open ‘Air Filter’ Failure Diagram

➢ Select Refine Gas Mass Flow rate FFM

➢ In the Properties Viewer select Criticality 

➢ Select the Low tab

➢ Set Severity to 5.0
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EXERCISE 3.2.6 SET APPARENT SEVERITY MEMBERSHIP

To set Apparent Severity membership:

➢ Select the Apparent Severity figure under the Fuzzifiers section

➢ Simplify the Linguistic terms by deleting Very Low using the     button

➢ For the Low Linguistic Term:

➢ Set Point 1 to X-Y Coordinates (0.0, 0.0)

➢ Set Point 2 to X-Y Coordinates (1.0, 1.0)

➢ Change Low colour to a green shade

➢ Verify new Apparent Severity Memberships 



Session 3.2: Criticality Analysis

DISCUSSION 3.2.6 FUZZY CRITICALITY FACTORS

• Difficulty of Detection is set from either: 

• Fault

• Item FFM
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EXERCISE 3.2.6 VERIFY DIFFICULTY OF DETECTION LINGUISTIC TERMS

To verify the Difficulty of Detection linguistic terms:

➢ Select Difficulty of Detection figure under the Fuzzifiers section

➢ Verify that there are 5 linguistic terms: Very Low, Low, Moderate, High, Very High
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DISCUSSION 3.2.6 FUZZY CRITICALITY FACTORS

• Fuzzy Criticality is based on 3 factors:

• Apparent Occurrence

• Causal Probability

• Occurrence

• Apparent Severity

• Progression Rate

• Severity

• Difficulty of Detection

• Fuzzy Criticality has its own set of Memberships and Linguistic terms

• These memberships can be tested in the Criticality page

• Membership rules can be edited in the Rules page
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EXERCISE 3.2.6 VERIFY FUZZY CRITICALITY MEMBERSHIPS

First, view Criticality Rules:

➢ Select the Rules tab under Criticality

➢ Verify the matrices for all 5 linguistic severity terms: Very Low, Low, Moderate, High, Very High

Next, test Criticality Rules:

➢ Select the Criticality tab
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EXERCISE 3.2.6 VERIFY FUZZY CRITICALITY MEMBERSHIPS (CONTINUED)

To verify Criticality rules:

➢ Enter Apparent Occurrence as 8.0

➢ Enter Apparent Severity as 5.0

➢ Enter Difficulty of Detection as 9.0

➢ Select

➢ Note Fuzzy Criticality is 7.50

➢ Note Membership is 1.00

➢ Note Linguistic Term is High



Session 3.2: Criticality Analysis

EXERCISE 3.2.7 ADD FUZZY CRITICALITY PROFILE TO PROJECT

On the Criticality Profile Landing Page:

➢ Delete the Custom RPN Profile under the Project Profiles section

❖ Note: We may need to change the active profile

➢ Right click the Custom RPN Profile under the Application Profiles section

➢ Select Copy profile to project

➢ Select to add Custom RPN Profile to Project



Session 3.2: Criticality Analysis

EXERCISE 3.2.7 ADD FUZZY CRITICALITY PROFILE TO PROJECT (CONTINUED)

Set the Custom RPN Profile as the active project profile

➢ Select the drop down arrow menu to Active Project Profile

➢ Select Custom RPN Profile

➢ Confirm change of profile by selecting



Session 3.2: Criticality Analysis

EXERCISE 3.2.6 GENERATE FUZZY RPN REPORT

We can verify the previous fuzzy criticality test by generating the FMECA report (Fuzzy, PHMT):

➢ Open the Report Wizard

➢ Select FMECA (Fuzzy, PHMT) then 

➢ Set Level of Analysis to System 

➢ Set End Effect Item to ‘Air Filter’

➢ Select



Session 3.2: Criticality Analysis

EXERCISE 3.2.6 GENERATE FUZZY RPN REPORT (CONTINUED)

➢ After FMECA report generates, navigate to the last page

➢ Locate last row with ‘Perforated’ fault

➢ Verify Criticality Factors:

➢ Apparent Occurrence: High (8.0)

➢ Apparent Severity: Moderate (5.0)

➢ Difficulty of Detection: Very High (10.0)

➢ Fuzzy RPN: High (7.5) →Matches Fuzzy Criticality Test Result



Session 3.2: Criticality Analysis

SESSION 3.2 SUMMARY

✓3.2.1: Criticality Analysis Definitions

✓3.2.2: Criticality Analysis – Risk Priority Number (RPN)

✓3.2.3: Assigning RPN Criticality Parameters in MADe

✓3.2.4: Generating a FMECA (RPN) report

✓3.2.5: Alternative Criticality Analyses in MADe

✓3.2.6: Criticality Profile Editor



Session 3.3: Revised FMECA

SESSION 3.3 OUTLINE

3.3.1: Adding Detection Methods

3.3.2: Adding Compensating Provisions

3.3.3: Adding Failure Conditions

3.3.4: Revised FMECA Reporting



Session 3.3: Revised FMECA

DISCUSSION 3.3.1 DETECTION METHOD DEFINITION

• Detection Method: The means by which the existence of a failure mode becomes known to relevant 
personnel

• In MADe, Detection Methods are assigned to either:

• Failure Modes

• Faults (if Failure Diagram is present)



Session 3.3: Revised FMECA

EXERCISE 3.3.1 ASSIGNING DETECTION METHODS

To assign detection methods: 

➢ Open the Failure Diagram editor of the ‘Fuel Tank’ item

➢ Expand the boxes to Inlet_Lining→ Lining

➢ Right-click the Perforated fault and select Detection Methods

➢ Select the check box for Inspection

➢ Enter the narrative: Inspection by maintenance personnel

➢ Select   to close the dialog



Session 3.3: Revised FMECA

DISCUSSION 3.3.2 COMPENSATING PROVISION DEFINITION

• Compensating Provision: Actions that can be taken to negate or mitigate the effect of a failure on a system 

• In MADe, Compensating provisions are assigned to either:

• Failure Modes

• Faults (if a Failure Diagram Tree is present)



Session 3.3: Revised FMECA

EXERCISE 3.3.2 ASSIGNING COMPENSATING PROVISION

To assign a compensating provision: 

➢ Open the Failure Diagram editor of the ‘Fuel Tank’ item

➢ Expand the boxes to Inlet_Lining and ‘Lining’

➢ Right-click the Perforated fault and select Compensating Provisions

➢ Select the check box for Repair

➢ Enter the narrative : Repair in Local Depot

➢ Select                  to close the dialog



Session 3.3: Revised FMECA

EXERCISE 3.3.3 ASSIGNING FAILURE CONDITIONS

To assign failure conditions: 

➢ Open the Failure Diagram editor of ‘Secondary Fuel Filter’

➢ Disconnect the path from Blocked to Refine Liquid Flow rate

➢ Select the failure condition icon in the Failure Concepts window

➢ Select and drag the Loss of output Failure condition onto the Failure 
Diagram

➢ Connect the Blocked Fault to Loss of output

➢ Complete the path by connecting the Loss of output failure condition to 
the Functional Failure Mode



Session 3.3: Revised FMECA

EXERCISE 3.3.3 ASSIGNING FAILURE CONDITIONS (CONTINUED)

➢ Select the Loss of output and in the Properties viewer and enter the following narrative: No fuel flow through the 
Secondary Fuel Filter



Session 3.3: Revised FMECA

DISCUSSION 3.3.4 REVISED FMECA REPORT

• Failure Conditions, Detection Methods, and Compensating Provision information entered into the MADe 
model is captured in the FMECA report in their respective columns



Session 3.3: Revised FMECA

EXERCISE 3.3.4 REVISED FMECA REPORT

➢Generate a FMECA (RPN, PHMT) Report 
➢ Set the Level of analysis to System 

➢ Propagation Focus: FCM

➢ End Effect: Vehicle System

❖Note: Detection methods and narratives entered should be displayed on the FMECA report 



Session 3.3: Revised FMECA

SESSION 3.3 SUMMARY

✓3.3.1: Adding Detection Methods

✓3.3.2: Adding Compensating Provisions

✓3.3.3: Adding Failure Conditions

✓3.3.4: Revised FMECA Reporting



Session 3.4: Critical Item Analysis

SESSION 3.4 OUTLINE

3.4.1: Critical Item Analysis

3.4.2: Find & Replace: Criticality

3.4.3: Critical Item List



Session 3.4: Critical Item Analysis

DISCUSSION 3.4.1 CRITICAL ITEM ANALYSIS

• Identifies critical items based on a criticality threshold

• Fuzzy Criticality

• RPN

• MIL-STD-1629A

• HRI

• MIL-STD-882E

• ARP4761

• ISO 262626

• Bar chart will display the number of items in that category

• Apply ‘critical’ designation to items in system model



EXERCISE 3.4.1 PERFORMING CRITICAL ITEM ANALYSIS

To perform a critical item analysis on the model: 

➢ Select Analyses → Critical Item Analysis to open the editor

➢ Select       to change End effect to ‘Power Generation’

➢ Set the Propagation Type as FCM

➢ Select RPN as the Criticality Measure

➢ Change the threshold value to 200

➢ Select the                             button to display top critical items in the chart

Session 3.4: Critical Item Analysis



Session 3.4: Critical Item Analysis

DISCUSSION 3.4.2 FIND & REPLACE (CRITICALITY)

• Default criticality setting is set to 10 for OSD (critical until otherwise specified)

• Critical Item Analysis needs a complete analysis to work

• Find & Replace can be used to bulk edit information in the model (e.g. occurrence)



Session 3.4: Critical Item Analysis

EXERCISE 3.4.2 REPLACE OCCURRENCE USING FIND & REPLACE

To search and replace item parameters: 

➢ Select Edit → Find/Replace from the main menu

➢ Type “.” into the search box and select



EXERCISE 3.4.2 REPLACE OCCURRENCE USING FIND & REPLACE (CONTINUED)

➢ Select the Replace tab

➢ Select the Probability/Occurrence value from the parameter drop down list

➢ Select the Filter checkbox and 

➢ Deselect failure modes, failure conditions & faults for: ‘Coupling 1’, ‘Control Unit’ and ‘Fuel Tank’ (including parts)

Session 3.4: Critical Item Analysis



Session 3.4: Critical Item Analysis

EXERCISE 3.4.2 REPLACE OCCURRENCE USING FIND & REPLACE (CONTINUED)

➢ Set the new value for model parameter to: 1

➢ Select



DISCUSSION 3.4.3 CRITICAL ITEM LIST

• Items with failures above a certain threshold can be marked as Critical

• Critical Items are flagged in the model with a red symbol

• A Critical Item List (viewer) can be used to track Critical Items

Session 3.4: Critical Item Analysis



EXERCISE 3.4.3 APPLY CRITICAL ITEMS TO MODEL

To apply critical items to the model: 

➢ Select Analyses → Critical Item Analysis

➢ Set the RPN Threshold to: 600

➢ Select

➢ Review Critical Items in the table

➢ Select to mark items in the system model with the critical icon

Session 3.4: Critical Item Analysis



Session 3.4: Critical Item Analysis

SESSION 3.4 SUMMARY

✓3.4.1: Critical Item Analysis

✓3.4.2: Find & Replace (criticality)

✓3.4.3: Critical Item List



Session 3.5: Failure Conditions (FHA)

SESSION 3.5 OUTLINE

3.5.1: Failure Modes & Failure Conditions

3.5.2: Mission Profile Section

3.5.3: Environment Section

3.5.3: Criticality Section

3.5.4: Verification Methods Section

3.5.5: FHA Report



Session 3.5: Failure Conditions (FHA)

DISCUSSION 3.5.1 FAILURE CONDITIONS

Failure Conditions page in the Functional Model editor is used to:

• Associate Failure conditions to individual Functional Failures

• Define the Failure Condition Type

• Associate a Failure Condition with Mission Profile Phases/Segments

• Associate a Failure Condition with special conditions & environmental characteristics

• Associate a Failure Condition with a Criticality Profile, severity classifications, probabilities etc.

• Associate a Failure Condition with Verification Methods



Session 3.5: Failure Conditions (FHA)

EXERCISE 3.5.1 PRE-REQUISITE

For this section we will need to change the criticality profile to PHMT Risk Assessment Criteria (FAA). 

➢ Select Preferences → Criticality Profile Editor from the menu bar

➢ Select PHMT Risk Assessment Criteria (FAA) as the Active Project Profile



Session 3.5: Failure Conditions (FHA)

EXERCISE 3.5.1 ACCESS FAILURE CONDITIONS PAGE

To open the Functional Diagram editor:

➢ Select the System in Project Explorer, Modeling→ Functional Diagram

➢ Open Functional Diagram of the Provide Thrust function

➢ Open Failure Condition page for Distribute Mechanical Motion

➢ Right-click Distribute Mechanical Motion then select Failure Condition from menu



Session 3.5: Failure Conditions (FHA)

DISCUSSION 3.5.1 FAILURE CONDITIONS PAGE

• The Failure Condition page enables user to create:

• 1 or more Failure Modes per Function

• 1 or more Failure Conditions per Failure Mode

• This page summarises the following information:

• Severity Classification

• Maximum probability of Failure Condition

• Verification methods



EXERCISE 3.5.1 CREATE A NEW FAILURE MODE & FAILURE CONDITION

To create a new Failure Mode:

➢ In the Distribute Mechanical Motion Failure Conditions page:

➢ Select       to add a new Failure Mode

➢ From the Create new Failure Mode dialog:

➢ Enter name: Inability to Distribute Mechanical Motion (Forward)

➢ Select the newly created Failure Mode 

➢ In the Functional Failure Details section, enter Failure Effect Narrative:

Failure of this function will prevent forward movement of the vehicle system.

Session 3.5: Failure Conditions (FHA)



Session 3.5: Failure Conditions (FHA)

EXERCISE 3.5.1 CREATE A NEW FAILURE MODE & FAILURE CONDITION (CONTINUED)

➢ Select the newly created Failure Mode

➢ Select the Add new Failure Condition icon

➢ Select the newly added Failure Condition

Update Failure Condition Details section:

➢ Rename Failure Condition: Failure Condition 1

➢ Select Failure Condition Type: Loss of Output

➢ Enter Failure Condition Narrative: Loss of output due to power source failure.



Session 3.5: Failure Conditions (FHA)

DISCUSSION 3.5.2 MISSION PROFILE SECTION

• This section allows the user to select applicable mission profiles to a selected failure condition

• User selects applicable mission phases/segments where the failure condition occurs



Session 3.5: Failure Conditions (FHA)

EXERCISE 3.5.2 SELECT MISSION PROFILE DETAILS

To edit the Mission Profile details for the Failure Condition:

➢ Select Failure Condition 1

➢ Select the Mission Profile tab

➢ From the drop down menu and select Regular Trip

➢ Select the following Mission Phases:

➢ Acceleration

➢ Cruise

➢ Turning

➢ Cruise 2

➢ Deceleration



Session 3.5: Failure Conditions (FHA)

DISCUSSION 3.5.3 ENVIRONMENTAL SECTION

• This section allows the user to select applicable Special Conditions & Environmental Characteristics relating 
to the selected Failure Condition



Session 3.5: Failure Conditions (FHA)

EXERCISE 3.5.3 SELECTING SPECIAL CONDITIONS AND ENVIRONMENTAL CHARACTERISTICS

➢ Select the Environment tab

➢ Select Special Condition: Very Low Visibility

➢ Select Environmental Characteristic: High Temperature



Session 3.5: Failure Conditions (FHA)

DISCUSSION 3.5.4 CRITICALITY SECTION

• This section allows the user to set:

• An applicable criticality profile

• Assign a severity class to the selected failure condition & view corresponding Design Assurance Level (DAL)

• Assign a maximum probability for the failure condition

• Enter an annotation regarding the criticality entry



Session 3.5: Failure Conditions (FHA)

EXERCISE 3.5.4 SELECT CRITICALITY DETAILS

➢ Select the Criticality tab

➢ Verify Criticality Profile is set to PHMT Risk Assessment Criteria (FAA), if not, set it in the Criticality Profile Editor

➢ Select the Criticality Profile icon

➢ Set the Active Project Profile as PHMT Risk Assessment Criteria (FAA)

➢ Set Severity Class as Severe Major

➢ Enter Annotation: Severity classification is based on ENG Dept criticality rating table.

➢ Verify DAL: Level B

➢ Set Max. Probability: 1E-2



Session 3.5: Failure Conditions (FHA)

DISCUSSION 3.5.4 VERIFICATION METHODS SECTION

• This section allows the user to enter verification methods used to check for a failure condition

• Verification Methods are divided into four categories:

• Analysis

• Inspection

• Test

• Demonstration



Session 3.5: Failure Conditions (FHA)

EXERCISE 3.5.4 SELECT VERIFICATION METHODS DETAILS

➢ Select the Verification Methods tab

➢ Enter the following: 

➢ Analysis: FMECA

➢ Inspection enter: Visual Inspection

➢ Test: None

➢ Demonstration: Start-up built-in diagnostic check



Session 3.5: Failure Conditions (FHA)

DISCUSSION 3.5.5 FHA REPORT

• This Report Summarises the Function List & Failure Condition pages for all Functions in the Functional Model

• Report is divided into sections:

• Function List

• Environment & Emergency Configuration List

• Derived Safety Requirements List

• Functional Hazard Assessment



Session 3.5: Failure Conditions (FHA)

EXERCISE 3.5.5 GENERATE FHA REPORT

To generate a FHA report: 

➢ Select       from the icon toolbar 

➢ Select Functional Hazard Assessment (SAE ARP4761)

➢ Select 

➢ Verify FHA Analysis: Vehicle System

➢ Select Mission Profile: Regular Trip

➢ Select



Session 3.5: Failure Conditions (FHA)

SESSION 3.5 SUMMARY

✓3.5.1: Failure Modes & Failure Conditions

✓3.5.2: Mission Profile Section

✓3.5.3: Environment Section

✓3.5.3: Criticality Section

✓3.5.4: Verification Methods Section

✓3.5.5: FHA Report



Session 3.6: Common Mode Analysis (CMA)

SESSION 3.6 OUTLINE

3.6.1: CMA in ARP4761 Context

3.6.2: CMA Editor Layout

3.6.3: Common Mode Item Search

3.6.4: Common Mode Events

3.6.5: CMA Worksheet

3.6.6: CMA Report



Session 3.6: Common Mode Analysis (CMA)

DISCUSSION 3.6 COMMON MODE ANALYSIS PRE-REQUISITE

Pre-requisite: Add the Failure Condition Failure to Cease Operation to Perforated Fault in ‘Primary Fuel Filter’
component failure diagram

This piece of information will be used in the analysis.



Session 3.6: Common Mode Analysis (CMA)

DISCUSSION 3.6.1 CMA IN ARP4761 CONTEXT

• ARP4761 Standard: Guidelines & methods of performing safety assessment for certification of civilian 
aircraft

• CMA Definition: Verify that ANDed events in FTA, Dependence Diagrams (DD) & Markov Analysis (MA) are 
independent in the actual implementation

• Analyse effects of Design, Manufacturing, Maintenance errors & Failures of components which defeat their 
independence

• Consider independence of functions & their respective monitors

• E.g. Items with identical hardware/software could be susceptible to the same faults

• Performed during Concept and Preliminary Design Stages

• CMA is performed at 2 levels: Platform (e.g. Aircraft) Level & System Level

• Pre-requisites: BOM/FBD Model, Failure Diagrams, RBD Groups



Session 3.6: Common Mode Analysis (CMA)

DISCUSSION 3.6.2 COMMON MODE EDITOR LAYOUT

The default layout of the CMA editor consists of:

• Vertical Tabs (Left): Overview, CMA Events & Common Mode Event Worksheet pages

• Overview Page: Displays a list of CMAs including CMA details & a pie chart

• Analysis Page: Displays search options & results, and Common Mode Events

• Worksheet Page: Displays Common Mode Failures & details



Session 3.6: Common Mode Analysis (CMA)

EXERCISE 3.6.2 CREATE A COMMON MODE ANALYSIS

To create a new CMA:

➢ Select Analyses → Common Mode Analyses from the main menu



Session 3.6: Common Mode Analysis (CMA)

EXERCISE 3.6.2 CREATE A NEW CMA

From the Overview page:

➢ Select      to create a new Common Mode Analysis

➢ From the dialog:

➢ Enter Name: Training CMA

➢ Enter Description: An example CMA for training purposes.

➢ Select Indenture: ‘Power Generation’

➢ Select 



Session 3.6: Common Mode Analysis (CMA)

DISCUSSION 3.6.3 COMMON MODE ITEM SEARCH

• The Analysis page is used to conduct an initial search of items based on 3 criteria:

• Items arranged in a Parallel RBD group (covered in Session 4.3)

• Items with common failure concepts

• Searching for items by display name

• Candidate items are grouped into a Common Mode Event for further evaluation in the Worksheet page

• Common Mode Events are also used to capture:

• Description of common mode items

• Relevant requirements if applicable (see ARP4761 examples)



Session 3.6: Common Mode Analysis (CMA)

EXERCISE 3.6.3 COMMON MODE ITEM SEARCH

In the Search Options section:

➢ Select the Failure Concept check box

➢ Select the Failure Concept Icon       to browse for a relevant failure concept

➢ From the dialog search for Solid Particle Contaminants

➢ Select the Cause Failure Concept under Cause → Operation → Contamination

➢ Select          to close dialog

➢ Select                       button



Session 3.6: Common Mode Analysis (CMA)

EXERCISE 3.6.3 COMMON MODE ITEM SEARCH (CONTINUED)

➢ Verify that the Search Results & Events table displays a current search result below

❖Note: ‘Primary Fuel Filter’ will not appear due to the failure diagram override. To 
deactivate failure diagram override, right click the ‘Primary Fuel Filter’ component from 
the Project Explorer and select Override Failure Diagram. 

➢ Once this has been done, select                       to re-run the search results

➢ Verify that ‘Primary Fuel Filter’ is displayed in the search results



Session 3.6: Common Mode Analysis (CMA)

DISCUSSION 3.6.4 COMMON MODE EVENTS

• Common Mode Events are used to aggregate selected items for further analyses

• Each CMA can have multiple Common Mode Events

• Each Common Mode Event stores the following information:

• Event Name

• Event Description

• Event Requirements

• List of items

• CMA Worksheet data



Session 3.6: Common Mode Analysis (CMA)

EXERCISE 3.6.4 CREATE A COMMON MODE EVENT

In the Search Results & Events section:

➢ Highlight 3 components: ‘Injector Pump’, ‘Primary Fuel Filter’ & ‘Secondary Fuel Filter’

➢ Ctrl + Left Select

➢ There are 3 methods to create a Common Mode Event:

➢Method 1: Drag-and-drop selected items to the Common Mode Event table

➢Method 2: Right-click and select Create New Event

➢Method 3: Select      and from New Common Mode Event dialog:

➢ Enter an Event Name

➢ Enter a Event Description

➢ Select Item check boxes to include into CMA 

➢ Select 

➢ Open Common Mode Event: Select      or Double-click Event



Session 3.6: Common Mode Analysis (CMA)

DISCUSSION 3.6.5 CMA WORKSHEET

• This page captures common mode failures for items included in the Common Mode Event

• Common Mode Failure details include:

• Failure Type/Sub-type (As per ARP4761 & CMA Literature)

• Failure Source/Error: Common Failure Concepts

• Failure Conditions & Narratives

• Failure Justification: Explain how this common mode failure occurs for all items

• Mitigating Action: What must be done to prevent this common mode failure from happening

• Status: whether a common mode failure is dependent/independent



Session 3.6: Common Mode Analysis (CMA)

EXERCISE 3.6.5 CREATE COMMON MODE FAILURES

➢ Create a new Common Mode Failure by selecting th

➢ Verify common mode failure in first row of table with ID of 1 & Status: Incomplete

➢ For Requirements, input the narrative: Design requirements 1-10.

➢ Select Failure Type & Sub-Type: Design Architecture, Mechanical Property

➢ Select Source/Error icon to open dialog:

➢ Search for Flow Rate (Flow Property →Material → Liquid) then select 

➢ Select Failure Condition: Loss of output

➢ Enter Justification: Common Filter dimensions

➢ Enter Mitigating Action: Decrease inspection interval to 7 days.

➢ Select Status: Dependent



Session 3.6: Common Mode Analysis (CMA)

EXERCISE 3.6.5 CREATE COMMON MODE FAILURES (CONTINUED)



Session 3.6: Common Mode Analysis (CMA)

EXERCISE 3.6.5 CREATE COMMON MODE FAILURES (CONTINUED)

➢ Create a second Common Mode Failure by selecting

➢ Verify common mode failure in first row of table with ID of 2 & Status: Incomplete

➢ Select Failure Type & Sub-Type: Operation, Procedure

➢ Select Source/Error icon to open dialog:

➢ Search for Perforated (Fault → Perforated) then select 



Session 3.6: Common Mode Analysis (CMA)

EXERCISE 3.6.5 CREATE COMMON MODE FAILURE (CONTINUED)

➢ Select Failure Condition: Failure to cease operation

➢ Enter Justification: High pressure differential due to solid contaminants from low-grade fuel.

➢ Enter Mitigating Action: None. Primary fuel filter has higher pressure limits than secondary filter.

➢ Select Status: Independent



Session 3.6: Common Mode Analysis (CMA)

EXERCISE 3.6.5 CREATE COMMON MODE FAILURES (CONTINUED)



Session 3.6: Common Mode Analysis (CMA)

EXERCISE 3.6.5 CREATE COMMON MODE FAILURES (CONTINUED)

➢ Create a third Common Mode Failure by selecting

➢ Verify common mode failure in first row of table with ID of 3 & Status Incomplete

➢ Select Failure Type & Sub-Type: Maintenance, Personnel

➢ Select Source / Error icon to open dialog:

➢ Search for Insufficient cleaning (Maintenance → Procedure) then select 

➢ Leave all other fields blank

➢ Verify Status for current Common Mode Failure as Incomplete

➢ Return to Overview/Management tab

➢ Verify Common Mode Analysis Summary Graph



Session 3.6: Common Mode Analysis (CMA)

EXERCISE 3.6.5 CREATE COMMON MODE FAILURES (CONTINUED)



Session 3.6: Common Mode Analysis (CMA)

DISCUSSION 3.6.6 CMA REPORT

• This report summarises each CMA, including Common Mode Events & Items

• The CMA Report is divided into sections:

• CMA Report Summary

• Common Mode Events

• Reference Documents, Drawings & Support Material



Session 3.6: Common Mode Analysis (CMA)

EXERCISE 3.6.6 GENERATE CMA REPORT

To generate a CMA Report:

➢ From the menu bar, select Report → Report Wizard

➢ Select Common Mode Analysis then select

➢ Verify CMA Analysis: Training CMA

➢ Verify Common Mode Event: New Event 1

➢ Select 



Session 3.6: Common Mode Analysis (CMA)

SESSION 3.6 SUMMARY

✓3.6.1: CMA in ARP4761 Context

✓3.6.2: CMA Editor Layout

✓3.6.3: Common Mode Item Search

✓3.6.4: Common Mode Events

✓3.6.5: CMA Worksheet

✓3.6.6: CMA Report



Session 3.7: Functional Fault Tree Analysis (FTA)

SESSION 3.7 OUTLINE

3.7.1: Fault Tree Builder

3.7.2: Fault Tree Analysis (Model-based) 

3.7.3: Custom Fault Tree 

3.7.3: Custom Fault Tree Properties

3.7.4: Custom Fault Tree Analysis



Session 3.7: Functional Fault Tree Analysis (FTA)

DISCUSSION 3.7 FAULT TREE BUILDER

• The Fault Tree Builder identifies all Faults that lead to an End Effect

• Three different fault tree options are presented: 

• User Defined allows customization of the Functional Fault Tree

• Model-based Analysis automatically generated the Functional Fault Tree according to the model 

• Hardware Fault Tree generated the Fault Tree based on the RBD

❖Note: Hardware Fault Tree will be covered in Session 4.6. 



Session 3.7: Functional Fault Tree Analysis (FTA)

DISCUSSION 3.7 FAULT TREE BUILDER (CONTINUED)

• The Functional Fault Tree Builder allows customization of the Fault Tree

• Various gates can be implemented to represent a specific configuration / use case

• AND 

• OR

• K of N

• Transfer

• Various Events can be assigned to the root cause 

• Basic Event

• House Event

• Undeveloped Event



Session 3.7: Functional Fault Tree Analysis (FTA)

DISCUSSION 3.7 FAULT TREE BUILDER (CONTINUED)

• Event Types and Probability of Failure can be specified using the Properties viewer

• Types of Gates: 

AND gates represents the output flow occurring if all inputs occur 

OR gates represent the output flow occurring if any one of the input flows occur

K of N gates represent the output flow occurring only if ‘K’ of the input flows occur

Transfer gates breaks up the fault tree into separate diagrams whilst maintaining connectivity. This is particularly 
useful when the fault tree gets large in size and become hard to follow. It will assist in presenting the fault tree in a 
readable manner, allowing sections of the fault trees to be separated. There is no mathematical calculations 
involved with the Transfer gate. 



Session 3.7: Functional Fault Tree Analysis (FTA)

DISCUSSION 3.7 FAULT TREE BUILDER (CONTINUED)

• Types of Events: 

Basic Event is an event which does not develop any further

House Event is an event which is normally expected to occur

Undeveloped Event is an event which is not further developed either because it is of insufficient consequence or 
because information is unavailable 

• Event Properties: 

• Event ID: Pre-assigned ID for the Fault Tree branch 

• Event Code: Custom event code to display on the Fault Tree, this field can be used to capture repeat events

• Narrative: Text field to add additional details of the event



Session 3.7: Functional Fault Tree Analysis (FTA)

EXERCISE 3.7.1 FAULT TREE BUILDER (MODEL-BASED)

To create a Model-based Functional Fault Tree:

➢ Right-click the ‘Power Generation’ in the Project Explorer

➢ Select Fault Tree → Fault Tree Builder

➢ This will be the landing page for the Fault Tree Builder where all Fault Tree analyses will be listed



Session 3.7: Functional Fault Tree Analysis (FTA)

EXERCISE 3.7.1 FAULT TREE BUILDER (MODEL-BASED) (CONTINUED)

➢ Set the first Convert Mechanical – rotational Angular velocity Low (Vehicle System) as the Top Event

➢ Enter the following details: 

➢ Name: Demonstration Fault Tree Analysis

➢ Description: Fault tree with Low Angular velocity as the top event

➢ Set Fault Tree Type to Model-based Analysis

➢ Set Propagation Type to FCM

➢ Select                  to generate the fault tree



Session 3.7: Functional Fault Tree Analysis (FTA)

EXERCISE 3.7.1 FAULT TREE BUILDER (MODEL-BASED) (CONTINUED)

➢ Fault tree is generated from the model



Session 3.7: Functional Fault Tree Analysis (FTA)

DISCUSSION 3.7.2 FAULT TREE ANALYSIS (MODEL-BASED)

• The Fault Tree analysis page displays the Fault tree as well as Analysis controls in the window below

• Edit Mode      allow change to be made to the Fault Tree

• Event Table Controls: 

• Event List displays all the elements within the fault tree with the respective analysis data  

• MCSQ displays the minimum cut-set sequences of the fault tree

• RI % Ranking displays the relative importance

• Calculations on the fault tree are derived from Minimum Cut-set Sequence methodology which considers repeat events
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DISCUSSION 3.7.2 FAULT TREE ANALYSIS (MODEL-BASED) (CONTINUED)

• Repeat events can be modelled in the fault tree and are denoted by the same Event code

• The notation for repeat event codes in MADe is Event Code : Number of repeats

• Once a repeat event is selected, the repeat events are also highlighted
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DISCUSSION 3.7.2 FAULT TREE ANALYSIS (MODEL-BASED) (CONTINUED)

• Probability of Failure Relative Importance type:

• Birnabaum: A value assigned to each basic event indicating its relative increase to risk of failure

• Fussel-Vesely: A value assigned to each basic event indicating its contribution to the top level event failure

• Refresh and Calculate the P(f) values by selecting    

• Select        to export the table to a .csv



Session 3.7: Functional Fault Tree Analysis (FTA)

EXERCISE 3.7.2 FAULT TREE ANALYSIS (MODEL-BASED)

To modify the Event Type and P(f) of a fault:

➢ Select the Convert Mechanical – rotational Angular velocity Low (Vehicle) Undeveloped event

➢ Navigate to the Properties viewer and input the following

➢ General Tab: 

➢ Event Code: LOW1 

➢ Narrative: Low angular velocity of a wheel in the vehicle system. 

➢ Event Tab: 

➢ Event Type: Basic Event 

➢ Probability of Failure: P(f) User-defined, Event P(f): 0.005

❖Note: Intermediate Events cannot be changed

❖Note: Although we have specified Model-based for the analysis, there is the 
option to manually adjust P(f) as required. 
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EXERCISE 3.7.2 FAULT TREE ANALYSIS (MODEL-BASED) (CONTINUED)

➢Calculate the P(f) of the Fault tree by selecting 
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DISCUSSION 3.7.3 CUSTOM FAULT TREE

• User-defined fault trees can be created to represent specific scenarios to calculate the probability of failure

• The custom fault tree capability allows events to be added in the order the user specifies as well as 
allowing the Probability of failure to be manually entered

• Failure conditions can be associated with the top event to provide context of the top event failure
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EXERCISE 3.7.3 CUSTOM FAULT TREE

To create a Custom Function Fault Tree Analysis:

➢ On the Fault Tree Builder landing page, select

➢ In the dialogue, enter the following: 

➢ Name: Custom Fault Tree Analysis

➢ Description: Custom Fault Tree Analysis doe the Control Unit.

➢ Select Process Continuous Amplitude Low (Control Unit) as 
the top event



Session 3.7: Functional Fault Tree Analysis (FTA)

EXERCISE 3.7.3 CUSTOM FAULT TREE (CONTINUED)

➢ The Fault Tree Builder will place the Top Event on the Fault Tree Builder canvas

➢ By default it is set to the ‘Modeling mode’. This can be toggled selecting 

➢ Fault Tree – Event list can be viewed or hidden by selecting
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EXERCISE 3.7.2 CUSTOM FAULT TREE (CONTINUED)

➢ Select      under the top event to build the fault tree in sequential order

➢ In the Add Fault Tree Event dialog select the Model Event tab

➢ Select Process Continuous Amplitude Low Govenor) to add event to the Custom Fault Tree
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EXERCISE 3.7.2 CUSTOM FAULT TREE (CONTINUED)

Proceed to build the fault tree using the information below

➢ Top event: Process Continuous Amplitude Low (Control Unit)

➢ Next Intermediate Event: Convert Mechanical – rotational linear
Linear Velocity Low (Governor)

➢ Next Intermediate Event: Regulate Liquid Dynamic pressure
Low (Injector Pump) 

➢ Next Intermediate Event: Convert Mechanical – rotational Torque 
Low (Engine) 

➢ Basic Events: Corroded (Engine), Abraded (Engine), Scratched (Engine)
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EXERCISE 3.7.2 CUSTOM FAULT TREE (CONTINUED)

➢ Select the      icon to add a Failure Condition to the top event

➢ Expand the Model-based tree and select Intermittent operation

➢ Select                   to add the Failure Condition to the tree



Session 3.7: Functional Fault Tree Analysis (FTA)

DISCUSSION 3.7.3 CUSTOM FAULT TREE PROPERTIES

The default gate type in the Fault Tree is an OR gate. 
To change a Gate Type: 

• Select the Gate

• In the Properties viewer, use the drop down menu to select the Gate Type

• Alternatively, use the icon toolbar and select the appropriate gate 

To change an Event Type:

• Select the Event

• In the Property window, use the drop down menu to select the Event Type

• Alternatively, use the icon toolbar and select the appropriate event type 
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EXERCISE 3.7.3 CUSTOM FAULT TREE PROPERTIES (CONTINUED)

Verify that the gate connecting Convert Mechanical – rotational 
Torque High (Engine) to the faults is an OR gate. 

Change the following events: 

➢ Corroded (Engine): House event

➢ Event Occurred: No (0.0)

➢ Abraded (Engine): Undeveloped Event



Session 3.7: Functional Fault Tree Analysis (FTA)

DISCUSSION 3.7.4 CUSTOM FAULT TREE ANALYSIS

• In the Fault Tree – Event List view there are three different tables which can be viewed:

• Event List

• MCSQ

• RI% Ranking
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DISCUSSION 3.7.4 CUSTOM FAULT TREE ANALYSIS (CONTINUED)

• Event List

• The event list shows the fault tree content in a list form. 

• The Relative Importance column is calculated using one of two methods: 

• Birnbaum

• Fussell-Vesely
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DISCUSSION 3.7.4 CUSTOM FAULT TREE ANALYSIS (CONTINUED)

• MCSQ (Minimum Cut-set Sequence) 

• Displays the minimum cut set with the relevant information. 
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DISCUSSION 3.7.4 CUSTOM FAULT TREE ANALYSIS (CONTINUED)

• RI% Ranking

• Displays the list of root causes and the calculated relative importance
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EXERCISE 3.7.4 CUSTOM FAULT TREE ANALYSIS

To refresh / calculate the Custom Fault Tree P(f):

➢ Select      

➢ Verify the P(f) of the Fault Tree Analysis with the table below

Event P(f)

Intermittent operation (Control Unit) 1.78 E-05

Process Continuous Amplitude Low (Control Unit) 1.78 E-05

Control Mechanical – linear Linear velocity Low (Governor) 1.78 E-05

Regulate Liquid Dynamic pressure Low (Injector Pump) 1.78 E-05

Convert Mechanical – rotational Torque Low (Engine) 1.78 E-05

Corroded (Engine) 0.00 E+00

Abraded (Engine) 8.89 E-06

Engine (Engine) 8.89 E-06



Session 3.7: Functional Fault Tree Analysis (FTA)

SESSION 3.7 SUMMARY

✓3.7.1: Fault Tree Builder

✓3.7.2: Fault Tree Analysis (Model-based) 

✓3.7.3: Custom Fault Tree 

✓3.7.3: Custom Fault Tree Properties

✓3.7.4: Custom Fault Tree Analysis



Session 3: Safety Analyses

SESSION 3 SUMMARY

✓3.1: Failure Mode & Effects Analysis (FMEA)

✓3.2: Criticality Analysis

✓3.3: Revised FMECA

✓3.4: Critical Item Analysis

✓3.5: Failure Conditions (FHA)

✓3.6: Common Mode Analysis

✓3.7: Functional Fault Tree Analysis



Session 4: 
Reliability Analyses

Using the MADe Model to generate key analyses from 
the Reliability and Availability domains



Session 4: Reliability Analyses

SESSION 4 OUTLINE

4.1: Reliability Block Diagram

4.2: Reliability Allocation

4.3: Reliability Editing

4.4: Failure Rate Prediction

4.5: Markov Analysis

4.6: Hardware Fault Tree Analysis (HFTA)



Session 4: Reliability Analyses

SESSION 4 DISCUSSION

• Session 4 will take place in the RAM module

• This session will focus on setting up and generating reliability analyses from the MADe model including: 

• RBD

• Reliability Allocation

• Failure Rate Prediction (MIL-HBK-217F)

• Markov Analysis

• Hardware Fault Tree



Session 4.1: Reliability Block Diagram

SESSION 4.1 OUTLINE

4.1.1: Reliability & Availability Block Diagrams 

4.1.2: Create RBD groups

4.1.3: Create ABD groups

4.1.4: Generate RBD Analysis

4.1.5: Generate ABD/RBD Report



Session 4.1: Reliability Block Diagram

DISCUSSION 4.1.1 RELIABILITY & AVAILABILITY BLOCK DIAGRAMS

• Availability/Reliability Block Diagrams are models showing reliability dependencies between items

• The blocks (subsystems, components, parts) are derived from system model items

• Both Availability and Reliability Block Diagrams share the same model structure

• Types of ABD/RBD groupings in MADe:

• Series Grouping

• Parallel Grouping

• Complex Group (Decomposition)

• Complex Group (Event Space)

• Standby Redundancy Grouping

• K/N Redundancy Grouping

• Exclusion Grouping



Session 4.1: Reliability Block Diagram

EXERCISE 4.1.2 CREATE RBD GROUPS

To apply a Series RBD grouping:

➢ Right-click ‘Vehicle System’ in Project Explorer viewer 

➢ Select RBD Model

➢ Select all items in the RBD Model editor

➢ Method 1: Shift + Select

➢ Method 2: Select and drag

➢ Select      from icon menu or Group → Series Group from the right-click menu

➢ Review reliability of series group and individual subsystems

❖Note: Within the RBD group, components and subsystems can be rearranged by 
clicking and dragging 



Session 4.1: Reliability Block Diagram

EXERCISE 4.1.2 CREATE RBD GROUPS (CONTINUED)

Continue to apply RBD groupings to items in the Driveline Subsystem:

➢ Right-click ‘Driveline’ Subsystem in Project Explorer & select RBD Model

➢ Create Series Group #1 and include:

➢ ‘Half Shaft Rear’, ‘Planetary Gearbox Rear’, ‘Wheel Resistance Rear’ & ‘Wheel Rear’

➢ Create Series Group #2 and include: 

➢ ‘Half Shaft Front’, ‘Planetary Gearbox Front’, ‘Wheel Resistance Front’ & ‘Wheel Front’

➢ Create Parallel group for Series Groups 1 & 2

➢ Create Series group for remaining items and include Parallel group

➢ Review reliability of top series group and individual sub-groups



Session 4.1: Reliability Block Diagram

EXERCISE 4.1.2 CREATE RBD GROUPS (CONTINUED)



Session 4.1: Reliability Block Diagram

EXERCISE 4.1.3 CREATE ABD GROUPS

Create the following ABD groupings to the ‘Diesel Engine’ subsystem:

➢ Right-click on the ‘Diesel Engine’ subsystem in Project Explorer and select ABD Model

➢ Create a K/N Redundancy Group and include:

➢ Air Filter, Primary Fuel Filter & Secondary Fuel Filter

➢ Set Functioning items / No. of Redundant Items (Properties viewer): 2/3

➢ Create an Exclusion Group and place the ‘Governor’ in the Exclusion Group



Session 4.1: Reliability Block Diagram

EXERCISE 4.1.3 CREATE ABD GROUPS (CONTINUED)

➢ Right-click on the ‘Diesel Engine’ subsystem in Project Explorer and select RBD Model

➢ Note that the structure matches the ABD Model



Session 4.1: Reliability Block Diagram

DISCUSSION 4.1.4 GENERATE RBD ANALYSIS

• RBD Analysis uses reliability information (Session 4.3) & RBD Groups (Session 4.4)

• Outputs include:

• Reliability – Calculated based on the distribution type e.g. 𝑅𝑖 = 𝑒−Σ𝜆𝑖𝑡 for Exponential

• MTTF – Calculated based on Part Failure Rate

• Inherent Availability – Based solely on reactive maintenance: 𝐴𝐼 =
𝑀𝑇𝑇𝐹

𝑀𝑇𝑇𝐹+𝑀𝑇𝑇𝑅

• Operational Availability – Based on preventative maintenance & logistic delay: 

• 𝐴𝑂 =
𝑀𝑇𝑇𝐹

𝑀𝑇𝑇𝐹+𝑀𝑇𝑇𝑅+𝐷𝑇+

𝑇𝑇
𝑀𝑇𝑇𝐹

𝑆
×𝑇𝑇

𝑘+1 !

• General Reliability & Distribution Type parameters

• Dynamically updates based on changes to the system & reliability parameters



Session 4.1: Reliability Block Diagram

DISCUSSION 4.1.4 GENERATE RBD ANALYSES



Session 4.1: Reliability Block Diagram

EXERCISE 4.1.4 GENERATE RBD ANALYSIS

To determine the reliability of the Control Unit component:

➢ From the menu bar, select Analyses→ RBD Analysis

➢ Expand the tree and select the ‘Control Unit’

➢ Verify that Control Unit reliability is 0.9998750



DISCUSSION 4.1.5 GENERATE RBD REPORT

• This Report Summarises the RBD & ABD Models, including Failure Rates, Groups, MTTR, and other 
reliability/availability information

• Report is divided into sections:

• Cover Page & Glossary

• Poor Performers

• Reliability & Availability

• Item Properties

• ABD/RBD Diagrams

Session 4.1: Reliability Block Diagram



EXERCISE 4.1.5 GENERATE RBD REPORT

To generate the RBD report: 

➢ Select Reports → Report Wizard from the main menu

➢ Select Reliability Block Diagram Report then select 

➢ Select ‘Vehicle System’ check box in the System Hierarchy 
section (or select )

➢ Select the Include screenshot of diagrams check box

➢ Select Reliability & Availability radio-button

➢ Select Poor Performers Threshold of 0.9999999

➢ Select 

Session 4.1: Reliability Block Diagram



Session 4.1: Reliability Block Diagram

EXERCISE 4.1.5 GENERATE RBD REPORT (CONTINUED) 



Session 4.1: Reliability Block Diagram

SESSION 4.1 SUMMARY

✓4.1.1: Reliability & Availability Block Diagrams

✓4.1.2: Create RBD Groups

✓4.1.3: Create ABD Groups

✓4.1.4: Generate RBD Analysis

✓4.1.5: Generate ABD/RBD Report



Session 4.2: Reliability Allocation

SESSION 4.2 OUTLINE

4.2.1: Types of Reliability Allocation in MADe

4.2.2: Create an Equal Reliability Allocation Analysis

4.2.3: Create a Weighted Reliability Allocation Analysis

4.2.4: Generate a Reliability Allocation Report



Session 4.2: Reliability Allocation

DISCUSSION 4.2.1 TYPES OF RELIABILITY ALLOCATION IN MADE

There are two approaches for Reliability Allocation in MADe:

1. Equal Target Allocation

• Based on Advisory Group on the Reliability of Electronic Equipment (AGREE) method

• Uses an evenly distributed reliability approach for all items

2. Weighted Target Allocation

• Based on four different methods of weighting:

• State of the Art

• Hardware Complexity

• Functional Complexity

• Historical Reliability Data
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EXERCISE 4.2.2 CREATE AN EQUAL RELIABILITY ALLOCATION ANALYSIS

Create a new reliability allocation analysis:

➢ From the menu bar, select from the Analyses → Reliability Allocation Editor

➢ Select      to create a new Reliability Allocation

➢ Select                to set ‘Power Generation’ as the Target Item

➢ Set the Analysis Type to: Equal

➢ Fill in the RA Analysis Name: Design Targets

➢ Fill in the RA Analysis Description: Reliability targets for

Power Generation system.

➢ Select the New group (Mission Group) from the drop down list

➢ Select                  to create the new RA analysis



Session 4.2: Reliability Allocation

EXERCISE 4.2.2 CREATE AN EQUAL RELIABILITY ALLOCATION ANALYSIS (CONTINUED)

From the Analysis Configuration page:

➢ Set the Reliability Target as 0.90

➢ Verify Target item is the ‘Power Generation’ subsystem

➢ Select                                     to calculate the reliability 

➢ Verify that the Analysis Result page will be displayed once the calculations are complete



Session 4.2: Reliability Allocation

EXERCISE 4.2.2 CREATE AN EQUAL RELIABILITY ALLOCATION ANALYSIS (CONTINUED)

Apply Reliability Allocation analysis results:

➢ Evaluate all the results shown in the analysis results table

➢ Select the to select all items in the table 

➢ Select                          to open the Confirm Allocation dialog



EXERCISE 4.2.2 CREATE AN EQUAL RELIABILITY ALLOCATION ANALYSIS (CONTINUED)

➢ Review the changes in MTTF for each item then select              to apply the new MTTF values

Session 4.2: Reliability Allocation



Session 4.2: Reliability Allocation

EXERCISE 4.2.2 CREATE AN EQUAL RELIABILITY ALLOCATION ANALYSIS (CONTINUED)

Verify Reliability Allocation analysis results:

➢ Open the ‘Diesel Engine’ System Model and select the ‘Coupling 1’ component

➢ From the Properties viewer select the Exponential tab

➢ Verify that the allocated Part Failure Rate matches up with the allocated value below



Session 4.2: Reliability Allocation

DISCUSSION 4.2.3 CREATE A WEIGHTED RELIABILITY ALLOCATION ANALYSIS

Weighted RA is based on four different methods of weighting described below:

• State of the Art

• A more highly developed item is given a higher ranking than a less developed item

• Items with higher State of the Art are assigned relatively lower reliabilities than other items on the same level of indenture

• Hardware Complexity

• A more complex item is given a higher ranking than a less complex item

• Items with higher Hardware Complexity are assigned relatively lower reliabilities on the same level of indenture 

• Functional Complexity

• A more complex item is given a higher ranking than a less complex item

• Items with higher Functional Complexity are assigned relatively lower reliabilities on the same level of indenture

• Historical Reliability Data

• Weighting is automatically calculated based on the relative current reliability values in the system model
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EXERCISE 4.2.3 CREATE A WEIGHTED RELIABILITY ALLOCATION ANALYSIS

Create a new reliability allocation analysis:

➢ From the menu bar, select Analyses→ Reliability Allocation Editor

➢ Select      to create a new Reliability Allocation

➢ Select                to select ‘Diesel Engine’ as the Target Item

➢ Set Analysis Type to Weighted

➢ Set Weighting Type to Functional Complexity

➢ Fill in the RA Analysis Details as follows: 

➢ Name: Design Target 2

➢ Description: Reliability targets for filters.

➢ Select the New group (Mission Group) from the drop down list

➢ Select                  to create the new RA analysis



Session 4.2: Reliability Allocation

EXERCISE 4.2.3 CREATE A WEIGHTED RELIABILITY ALLOCATION ANALYSIS (CONTINUED)

From the Analysis Configuration page:

➢ Set the Reliability Target to Custom and enter 0.85

➢ Select the ‘Primary Fuel Filter’ & ‘Secondary Fuel Filter’ components in the Weighted Analysis Inputs table

➢ Set Functional Complexity Item Weighting for both components to 8.0 from the slider



Session 4.2: Reliability Allocation

EXERCISE 4.2.3 CREATE A WEIGHTED RELIABILITY ALLOCATION ANALYSIS (CONTINUED)

➢ Lock the Reliability of the Air Filter component using the icon

➢ Locking the reliability of the Air Filter forces the reliability to not change when the allocation analysis is conducted. 
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EXERCISE 4.2.3 CREATE A WEIGHTED RELIABILITY ALLOCATION ANALYSIS (CONTINUED)

➢ Run the analysis by selecting

➢ Verify that the Analysis Result page will be displayed once the calculations are complete
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EXERCISE 4.2.3 CREATE A WEIGHTED RELIABILITY ALLOCATION ANALYSIS (CONTINUED)

Apply Reliability Allocation analysis results:

➢ Evaluate all the results shown in the analysis results table

➢ Select the ‘Primary Fuel Filter’ & ‘Secondary Fuel Filter’ check boxes in the table

➢ Select                          to open the Confirm Allocation dialog



Session 4.2: Reliability Allocation

EXERCISE 4.2.3 CREATE A WEIGHTED RELIABILITY ALLOCATION ANALYSIS (CONTINUED)

➢Review the changes in MTTF for each item then select to apply the new MTTF values



Session 4.2: Reliability Allocation

EXERCISE 4.2.3 CREATE A WEIGHTED RELIABILITY ALLOCATION ANALYSIS (CONTINUED)

Verify Reliability Allocation analysis results:

➢ Open the ‘Diesel Engine’ System Model and select the ‘Primary Fuel Filter’

➢ From the Properties viewer select the Exponential tab

➢ Verify that the allocated Part Failure Rate matches up with the allocated value



Session 4.2: Reliability Allocation

DISCUSSION 4.2.4 GENERATE A RELIABILITY ALLOCATION REPORT

• This report summarises each RA analysis

• The RA Report is divided into 3 sections:

• Cover Page

• Glossary of Terms

• Reliability Allocation Analysis – includes Duration of Operation, Item Reliability, Failure Rate, MTTF, Weighting, 



Session 4.2: Reliability Allocation

EXERCISE 4.2.4 GENERATE A RELIABILITY ALLOCATION REPORT

To generate a Reliability Allocation report: 

➢ Select Reports → Report Wizard from the main menu

➢ Select Reliability Allocation Report then select 

➢ Select the Design Targets analysis

➢ Select



Session 4.2: Reliability Allocation

EXERCISE 4.2.4 GENERATE A RELIABILITY ALLOCATION REPORT



Session 4.2: Reliability Allocation

SESSION 4.2 SUMMARY

✓4.2.1: Types of Reliability Allocation in MADe

✓4.2.2: Create an Equal Reliability Allocation

✓4.2.3: Create a Weighted Reliability Allocation

✓4.2.4: Generate Reliability Allocation Report



Session 4.3: Reliability Editing

SESSION 4.3 OUTLINE

4.3.1: Introduction to Item Reliability

4.3.2: Access Reliability Editor

4.3.3: Edit Item Reliability – Exponential Distribution

4.3.4: Edit Item Reliability – Weibull Distribution

4.3.5: Edit Failure Mode Ratios



DISCUSSION 4.3.1 INTRODUCTION TO ITEM RELIABILITY

• Entering Reliability Data into components & parts determines their Probability of Failure, P(f)

• Item reliability is taken into account in the RBD model to calculate subsystem & system reliability

• Aggregation of P(f) determines Reliability of RBD Groups

Session 4.3: Reliability Editing



Session 4.3: Reliability Editing

EXERCISE 4.3.2 ACCESSING RELIABILITY EDITOR

To access the Reliability Editor:

➢ Select Analyses→ Criticality & Reliability Editor from the main menu

➢ In the Item/Failure Selection section select Reliability from the drop down menu and select the ‘Control Unit’
component from the tree



Session 4.3: Reliability Editing

DISCUSSION 4.3.3 EDIT ITEM RELIABILITY – EXPONENTIAL DISTRIBUTION

General Reliability section contains reliability fields used to capture:

• Duration of Operation

• Mean Time to Repair (MTTR)

• Failure Distribution Type: Exponential or Weibull

• Delay Time

• Turn Around Time

• Spares on Hand



Session 4.3: Reliability Editing

EXERCISE 4.3.3 EDIT ITEM RELIABILITY – EXPONENTIAL DISTRIBUTION

To edit reliability values from the Reliability editor: 

➢ Select the ‘Control Unit’ component from the Item/Failure Selection tree

➢ For the General Reliability section, edit/confirm the following reliability information:

➢ Duration of Operation: ~71.58 Hours (from Mission Group)

➢ Mean Time To Repair: 3 Hours

➢ Failure Distribution Type: Exponential

➢ Delay Time: 3 Hours

➢ Turnaround Time: 5 Hours

➢ Spares on Hand: 2



Session 4.3: Reliability Editing

EXERCISE 4.3.3 EDIT ITEM RELIABILITY – EXPONENTIAL DISTRIBUTION (CONTINUED)

➢ For the Exponential Section enter or verify the following reliability information:

➢ Mean Time To Failure: 8,000 Hours

➢ Part Failure Rate: 125.00 (1.25E+02)



Session 4.3: Reliability Editing

EXERCISE 4.3.3 EDIT ITEM RELIABILITY – EXPONENTIAL DISTRIBUTION (CONTINUED)

➢ Expand the ‘Control Unit’ component & Failure Diagram in the Item/Failure Selection Tree

➢ Select the Faults below to set their individual Failure Mode Ratio (FMR):

➢ Dielectric strength decreased: 0.60

➢ Electrical potential decreased: 0.10

➢ Open circuit: 0.15

➢ Property mismatch: 0.15



Session 4.3: Reliability Editing

EXERCISE 4.3.4 EDIT ITEM RELIABILITY – WEIBULL DISTRIBUTION

➢ Select the ‘Air Filter’ component from the Item / Failure Selection Tree

➢ For the General Reliability section, edit/confirm the following reliability information:

➢ Duration of Operation: ~71.58 Hours (taken from Mission Profile)

➢Mean Time To Repair: 5 Hours

➢ Failure Distribution Type: Weibull

➢ Delay Time: 5 hours

➢ Turn Around Time: 12 Hours

➢ Spares on Hand: 0



Session 4.3: Reliability Editing

EXERCISE 4.3.4 EDIT ITEM RELIABILITY – WEIBULL DISTRIBUTION (CONTINUED)

➢ For the Weibull section, enter or verify the following reliability information:

➢ Slope: 3

➢ Characteristic Life: 10000 Hours



Session 4.3: Reliability Editing

DISCUSSION 4.3.5 EDIT FAILURE MODE RATIOS

• MIL-STD-1629A: Failure Mode Ratios represent probabilities that an item will fail in the identified failure 
mode with respect to other failures.

• Failure Mode Ratio is applied in MADe in two areas:

• Failure Mode Responses (e.g. High/Low)

• Faults



Session 4.3: Reliability Editing

DISCUSSION 4.3.5 EDIT FAILURE MODE RATIOS

Which Failure Mode Ratios should be used?

• Use Failure Mode Response FMR when:

• Physics of Failure is not known

• There are no failure concepts in the Failure Diagram (except for Failure Mode)

• Failure Diagram Override is applied

• Use Fault FMR when:

• Physics of Failure is understood (i.e. Fault-level information)

• Failure Trees are present: Cause →Mechanism → Fault → Failure Mode

• FMR is used in the following analysis outputs:

• Criticality Analysis FMECA

• Relative Probability of Failure Causes (Classic RCM)
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EXERCISE 4.3.5 EDIT FAILURE MODE RATIOS

➢ Expand the ‘Air Filter’ component & Failure Diagram in the Item/Failure Selection tree

➢ Select the Faults below to set their individual Failure Mode Ratio (FMR):

➢ Blocked: 0.50

➢ Contaminated: 0.2 (FMR)

➢ Outgrowths: 0.1 (FMR)

➢ Perforated: 0.2 (FMR)



Session 4.3: Reliability Editing

SESSION 4.3 SUMMARY

✓4.3.1: Introduction to Item Reliability

✓4.3.2: Access Reliability Editor

✓4.3.3: Edit Item Reliability – Exponential Distribution

✓4.3.4: Edit Item Reliability – Weibull Distribution

✓4.3.5: Edit Failure Mode Ratios



Session 4.4: Failure Rate Prediction

SESSION 4.4 OUTLINE

4.4.1: Failure Rate Prediction in Standards Context

4.4.2: Create a Failure Rate Prediction Analysis

4.4.3: Enter Part Detail Parameters

4.4.4: Apply Predicted MTTF to Item(s)



Session 4.4: Failure Rate Prediction

DISCUSSION 4.4.1 FAILURE RATE PREDICTION IN STANDARDS CONTEXT

• MIL-STD-217F: Handbook for calculating reliability predictions using ‘Part Stress Analysis’ method

• Failure Rate Prediction purpose:

• Establish & maintain consistent and uniform methods for estimating inherent reliability

• Provide common basis of reliability prediction during acquisition stage

• Standard applies to electronic equipment & systems

• Performed during Detailed Design Stages

• Applied to Component & Part-level Items



Session 4.4: Failure Rate Prediction

EXERCISE 4.4.2 CREATE A FAILURE RATE PREDICTION ANALYSIS

To create a Failure Rate Prediction analysis: 

➢ Select Analyses → Failure Rate Prediction from the menu bar



Session 4.4: Failure Rate Prediction

EXERCISE 4.4.2 CREATE A FAILURE RATE PREDICTION ANALYSIS (CONTINUED)

➢ Select       to create a new Failure Rate Analysis

➢ Enter the following details: 

➢ Name: Training Analysis

➢ Description: Example Failure Rate Prediction analysis for Control Unit.

➢ Verify Failure Rate Standard type is ‘217F Notice 2…’

➢ Select 



Session 4.2: Failure Rate Prediction

EXERCISE 4.4.2 CREATE A FAILURE RATE PREDICTION ANALYSIS (CONTINUED)

➢ In the Predicted Failure Rate section, select                        to choose a model item

➢ Select ‘Control Unit’ as the item for analysis

➢ Select 



Session 4.4: Failure Rate Prediction

EXERCISE 4.4.2 CREATE A FAILURE RATE PREDICTION ANALYSIS (CONTINUED)

➢ Select      to add New Parts to the analysis

➢ In the New Part dialog, search for PCB

➢ Select Connectors, Card Edge, Printed Circuit Board (PCB) from the list

➢ Select 



Session 4.4: Failure Rate Prediction

EXERCISE 4.4.3 ENTER PART DETAIL PARAMETERS

➢Verify the following parameters:

➢ Part Quantity is 1

➢ Base Failure Rate: Card Edge, Printed Circuit Board (PCB)

➢ Environment Factor: GB – Ground, Benign

➢ Quality Factor: LOWER

➢ Change the following parameters:

➢ Mating/Unmating Factor: > 50 Cycles/103 Hours

➢ Connected Ambient Temperature: 40

➢ Amperes per Contact: 100, 32 Gauge



Session 4.4: Failure Rate Prediction

EXERCISE 4.4.4 APPLY PREDICTED TO ITEMS

➢ Verify Predicted Failure Rate: 67.6858

➢ Select 

➢ Verify updated MTTF for ‘Control Unit’ from the Properties viewer



Session 4.4: Failure Rate Prediction

SESSION 4.4 SUMMARY

✓4.4.1: Failure Rate Prediction in Standards Context

✓4.4.2: Create a Failure Rate Prediction Analysis

✓4.4.3: Enter Part Detail Parameters

✓4.4.4: Apply Predicted MTTF to Item(s)



Session 4.5: Markov Analysis

SESSION 4.5 OUTLINE

4.5.1: Markov Analysis in ARP4761 Context

4.5.2: Accessing Markov Analysis Editor

4.5.3: Markov Analysis Canvas Overview

4.5.4: Markov Analysis States

4.5.5: Markov Analysis Transitions

4.5.6: Markov Analysis Results



Session 4.5: Markov Analysis

DISCUSSION 4.5.1 MARKOV ANALYSIS IN ARP4761 CONTEXT

• ARP4761 Standard: Guidelines & methods of performing safety assessment for certification of civilian 
aircraft

• Markov Analysis (MA) Definition: A Markov Model (chain) represents various system states & the 
relationships among them.

• States: Operational, Degraded, Non-Operational (Failed)

• Transition rate between states is a function of failure/repair rate

• State probabilities derived from differential equations derived from Markov chain



Session 4.5: Markov Analysis

DISCUSSION 4.5.1 MARKOV ANALYSIS IN ARP4761 CONTEXT (CONTINUED)

• Used to model complex, fault-tolerant systems with condition monitoring & reconfiguration

• Performed during Concept and Preliminary Design Stages

• Unlike Fault Trees, MA cover complex system behaviours of repairable systems or systems where 
failure/repair rate are state dependent

• Disadvantage: Markov model size grows exponentially with number of components

• In MADe, MA is conducted on each individual item for simplicity



Session 4.5: Markov Analysis

EXERCISE 4.5.2 ACCESSING MARKOV ANALYSIS MODEL EDITOR

To create a Markov Analysis: 

➢ Select Analyses→Markov Analysis from the main menu

➢ Alternatively, right-click an item in the Project Explorer/System Model then select Markov Analysis



Session 4.5: Markov Analysis

EXERCISE 4.5.2 ACCESSING MARKOV ANALYSIS MODEL EDITOR (CONTINUED)



Session 4.5: Markov Analysis

EXERCISE 4.5.2 ACCESSING MARKOV ANALYSIS MODEL EDITOR (CONTINUED)

➢ Select the new Markov Analysis icon 

➢ From the dialog, select ‘Primary Fuel Filter’ 

➢ Select



Session 4.5: Markov Analysis

DISCUSSION 4.5.3 MARKOV ANALYSIS CANVAS OVERVIEW

• Canvas: Displays states, transitions and transition durations in hours

• Palette: Contains a selection tool, list of state categories and transition connection

• Markov Analysis Results: Shows states & corresponding availability, reliability & duration of operation

❖Note: Properties Viewer edits canvas details: transitions, durations, state details.



Session 4.5: Markov Analysis

DISCUSSION 4.5.4 MARKOV ANALYSIS STATES

There are 4 types of states use in the Markov Analysis:

1. Initial State: Item state at time 𝑡 = 0

• Indicated by a blue circle 

• Default numerical label (indicating state) is ‘0’ but can be a larger value

2. Operational State: Item state in which the item is capable of performing the required function

• Indicated by a green circle

• Default numerical label is 𝑛 ≥ 0

3. Degraded State: Item state in which the item is capable of partially performing the required function

• Indicated by a yellow circle 

• Default numerical label is 𝑛 ≥ 0

4. Failure State: Item state in which the item is not capable of performing the required function

• Indicated by a red circle

• Default numerical label is 𝑛 ≥ 0



Session 4.5: Markov Analysis

DISCUSSION 4.5.4 MARKOV ANALYSIS STATES

The user can modify Markov states from the Properties viewer:

• State Name: Updates individual state names in the canvas

• Initial State (check box)

• (State) Type:

• Normal Operation

• Degraded Operation

• Total System/Component Failure

• Dangerous Failure: Failure which has the potential to put the safety related system into a hazardous state or fail-to-function state

• Safe Failure: Failure that does not have the potential to put the system into a hazardous state or fail-to-function state

• Description Field: Used to describe the condition of the item during a specific Markov state



Session 4.5: Markov Analysis

EXERCISE 4.5.4 MARKOV ANALYSIS STATES

➢ Create the following states: Operational State, Degraded State

➢ Step 1: Select states in Markov Analysis palette

➢ Step 2: Select canvas to create state

➢ Change Total System/Component failure type to ‘Dangerous Failure’

➢ Delete the existing connection between Normal Operation and Dangerous Failure



Session 4.5: Markov Analysis

DISCUSSION 4.5.5 MARKOV ANALYSIS TRANSITIONS

• Markov Analysis Transitions represent the change from one state to another

• Indicated by a single or double-sided arrow connected two states in the canvas

• Single arrow indicates transition in only one direction/only one state

• Double-headed arrow indicates transition is possible between both states

• Transition connection displays time in hours to transition between states

• Double-headed arrows show 2 transition times

• Set from the Properties viewer

• Transition placement is manipulated by selecting the square on the line



Session 4.5: Markov Analysis

EXERCISE 4.5.5 MARKOV ANALYSIS STATES

➢ Create the following transitions:

➢ State 0 to 2: Initial State to Operational State

➢ Set transition hours (0→1) to 0.01

➢ State 2 to 3: Operational State to Degraded State

➢ Set transition hours (2→3) to 56.53

➢ Set transition hours (3→2) to 22

➢ State 3 to 1: Degraded State to Failure State

➢ Deselect check box: Allow transition from state 1 to state 3

➢ Set transition hours (3→1) to 10.6

➢ State 1 to 2: Failure State to Normal Operation State

➢ Deselect check box: Allow transition from state 1 to state 3

➢ Set transition hours (3→1) to 3.53

❖Note: the numbering may be different due to the order each state was created. 



Session 4.5: Markov Analysis

DISCUSSION 4.5.6 MARKOV ANALYSIS RESULTS

• Markov Analysis – Results collapsible canvas is refreshed to generate updated results

• Results are displayed in table or line chart format

• Export of table in .csv format available



Session 4.5: Markov Analysis

EXERCISE 4.5.6 MARKOV ANALYSIS RESULTS

To generate results for all Markov states:

➢ Select      to recalculate the Markov Reliability graph

➢ Select                  to confirm duration of operation of 71.58

➢ Toggle Analysis Data/Line Charts icons to view results



Session 4.5: Markov Analysis

EXERCISE 4.5.6 MARKOV ANALYSIS RESULTS (CONTINUED)

To apply the current Markov Analysis to multiple items in the system:

➢ Navigate to Overview/Management page

➢ Select the Markov Analysis

➢ Select      to open the Target Items dialog

➢ From the target item dialog select item check boxes that apply

➢ Apply to ‘Primary Fuel Filter’ (default), ‘Secondary Fuel Filter’ & ‘Air Filter’

➢ Select 

➢ Verify Markov Analysis application in table 



Session 4.5: Markov Analysis

SESSION 4.5 OUTLINE

✓4.5.1: Markov Analysis in ARP4761 Context

✓4.5.2: Accessing Markov Analysis Editor

✓4.5.3: Markov Analysis Canvas Overview

✓4.5.4: Markov Analysis States

✓4.5.5: Markov Analysis Transitions

✓4.5.6: Markov Analysis Results



Session 4.6: Hardware Fault Tree Analysis (HFTA)

SESSION 4.6 OUTLINE

4.6.1: Generate a Hardware Fault Tree Analysis (HFTA)

4.6.2: Export Hardware FTA Results



Session 4.6: Hardware Fault Tree Analysis (HFTA)

DISCUSSION 4.6.1 HARDWARE FAULT TREE ANALYSIS

• The hardware fault tree traces progression of failures based on the System RBD structure 

• Instead of functional failure modes it displays parts, components and systems

• For this session, we will need to be in the SRA Module



Session 4.6: Hardware Fault Tree Analysis (HFTA)

EXERCISE 4.6.1 HARDWARE FAULT TREE ANALYSIS

To generate a hardware fault tree analysis:

➢Access the Fault Tree Builder and select

➢Enter the following details: 

➢Name: Hardware Fault Tree

➢Description: Hardware Fault Tree for Vehicle System

➢Fault Tree Type: Hardware Fault Tree

➢Set ‘Vehicle System’ as the Top Event



Session 4.6: Hardware Fault Tree Analysis (FTA)

EXERCISE 4.6.1 HARDWARE FAULT TREE ANALYSIS



Session 4.6: Hardware Fault Tree Analysis (HFTA)

EXERCISE 4.6.2 EXPORTING HARDWARE FAULT TREE RESULTS

To export the Hardware Fault Tree as an image:

➢ Select      to capture the entire Hardware Fault Tree

➢ Select a directory and enter a file name for the PNG image

➢ Select                  ’ to save the image of the current Fault Tree

To export the Hardware Fault Tree analysis results:

➢ Select        in the Hardware Fault Tree tab

➢ Select a directory and enter a file name for the .csv export

➢ Select                    to save the analysis results of the Hardware Fault Tree



Session 4.6: Hardware Fault Tree Analysis (HFTA)

SESSION 4.6 SUMMARY

✓4.6.1: Generate a Hardware Fault Tree Analysis (FTA)

✓4.6.2: Export Hardware FTA Results



Session 4: Reliability Analyses Summary

SESSION 4 SUMMARY

✓4.1: Reliability Block Diagram

✓4.2: Reliability Allocation

✓4.3: Reliability Editing

✓4.4: Failure Rate Prediction

✓4.5: Markov Analysis

✓4.6: Hardware Fault Tree Analysis (HFTA)



Session 5: 
Maintainability Analyses

Using the MADe Model to 

generate key analyses from

Maintenance and ILS domains



Session 5: Maintainability Analyses

SESSION 5 OUTLINE

5.1: Maintenance Cost Estimates 

5.2: Maintenance Actions

5.3: Reliability Centered Maintenance (Classic)

5.4: Reliability Centered Maintenance (Back-Fit RCM)



Session 5: Maintainability Analysis

SESSION 5 DISCUSSION

• Session 5 will take place in the RAM module.

• This session will focus on Maintenance. This includes: 

• Maintenance Cost Estimate

• Maintenance Actions

• Reliability Centred Maintenance (Classic) 

• Reliability Centred Maintenance (Back-Fit)



Session 5.1: Maintenance Cost Estimates

SESSION 5.1 OUTLINE

5.1.1: MCE Management

5.1.2: MCE Summary & Details

5.1.3: Charting & MCE Report



Session 5.1: Maintenance Cost Estimates

DISCUSSION 5.1 MAINTENANCE COST ESTIMATES

• MCE generates and compares costs of maintenance procedures over the operational timespan of an item

• Typically used in early stages of the design lifecycle to estimate and predict the total maintenance costs

• Can be used to detail the maintenance and support aspect of lifecycle costs



Session 5.1: Maintenance Cost Estimates

DISCUSSION 5.1.1 MCE MANAGEMENT

• This page is used to create, store and edit MCE analyses

• The page also provides an overview for a specific analysis



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.1 CREATE A NEW MCE ANALYSIS

To create a MCE analysis: 

➢ Select to create a new MCE analysis

➢ Enter the MCE Name: Training MCE

➢ Enter the MCE Description: Maintenance Cost estimation for the Power Generation system.



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.1 EDIT APPLIED ENVIRONMENT

➢ Select       to choose an applied environment

➢ Under User Library select Benign Environment 

➢ Select                  to close dialog and select applied environment

➢ Verify that Environmental Loading Factor (ELF) is: 0.59

❖Note: The ELF is calculated based on the selected environment



Session 5.1: Maintenance Cost Estimates

DISCUSSION 5.1.2 MCE PAGE

• After a new MCE analysis has been created, maintenance 
and item costs must be estimated

• MCE is a bottom-up approach

• This is accessed by selecting the new analysis and 
clicking      to open the analysis 

• This page defines the estimated cost of sustainment for the 
system based on the component maintenance actions

• If item maintenance estimates are unknown, costs can be 
estimated at the subsystem level

• Less detailed (estimates are more rough)

• Lower-level component estimates can be updated later



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.2 ADD BREAKDOWN REPAIR FOR FUEL TANK COMPONENT

To edit details for the MCE: 

➢ Select Training MCE then select

➢ Expand the system tree and select Fuel Tank

➢ Under Proposed Maintenance Approach section:

➢ Select Maintenance Category: Breakdown Maintenance

➢ Select Maintenance Type: Breakdown Repair



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.2 ADD BREAKDOWN REPAIR FOR FUEL TANK COMPONENT (CONTINUED)

➢ Select the Cost tab and enter:

➢ Acquisition cost: $500

➢ Cost of Failure: $10,000

➢ Downtime cost: $1,000

➢ Personnel cost: $100 (per person per hour)

➢ Equipment Renewal Factor: 2.00

➢ Tools & Equipment Cost: $500

➢ Consumables Cost: $100



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.2 ADD BREAKDOWN REPAIR FOR FUEL TANK COMPONENT (CONTINUED)

➢ Select the Maintenance tab and enter:

➢ Maintenance Supplier: ACME Inc.

➢ Maintenance Country: Australia

➢ Estimated MTTF: 10,000 Hours

➢ Maintenance Time: 1 Hour

➢ No. of Personnel: 1

➢ Verify Total Cost: $1635.23

➢ Verify Cost per Hour: $22.85



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.2 ADD BREAKDOWN REPAIR FOR FUEL TANK COMPONENT (CONTINUED)

➢ Breakdown of Total Cost: $1635.23

1. MTBM = (MTTF × ELF) + MTTR = (10,000 × 0.5927273) + 1 = 5928.273 hours

2. Maintenance Frequency = Duration of Operation / MTBM = 71.576 / 5928.273 = 0.012074

3. Total Cost = Maintenance Frequency × Action Costs = 

(MF × CostFailure) + (MF × CostDowntime) + (MF × CostPersonnel) + (MF × CostConsumables) + 

( [Equipment Renewal Factor × CostTools/Equipment ]+ CostTools/Equipment ) = 

(0.012074 × 10,000) + (0. 012074 × 1,000) + (0. 012074 × 100) + (0.012074 × 100) + (2 x 500 + 500) = 

120.74 + 12.074 + 1.2074 + 1.2074 + 1500 = $1635.23



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.3 ADD SCHEDULED SERVICE FOR CONTROL UNIT COMPONENT

To add expected maintenance for an item: 

➢ Select ‘Control Unit’ from the System Breakdown tree

➢ Under Proposed Maintenance Approach section:

➢ Set Maintenance Category to Scheduled Maintenance

➢ Set Maintenance Type to Scheduled Service



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.3 ADD SCHEDULED SERVICE FOR CONTROL UNIT COMPONENT (CONTINUED)

➢ Select the Cost tab and enter:

➢ Acquisition cost: $2000

➢ Downtime cost: $1,000

➢ Personnel cost: $100 (person per hour)

➢ Equipment Renewal Factor: 1.00

➢ Tools & Equipment Cost: $100

➢ Consumables Cost: $100

➢ Spares Cost Factor: 1



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.3 ADD SCHEDULED SERVICE FOR CONTROL UNIT COMPONENT (CONTINUED) 

➢ Select the Maintenance tab and enter:

➢ Maintenance Supplier: ACME Inc.

➢ Maintenance Country: Australia

➢ Estimated MTTF: 10,000 Hours

➢ Maintenance Interval: 800 Hours

➢ MTTR: 2 Hours

➢ No. of Personnel: 1

➢ Verify Total Cost: $846.35

➢ Verify Cost per Hour: $11.82



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.4 ADD CONDITION BASED REPLACE FOR COUPLING COMPONENT

➢ Select the Coupling 1 from the system tree

➢ Under Proposed Maintenance Approach section:

➢ Select Maintenance Category: Condition Based Maintenance

➢ Select Maintenance Type: Condition Based Replace – Continuous Monitoring



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.4 ADD CONDITION BASED REPLACE FOR COUPLING COMPONENT (CONTINUED)

➢ Select the Cost tab and enter:

➢ Acquisition cost: $250

➢ Downtime cost: $10,000

➢ Personnel cost: $100 (person per hour)

➢ Equipment Renewal Factor: 1.00

➢ Maintenance Tools & Equipment Cost: $100

➢ Maintenance Consumables Cost: $100

➢ Maintenance Spares cost factor: 0

➢ Detection Tools & Equipment Cost: $50

➢ Detection Consumables Cost: $0



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.4 ADD CONDITION BASED REPLACE FOR COUPLING COMPONENT (CONTINUED)

➢ Select the Maintenance tab and enter:

➢ Maintenance Supplier: ACME Inc.

➢ Maintenance Country: Australia

➢ Estimated MTTF: 1,000 Hours

➢ Requires shutdown (Maintenance): Yes

➢ Maintenance Interval: 750 Hours

➢ MTTR: 0.5 Hours

➢ No. of Personnel: 2

➢ Requires shutdown (Maintenance): No

➢ Detection Interval: 250 hours

➢ Detection Time: 5 minutes

➢ No. of Personnel: 1

➢Verify Total Cost: $1,138.70
➢Verify Cost per Hour: $15.91



Session 5.1: Maintenance Cost Estimates

DISCUSSION 5.1.5 CHARTING & MCE REPORT

• Once all relevant analysis information has been provided, the user can view the breakdown of the MCE 
analysis in the Overview/Management page.



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.5 GENERATE A MCE REPORT

To generate a MCE report:

➢ Select Reports → Report Wizard 

➢ Select Maintenance Cost Estimates Report

➢ Select 

➢ Select Training MCE and select 

➢ Set formatting or select  to generate the report



Session 5.1: Maintenance Cost Estimates

EXERCISE 5.1.5 GENERATE A MCE REPORT



Session 5.1: Maintenance Cost Estimates

SESSION 5.1 SUMMARY

✓5.1: MCE Analysis for Fuel Tank, Control Unit & Coupling components

✓ Determine Total MCE per item/cost per operating hour

✓ Generate MCE Report



Session 5.2: Maintenance Actions

SESSION 5.2 OUTLINE

5.2.1: Maintenance Actions Page

5.2.2: Enter Maintenance Actions

5.2.3: Import Maintenance Actions

5.2.4: Generate a Maintenance Actions Report



Session 5.2: Maintenance Actions

DISCUSSION 5.2.1 MAINTENANCE PROPERTIES

• MADe captures the maintenance actions of the system and model elements (subsystems, components or 
parts) in the Maintenance Actions page under advanced properties



Session 5.2: Maintenance Actions

EXERCISE 5.2.2 CREATE A MAINTENANCE ACTION FOR THE FUEL TANK

To create a Maintenance Action: 

➢ Select the ‘Fuel Tank’ component in the Project Explorer

➢ From the drop down menu, select the Maintenance Actions option



Session 5.2: Maintenance Actions

EXERCISE 5.2.2 CREATE A MAINTENANCE ACTION FOR THE FUEL TANK (CONTINUED)

To create a maintenance actions:

➢ Select      to add a new maintenance action

➢ Select the check box to set the new Maintenance Action as default

➢ In the Maintenance Action Details section, populate the following information:

➢ Action ID: 001

➢ Action Name: Breakdown Maintenance

➢ Description: Breakdown Repair based on MCE Analysis 1.

➢ Location of Maintenance: Field

➢Maintenance Type: Breakdown

➢Maintenance Sub-Type: Repair



Session 5.2: Maintenance Actions

EXERCISE 5.2.2 CREATE A MAINTENANCE ACTION FOR THE FUEL TANK (CONTINUED)

➢ Select       to create a New Maintenance Task

➢ Select       to create a New Personnel Record – this assign a new personnel to a task

➢ Select             to rearrange tasks/personnel/items

➢ Select to create New Maintenance Items

➢ Select       to delete selected tasks/personnel/items



Session 5.2: Maintenance Actions

EXERCISE 5.2.2 CREATE A MAINTENANCE ACTION FOR THE FUEL TANK (CONTINUED)

➢ Enter the following tasks (ID/Description), personnel (ID/Description/#), Rates & Equipment ($, QTY):



Session 5.2: Maintenance Properties

EXERCISE 5.2.3 IMPORT A MAINTENANCE ACTION FOR THE CONTROL UNIT

➢ Select the ‘Control Unit’ component in the system model

➢ Select Maintenance Actions

➢ Select       to import

➢ Select 001 – Breakdown Maintenance from 
‘Fuel Tank’ then select 

➢ Change the imported maintenance action Name and Type to 
Scheduled Repair

➢Maintenance Interval: 800 hour interval

➢ Action Name: Scheduled Repair

➢ Description: Scheduled Repair based on MCE Analysis 1.



Session 5.2: Maintenance Actions

EXERCISE 5.2.3 IMPORT A MAINTENANCE ACTION FOR THE CONTROL UNIT (CONTINUED)



Session 5.2: Maintenance Actions

EXERCISE 5.2.4 CREATE A MAINTENANCE ACTION REPORT

To generate a Maintenance Actions Report:

➢ Select Reports → Report Wizard from the main menu

➢ Select Maintenance Actions Report

➢ Select 

➢ Select Breakdown Maintenance for the ‘Fuel Tank’ component
Confirm the Time Span is the current mission profile: New Group

➢ Set formatting or select to generate the report



Session 5.2: Maintenance Actions

EXERCISE 5.2.4 CREATE A MAINTENANCE ACTION REPORT

The report consists of several sections:

• Maintenance Actions Summary – Aggregates costs & time spans across all items

• Maintenance Actions Dashboard – Pie charts visualise maintenance breakdown

• Maintenance Actions Summary – Aggregates costs & time spans across all item MAs

• Maintenance Actions Breakdown – Records all fields from Maintenance Actions page per item 



Session 5.2: Maintenance Actions

SESSION 5.2 SUMMARY

✓ 5.2.1: Access the Maintenance Actions editor

✓ 5.2.2: Generate a Maintenance Action

✓ 5.2.3: Import Maintenance Actions

✓ 5.2.4: Generate a Maintenance Action Report



Session 5.3: Reliability Centered Maintenance (Classic)

SESSION 5.3 OUTLINE

5.3.1: Background to RCM

5.3.2: RCM Overview and Management (STEP 0)

5.3.3: Functions & Functional failures (STEP 1 & 2)

5.3.4: Failure Causes (STEP 3)

5.3.5: Failure Effects (STEP 4)

5.3.6: Failure Criticality (STEP 5A/5B/5C; REPAIR & REPLACE WORKSHEETS)

5.3.7: Failure Classification 

5.3.8: Item Maintenance Overview (STEP 7)

5.3.9: Classic RCM Report

(STEP 6H/6S/6O/6N; FAILURE FINDING, REDESIGN, SCHEDULED

REPAIR, SCHEDULED REPLACE & ON CONDITION WORKSHEETS)



Session 5.3: Reliability Centered Maintenance

DISCUSSION 5.3 BACKGROUND TO RCM

What is the difference between Back-Fit & Classic RCM? When are they used?

Classic RCM: A process that develops, analyses and documents requirements to develop a maintenance program

➢ Environment of uncertainty

➢ Limited operating data

Back-Fit RCM: A process that confirms assumptions when the original maintenance program was developed 
once sufficient operating data exists 

➢ Validates existing maintenance requirements

➢ Recommends changes where appropriate



Session 5.3: Reliability Centered Maintenance

DISCUSSION 5.3 BACKGROUND TO RCM (CONTINUED)



Session 5.3: Classic RCM

DISCUSSION 5.3 CLASSIC RCM

The MADe Classic Reliability Centered Maintenance (RCM) analysis is based on a process referenced from 
J. Moubray1 and USN SSC Handbook S9081-AB-GIB-010. 

Two types of RCM in MADe: Classic RCM & Back-Fit RCM

RCM retrieves reliability and maintenance information in the system model:

• Overview/Item Selection

• Functions & Functional Failures

• Failure Causes

• Failure Effects

• Failure Criticality

• Failure Classification

• Item Maintenance Overview

• Reporting Outputs

1Moubray, John, Reliability Centered Maintenance; RCM II; Second Edition, Industrial Press, 1997, ISBN 0-8311-3078-4

RCM Logic Tree (Source: MIL-STD-3034)



Session 5.3: Classic RCM

EXERCISE 5.3.1 OPEN CLASSIC RCM EDITOR

To access the Classic RCM editor: 

➢ Select Analyses → Classic RCM from the main menu



Session 5.3: Classic RCM

DISCUSSION 5.3.1 RCM MANAGEMENT

• Lists all RCM Analyses conducted on the modelled system

• Define or allocate the Maintainable Items for the RCM analysis

• Provides System Reliability & System Functions information



Session 5.3: Classic RCM

EXERCISE 5.3.1 RCM MANAGEMENT

To create a RCM Analysis, in the RCM Management page:

➢ Select                    to open the New RCM Analysis dialog

➢ Enter the analysis name: Analysis 1

➢ Enter the time span: 1.00 years

➢ Enter the following comment: The following analysis is based on the New 
Group mission projected to a year timespan for 
maintenance costs. The main candidate is the 
Fuel Tank as this model is for training purposes.

➢ Select ‘Vehicle System’ as the End Effect

➢ Select                  to create RCM analysis



Session 5.3: Classic RCM

EXERCISE 5.3.1 RCM MANAGEMENT (CONTINUED)

➢ Select Analysis 1 in the table

➢ Select  to open the RCM analysis

➢ The RCM analysis will automatically redirect to the Overview/Item Selection page



Session 5.3: Classic RCM

DISCUSSION 5.3.2 OVERVIEW/ITEM SELECTION

• Provides System Reliability & System Functions information

• User can define or allocate the Maintainable Items for the RCM analysis
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EXERCISE 5.3.2 OVERVIEW/ITEM SELECTION

Edit the following information in the Overview/Item Selection page:

➢ For System Functions, enter the following Acceptable Limits: 5.0 – 10.0 rad/s

To fill in the Maintainable Item List section: 

➢ Select the ‘Fuel Tank’ component

➢ Select                   to add ‘Fuel tank’ to the Maintainable Item table
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DISCUSSION 5.3.3 FUNCTIONS & FUNCTIONAL FAILURES

• The Functions and Functional Failures are displayed for the selected Maintainable Item

• This page allow the user to verify and confirm the functions of the component and to add descriptions

• Sections include:

• Item Functions

• Function Details

• Functional Failure Details
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EXERCISE 5.3.3 FUNCTIONS & FUNCTIONAL FAILURES

To add Function details in the Function & Functional Failures page:

➢ Select the Maintainable Item by selecting the Maintainable Item Field

➢ From the Maintainable Item dialog table select: ‘Fuel Tank’

➢ Select 
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EXERCISE 5.3.3 FUNCTIONS & FUNCTIONAL FAILURES (CONTINUED)

➢ Under the Item Functions section select: To Provide Liquid – Static Pressure

➢ Under Functional Narrative enter: The function of the fuel tank is to collect a flow rate of fuel and provide a static 
pressure of the fuel for the diesel engine. 

➢ Under Acceptable Limits enter: Fuel pressure between 35 kPa and 310 kPa.
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EXERCISE 5.3.3 FUNCTIONS & FUNCTIONAL FAILURES (CONTINUED)

➢ Select the Functional Failure: Fuel Tank Liquid Static pressure fails Low

➢ Under Functional Failure Details, Failure Narrative enter the following: A low fuel static pressure can result from a loss 
of fuel from the tank, from leaks etc.
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DISCUSSION 5.3.4 FAILURE CAUSES

• User identifying and assessing the causes of the failures of the Maintainable Item

• This section provides additional information e.g. relative importance, Mode / Cause of each path that leads 
to the failure

• Table columns include:

• Mode / Cause

• Detection Narrative

• Progression to Failure

• Relative Probability

• Comment

• Decision

• Analysis Status
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EXERCISE 5.3.4 FAILURE CAUSES

Enter the following information for the Failure Causes page:

➢ Enter/Verify detection Narrative for Perforated due to corrosive attack: Inspection

➢ Comment: Failure progression due to corrosive attack

➢ Decision: Analyse

➢ Analysis Status: In Progress
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DISCUSSION 5.3.5 FAILURE EFFECTS

• Failure Effects (RCM Step 4) involves reviewing the effects of the Functional Failure of the elected 
component (in this case, Fuel Tank) and commenting on its effect on the Vehicle System. 

• Main table columns:

• Functions & Functional Failures

• System Level Response

• Response Narrative
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EXERCISE 5.3.5 FAILURE EFFECTS

Enter the following response narrative for the Generator system response:

➢ Select the Response Narrative table cell

➢ Select     to open the Response Narrative text editor

➢ Enter the Response Narrative: A loss of static pressure in the fuel tank will propagate through the diesel engine and 
result in a reduction of force at the end of the vehicle system.
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DISCUSSION 5.3.6 FAILURE CRITICALITY

• Involves assessing the criticality of the effects of the failure through ‘Measures of Impacts’ (MOIs) 

• It is important in understanding the impact that a failure can have in terms of the following MOIs:

• Safety Impact

• Operational Impact

• Economic Impact
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DISCUSSION 5.3.6 FAILURE CRITICALITY (SAFETY IMPACT)

• Safety Measure of Impact is measured from both human and environmental impact rankings
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EXERCISE 5.3.6 FAILURE CRITICALITY (SAFETY IMPACT)

Overall Safety Measure of Impact is measured from a combination of human and environmental impact. 
To assess the Safety Impacts:

➢ Select page: 5A – Safety Impact

➢ Select Human Safety Impact Rating: Moderate (5-6) – Significantly reduces operator performance

➢ Enter Impact Narrative: A loss of fuel is likely to only result in a break-down in an isolated area, this will 
significantly impact the ability for the vehicle to complete its mission but will not have 
any directly dangerous hazards.
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EXERCISE 5.3.6 FAILURE CRITICALITY (SAFETY IMPACT) (CONTINUED)

➢ Environmental Safety Impact Rating: Low (3-4) – Minor repair/cleaning required

➢ Enter Impact Narrative: Leaking of the fuel tank or loss of torque is only likely to cause minor short-term damage or
minor clean-up, examples would be a fuel leak.
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DISCUSSION 5.3.6 FAILURE CRITICALITY (OPERATIONAL IMPACT)

• Operational Measure of Impact is derived from functional importance affected by the functional failure, 
and whether it will cause a shutdown/mission abort of the system
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EXERCISE 5.3.6 FAILURE CRITICALITY (OPERATIONAL IMPACT)

To assess the Operational Impacts:

➢ Select the Operational Impact page (5B – Operational Impact):

➢ Confirm the cell under the Functional Importance column is set to: Very High

➢ Confirm the cell under the Shutdown/Abort? column is set to: Yes

➢ Confirm the Operational Impact is set to: Very High
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DISCUSSION 5.3.6 FAILURE CRITICALITY (ECONOMIC IMPACT)

• Economic Measure of Impact is determined by defining baseline maintenance actions, which consist of: 

• Repair Worksheet

• Replace Worksheet

• Cost of System Failure Effects per Failure
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EXERCISE 5.3.6 FAILURE CRITICALITY (ECONOMIC IMPACT)

Select the following information in the Economic Impact page (5C – Economic Impact):

➢ Select Reactive Maintenance Action as: Repair

➢ Select               to edit the Repair worksheet
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DISCUSSION 5.3.6 FAILURE CRITICALITY (ECONOMIC IMPACT): REPAIR/REPLACE WORKSHEETS

• The repair & replace worksheets consist of the following sections:

• Repair/Replace Maintenance Worksheet: 
Lists the maintainable item, functional failure & system response

• Worksheet management: 
Allows the user to select/deselect, rename, copy and delete tasks

• Repair Maintenance Action Statistics: 
Summary of durations, costs and failure rates

• Cost & MTTR Estimation: 
Fields and Tables for the proposed Maintenance Action
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EXERCISE 5.3.6 FAILURE CRITICALITY (ECONOMIC IMPACT)

Select/Enter the following information in the Repair worksheet:

➢ In the Worksheet management section select: Repair check box (worksheet is included for Step 7)

➢ In the Repair Maintenance Action Statistics section:

➢ Enter Failure Rate of Repaired Item: 280 (Failure per million hours)

➢ Enter Failure Rate narrative: Failure Rate based on Reliability Allocation analysis.



Session 5.3: Classic RCM

EXERCISE 5.3.6 FAILURE CRITICALITY (ECONOMIC IMPACT) (CONTINUED)

➢ In the Cost & MTTR Estimation section: 

➢ Enter Action ID: 001

➢ Verify Action Name: Repair

➢ Enter Description: Repair maintenance action for Fuel Tank.

➢ Select Location of Maintenance: Field

➢ Enter Downtime cost/hr: $1000
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EXERCISE 5.3.6 FAILURE CRITICALITY (ECONOMIC IMPACT) (CONTINUED)

➢ Enter information for the Cost & MTTR Estimation section tables as shown below: 
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EXERCISE 5.3.6 FAILURE CRITICALITY (ECONOMIC IMPACT) (CONTINUED)

➢ Return to Page 5C – Economic Impact

➢ Enter the following costs for Cost of System 
Failure Effects per failure section:

➢ Legal/Administration cost: $5,000

➢ Loss of Mission/Production cost: $1,000

➢ Medical cost: $5,000

➢ Environmental Cleanup cost: $2,000

➢ Enter the following cost narrative: Cost based on FY17 estimates.

➢ Verify that the Total System Failure Effects cost: $13,000

➢ Verify Total Economic Impact: $16,430
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DISCUSSION 5.3.7 FAILURE CLASSIFICATION

• RCM Step 6 involves classifying the Failure based on the classic RCM II approach, identifying then alleviating 
it by taking the appropriate maintenance action

• Failure classifications types are divided into:

• Hidden Failures

• Safety Failures

• Operational Failures

• Economic Failures
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EXERCISE 5.3.7 SELECT FAILURE CLASSIFICATION

➢ In Failure Classification table select: Hidden failure type

➢ Read question and select response: Yes

➢ Enter narrative: Functional Failure is not hidden.
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EXERCISE 5.3.7 SELECT FAILURE CLASSIFICATION

➢ In Failure Classification table select: Safety failure type

➢ Read question and select response: No

➢ Enter narrative: Moderate (Human) & Low (Environment) rankings are acceptable.



Session 5.3: Classic RCM

EXERCISE 5.3.7 SELECT FAILURE CLASSIFICATION

➢ In Failure Classification table select: Operational failure

➢ Read question and select response: Yes

➢ Enter narrative: Failure of Fuel Tank significantly decreases output of Vehicle system.

➢ Select link:
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DISCUSSION 5.3.7 FAILURE CLASSIFICATION (O-TYPE)

• The Operational (O-Type) decision tree investigates 
the decision making process for Operational Failures 

• Three questions requiring a justifiable decision for 
the best course of action to address failure

• The main steps to decide:

1. Whether failure is acceptable

2. Whether Proactive maintenance 
can resolve the failure

3. Whether Redesign is required to fix the failure
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EXERCISE 5.3.7 COMPLETE O-TYPE FAILURE CLASSIFICATION PAGE

➢ Read Question A and select response: Yes (unacceptable reduction to operational capability)

➢ Enter narrative: Probability of Failure for the given duration of operation is unacceptable.

➢ Read Question B and select proactive maintenance: Scheduled Repair (Safety)

➢ Select link: 
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DISCUSSION 5.3.7 FAILURE CLASSIFICATION (SCHEDULED MAINTENANCE)

• Proactive maintenance aims to fix failures before they occur – for scheduled repair the fuel tank is repaired 
at set intervals to avoid the failure from occurring

• Scheduled Repair and Replace Worksheets consist of the following sections:

• Scheduled Repair/Replace Maintenance Worksheet: Lists the maintainable item, functional failure & system 
response

• Worksheet management: allows the user to select/deselect, rename, copy and delete worksheets

• Statistics: Baseline failure rate

• Technical Feasibility: Fields for age-related failures, useful life and cause/mode narratives

• Cost & MTTR Estimation: Fields and Tables for the proposed Maintenance Action

• Economic Feasibility: Yes/No Questions that define failures and maintenance

• Summary: Table showing comparison between scheduled repair and repair in terms of timespans and costs
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EXERCISE 5.3.7 COMPLETE SCHEDULED REPAIR WORKSHEET

Select/Enter the following information in the Scheduled Repair worksheet:

➢ In the Worksheet management section: 
➢ Select: Scheduled Repair check box (worksheet is included for Step 7)

➢ Select: Set worksheet as baseline maintenance action check box

➢ In the Technical feasibility section enter the following age-related & useful life values:

Cause/Mode Age-related? Useful Life (hr) Narrative

Lining – Corroded due to Cavitation corrosion Yes 2000 OEM data source

Lining – Perforated due to Corrosive attack Yes 5000 OEM data source

Lining – Pitted due to Cavitation corrosion No - OEM data source

Lining – Corroded due to Corrosive attack Yes 5000 OEM data source

Lining – Pitted due to Corrosive attack Yes 5000 OEM data source



Session 5.3: Classic RCM

EXERCISE 5.3.7 COMPLETE SCHEDULED REPAIR WORKSHEET (CONTINUED)
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EXERCISE 5.3.7 COMPLETE SCHEDULED REPAIR WORKSHEET (CONTINUED)

➢ In the Cost & MTTR Estimation section: 

➢ Enter Action ID: 002

➢ Verify Action Name: Scheduled Repair

➢ Enter Description: Scheduled Repair maintenance action for Fuel Tank.

➢ Select Location of Maintenance: Local Depot

➢ Enter Downtime cost/hr: $1000
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EXERCISE 5.3.7 COMPLETE SCHEDULED REPAIR WORKSHEET (CONTINUED)

➢ Enter information for the Cost & MTTR Estimation section tables as shown below: 
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EXERCISE 5.3.7 COMPLETE SCHEDULED REPAIR WORKSHEET (CONTINUED)

➢ Return to Page 6O – Type Failures

➢ Read Question B and answer: Yes

➢ Enter Narrative: Proactive probability of failure is reduced to 0.0.
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DISCUSSION 5.3.7 FAILURE CLASSIFICATION (CONDITION BASED MAINTENANCE)

• On Condition Maintenance (or Condition Based Maintenance) investigates the feasibility of performing 
maintenance as indicated by the health of a component 

• Proactive Maintenance allows the monitoring of the health of a failure by monitoring, analysis and 
maintenance tasks

• Key Areas of the On Condition Worksheet:

• Symptoms of Incipient Failure

• Summary of CBM Activities

• Maintenance Activities

• Monitoring Tasks

• Analysis Tasks

• Maintenance Tasks
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DISCUSSION 5.3.7 FAILURE CLASSIFICATION (CONDITION BASED MAINTENANCE) (CONTINUED)
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DISCUSSION 5.3.7 FAILURE CLASSIFICATION (REDESIGN)

• Redesign is intended as a last resort for unacceptable failures that cannot be fixed by Reactive/Proactive 
Maintenance Tasks

• The scope of the Redesign in MADe is to provide the feasibility and general tasks involved with redesign to 
determine whether it would be more appropriate than other actions

• Key sections of the Redesign Worksheet:

• Item Reliability Status

• Redesign Approach 

• Mitigation of Operational Impact

• Redesign Effect

• Redesign cost & Project delay time estimation

• Feasibility of Redesign
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DISCUSSION 5.3.7 FAILURE CLASSIFICATION (REDESIGN)
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DISCUSSION 5.3.8 ITEM MAINTENANCE OVERVIEW

• Item Maintenance Overview page allows the 
comparison of important characteristics for all 
completed worksheets. The overview allows to 
compare costs, downtimes and MTBM for each task 
and to also report out on the RCM process

• Worksheet Factors compared in the Overview page:
• Maintenance Classification
• MTBM
• Downtime
• Cost
• Reliability
• Availability
• Summary Graphs
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DISCUSSION 5.3.9 REPORTING OUTPUTS

• RCM Reports can be automatically generated from the Item Maintenance Overview page. 

• Reports are generated in both PDF and XLS formats

• Allows multiple component RCM analyses to be incorporated

• The main types of RCM reports include:

• Classic RCM Report (Long Form)

• Classic RCM Report (Abbreviated)

• Classic RCM Report (Expanded)
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EXAMPLE 5.3.9 GENERATE A CLASSIC RCM REPORT

To generate a Classic RCM report:

➢ Select Reports → Report Wizard from the main menu

➢ Select the Maintainable Item as ‘Fuel Tank’

➢ Select                  to generate the report
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SESSION 5.3 SUMMARY

✓5.3.1: Background to RCM

✓5.3.2: Classic RCM Overview and Management

✓5.3.3: Functions & Functional failures

✓5.3.4: Failure Causes

✓5.3.5: Failure Effects

✓5.3.6: Failure Criticality

✓5.3.7: Failure Classification

✓5.3.8: Item Maintenance Overview

✓5.3.9: Classic RCM Report



Session 5.4: Reliability Centered Maintenance (Back-Fit)

SESSION 5.4 OUTLINE

5.4.1: Back-Fit RCM Background

5.4.2: Back-Fit RCM Editor

5.4.3: NAVSEA Road MAP: Identify Failure Modes

5.4.3: Failure Assessment

5.4.4: Maintenance Classification

5.4.5: Maintenance Applicability

5.4.6: Failure Consequences

5.4.7: Maintenance Effectiveness

5.4.8: Improve Task

5.4.9: Proposed Maintenance

5.4.10: Maintenance Association

5.4.11: Back-Fit RCM Report
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DISCUSSION 5.4.1 BACK-FIT RCM BACKGROUND

• Back-Fit RCM is based on a process described in USN SSC Handbook S9081-AB-GIB-010

• Back-Fit RCM processes involve:

• Identifying Failure Mode / Faults

• Failure Assessment

• Maintenance Classification

• Maintenance Applicability

• Failure Consequences

• Maintenance Effectiveness

• Maintenance Task Improvement

• Review Proposed Maintenance
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DISCUSSION 5.4.2 BACK-FIT RCM EDITOR

• The Back-Fit RCM Analysis editor consists of 3 main pages:

1. Back-Fit Summary: For defining RCM time-span

2. NAVSEA Road Map: Contains Back-Fit RCM analysis steps

3. Maintenance Association:

• Summarises current & proposed maintenance actions

• Displays maintenance durations, downtimes, cost divergence
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DISCUSSION 5.4.2 BACK-FIT SUMMARY PAGE

• The Back-Fit Summary page contains 2 sections

1. Back-Fit RCM Time Span

• Enter duration (time span) Back-Fit RCM analysis is performed over

2. Proposed Maintenance Actions

• Lists maintenance actions which address Failure Modes or Faults
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EXERCISE 5.4.2 BACK-FIT RCM EDITOR

To create a Back-Fit RCM Analysis:

➢ Right-click the ‘Fuel Tank’ in the System Model/Project Explorer

➢ Select Back-Fit RCM

➢ Alternatively, select the ‘Fuel Tank’ item 

➢ From the menu bar, select Analyses → Back-Fit RCM
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EXERCISE 5.4.2 BACK-FIT SUMMARY PAGE

Enter the following Timespan and narrative:

➢ Time Span: 1 Year

➢ Narrative: Back-Fit RCM analysis covers the analysis of the Fuel Tank for the operational period from 2017 to 2018.
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DISCUSSION 5.4.3 NAVSEA ROAD MAP: IDENTIFY FAILURE MODES

• NAVSEA Road Map starts by identifying failure modes or faults of a component

• Existing maintenance actions (if available) are listed
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EXERCISE 5.4.3 NAVSEA ROAD MAP: IDENTIFY FAILURE MODES

➢ Select                      to enable Back-Fit RCM

➢ Select from the drop down menu: Corroding of Lining due to Cavitation corrosion

➢ Under Existing Maintenance Actions select: 001 – Breakdown Maintenance



Session 5.4: Back-Fit RCM

DISCUSSION 5.4.3 FAILURE ASSESSMENT

• Failure Assessment contains questions to determine:

• Whether existing maintenance exists for the failure mode

• Whether the Failure Mode occurs during the service life

• Whether a maintenance action can be created to address the failure path

• Displays existing maintenance actions associated to the component

• Recommended action with a link displayed at the bottom of page after the questions are answered

• E.g. “Yes” to existing maintenance actions and existence of age degradation will cause Back-Fit RCM to 
recommend continuing to classify the type of maintenance task
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EXERCISE 5.4.3 FAILURE ASSESSMENT

To conduct Back-Fit RCM failure assessment, on the Back-Fit RCM page: 

➢ Select the Failure Assessment tab

➢ Read Question 1 (Is there an existing Maintenance Action?) and select response: Yes

➢ Select existing maintenance action from drop down menu: 001 – Breakdown Maintenance

➢ Read Question 2 (Does Failure Mode occur…) and select response: Yes

➢ Enter comment: Item Failure diagram – sourced from maintenance data.

➢ Review Recommended Action: Continue Analysis

➢ Select
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EXERCISE 5.4.3 FAILURE ASSESSMENT (CONTINUED)
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DISCUSSION 5.4.4 MAINTENANCE CLASSIFICATION

This page is used to determine which major category the maintenance action falls under

• Main categories include:

• Condition-Directed (CD)

• Time-Directed (TD)

• Failure Finding (FF)

• Servicing (S)

• Lubrication (L)

• Selecting a maintenance type category will generate a link at the bottom of the page

• E.g. Selecting Time-Directed maintenance will prompt the user to continue to Step 4: Applicability
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EXERCISE 5.4.4 MAINTENANCE CLASSIFICATION

➢ Select Time-Directed for Maintenance Type Task

➢ Note: Recall 001 – Scheduled Maintenance is regular, periodic maintenance

➢ Select link:
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DISCUSSION 5.4.5 MAINTENANCE APPLICABILITY

• The Maintenance Applicability page contains questions to determine:

• Whether the existing maintenance action is applicable

• Whether the existing maintenance action can be modified in order to meet applicability requirements

• The page displays existing maintenance actions associated to the component

• Recommended action with a link is displayed at the bottom of page after the questions are answered

• E.g. Yes to the applicability of existing maintenance actions will cause Back-Fit RCM to recommend continuing to describe 
the consequences of the failure mode occurring
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EXERCISE 5.4.5 MAINTENANCE APPLICABILITY

➢ Review applicability criteria

➢ Select: Yes (Existing Maintenance is applicable)

➢ Enter Narrative: Meets Applicability Criteria.

➢ Select link:



Session 5.4: Back-Fit RCM

DISCUSSION 5.4.6 FAILURE CONSEQUENCES

• The Failure Consequences page aims to classify the nature of the selected failure mode into the following 
categories:

• Safety/Environmental

• Operational Performance

• Others

• A recommended action with a link is displayed at the bottom of the page after a failure consequence type 
is selected

• E.g. Selecting Operational Performance as a failure consequence of blockage of the primary fuel filter due to silting 
will cause Back-Fit RCM to recommend continuing to describe the effectiveness of the existing maintenance
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EXERCISE 5.4.6 FAILURE CONSEQUENCES

➢ Select: Operational Performance

➢ Narrative: Cavitation corrosion in Fuel Tank will prevent fuel flow.

➢ Select link:
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DISCUSSION 5.4.7 MAINTENANCE EFFECTIVENESS

• The page displays existing maintenance actions associated to the component

• A recommended action with a link is displayed at the bottom of the page after the questions have been answered

• E.g. If the risk of failure is not reduced to an acceptable level (No), leads to the next question activating. A Yes
Response to whether the existing maintenance action can be improved will show a link to the final page

• The Maintenance Effectiveness page contains questions to determine:

• Whether the existing maintenance reduce the risk of failure to an acceptable level (Probability of Failure × Severity 
of Failure)

• Whether the existing maintenance action can be improved to demonstrate its effectiveness
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EXERCISE 5.4.7 MAINTENANCE EFFECTIVENESS

To assess the maintenance effectiveness: 

➢ Review Effectiveness criteria – Does it reduce the probability of failure to an acceptable level? 

➢ Select: Yes (Existing Maintenance is Effective)

➢ Enter Narrative: Effectiveness based on FMECA documentation.

➢ Select



Session 5.4: Back-Fit RCM

DISCUSSION 5.4.8 IMPROVE TASK

• The Improve Task page allows the user to decide whether the current maintenance task can be improved or 
to override the recommendations put forward e.g. modify the existing maintenance task

• A narrative box is provided to enable the user to explain the motive behind the decision

• A link is displayed at the bottom of the page after a decision has been selected
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EXERCISE 5.4.8 IMPROVE TASK

To select the Maintenance Action improvement: 

➢ Review list of Maintenance Action Improvements

➢ Select: No Change (Existing Maintenance is Effective)

➢ Enter Narrative: Maintenance Action is currently sufficient for selected failure.

➢ Select 
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DISCUSSION 5.4.9 PROPOSED MAINTENANCE

• The page displays a section to create a proposed maintenance action

• The Maintenance comparison table shows the differences between current maintenance and proposed 
maintenance if differences are present

• The Proposed Maintenance page shows the recommended action based on the answers selected in 
previous pages which can include the following:

• No Change

• Modify task

• Delete task

• Add New task

• Re-design
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EXERCISE 5.4.9 PROPOSED MAINTENANCE

To justify the proposed maintenance task: 

➢ Enter Proposed Maintenance Narrative: Current Maintenance Action is sufficient for Fuel Tank fault.
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DISCUSSION 5.4.10 MAINTENANCE ASSOCIATION

• The Maintenance Association page summarises: 

• Faults or failure modes that have been analysed 

• Current and proposed maintenance actions

• Comparison between the two maintenance actions if 
applicable

• The page also displays in a graph format: 

• Meantime between Maintenance (MTBM) 

• Cost

• Downtime deltas
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DISCUSSION 5.4.11 BACK-FIT RCM REPORT

The Back-Fit RCM Report summarises the Back-Fit RCM analysis into the following sections:

• Component Summary: Shows a summary of changes in MTTF, durations and costs.

• Maintenance Action Summary: Compares existing maintenance to proposed maintenance and the
duration and cost differences between the two.

• Component Details: 

• Specific breakdown of each failure path in terms of frequency, durations and costs.

• A summary of responses to all NAVSEA questions answered

• Displays the maintenance action comparison table

• Displays the current and proposed maintenance action details e.g. tasks, personnel, costs, durations etc.
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EXERCISE 5.4.11 BACK-FIT RCM REPORT

To generate a Back-Fit RCM Report:

➢ Select Reports → Report Wizard from the main menu

➢ Select Back-Fit RCM Report

➢ Select                   then select the check box for maintainable items to include in the report

➢ Select                   to generate the Back-Fit RCM report
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SESSION 5.4 SUMMARY

✓ 5.4.1: Back-Fit RCM Background

✓ 5.4.2: Back-Fit RCM Editor

✓ 5.4.2: NAVSEA Road MAP: Identify Failure Modes

✓ 5.4.3: Failure Assessment

✓ 5.4.4: Maintenance Classification

✓ 5.4.5: Maintenance Applicability

✓5.4.6: Failure Consequences

✓5.4.7: Maintenance Effectiveness

✓5.4.8: Improve Task

✓5.4.9: Proposed Maintenance

✓5.4.10: Maintenance Association

✓5.4.11: Back-Fit RCM Report



Session 5: Maintainability Analyses

SESSION 5 SUMMARY

✓ 5.1: Maintenance Cost Estimates analysis

✓5.2: Maintenance Actions

✓5.3: Reliability Centered Maintenance (Classic)

✓5.4: Reliability Centered Maintenance (Back-Fit RCM)



Session 6:
Prognostics & Health Management 

Analyses
Using the MADe Model to 

generate sensor analyses for

Health-monitoring domains



Session 6: PHM Analyses

SESSION 6 OUTLINE

6.1: Sensor Library

6.2: Test Points

6.3: Automated Diagnostic Analysis

6.4: User-defined Diagnostic Analysis

6.5: Modeling for PHM and Additional Features
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SESSION 6 DISCUSSION

• Session 6 will take place in the PHM Module

• Prognostics & Health Monitoring (PHM) Module is used for several purposes:
• Understand coverage of functional flows in a system by sensors

• Understand how built-In sensors on legacy systems monitor functional flows

• Use algorithms to generate sensor sets to provide optimal coverage
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SESSION 6.1 OUTLINE

6.1.1: Sensor Library

6.1.2: Access Sensor Library

6.1.3: Sensor Library Editor

6.1.4: Create a Sensor Library

6.1.5: Sensor Library Categories

6.1.6: Sensor Detail Sections

6.1.7: Creating Sensors

6.1.8: ROC Curves

6.1.9: Sensor Selection Optimizer
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DISCUSSION 6.1.1 SENSOR LIBRARY

• Contains both sample sensors & user-defined sensors in multiple categories

• Sensors can be defined based on: 
• Physical attributes

• Performance parameters

• Operating environment

• Flows types sensed

• Any other custom properties



Session 6.1: Sensor Library

EXERCISE 6.1.2 ACCESS SENSOR LIBRARY

To access the Sensor Library: 

➢ Select Modeling→ Sensor Library from the main menu

➢ Alternatively, select      from the icon toolbar 



Session 6.1: Sensor Library

DISCUSSION 6.1.3 SENSOR LIBRARY EDITOR

Editor is divided into 5 sections:
• Sensor Libraries table shows a list of libraries, categories and sensors

• Sensors Details shows information on sensor ID, dimensions, costs, and reliability data

• Sensed Elements show the applicable flows for a sensor or sensor category

• Parameters show detailed sensor performance details such as POD, specificity, true/false rates, likelihood ratios etc.

• Additional Sensor Information shows additional sensor information such as environmental constraints and custom 
properties



Session 6.1: Sensor Library

EXERCISE 6.1.4 CREATE A SENSOR LIBRARY

To create a Sensor Library: 

➢ Right-click on the open space within the Sensor Libraries table

➢ Select New Library

➢ Alternatively, select      next to the Sensor Libraries section



Session 6.1: Sensor Library

EXERCISE 6.1.4 CREATE A SENSOR LIBRARY (CONTINUED)

➢ Complete the Library Details with the following information: 

➢ Name: New User Library

➢ Description: User Library containing sensors for the Training model. 



Session 6.1: Sensor Library

DISCUSSION 6.1.5 SENSOR LIBRARY CATEGORIES

• User can create multiple levels of sensor categories for a user library

• Each library can contain specific sensed elements (flows, flow properties, symptoms)



Session 6.1: Sensor Library

EXERCISE 6.1.5 SENSOR LIBRARY CATEGORIES

To create new Sensor Library categories: 

➢ Select New User Library from the sensor libraries list

➢ Select      or right click on New User Library and select New Category from the menu

➢ Enter the following details for the Sensor category: 

➢ Name: Sample Category 1

➢ Description: Sample Sensor category for New User Library



Session 6.1: Sensor Library

EXERCISE 6.1.5 SENSOR LIBRARY CATEGORIES (CONTINUED)

➢ Select Flow Properties to be considered for this category by selecting the check boxes

➢ For this category we will select Material – Liquid



Session 6.1: Sensor Library

EXERCISE 6.1.5 SENSOR LIBRARY CATEGORIES (CONTINUED)

➢ Create 5 additional Sensor categories using the information from the table below

❖Note: Sensors created in the categories will only be able to sense the selected sensed flows

Name Description Sensed Flow

Sample Category 2 Category for rotational energy flow Energy, Mechanical – rotational

Sample Category 3 Category for linear energy flow Energy, Mechanical – linear

Sample Category 4 Category for gas flow Material, Gas 

Sample Category 5 Category for liquid flow Material, Liquid 

Sample Category 6 Category for continuous signal flow Signal, Continuous



Session 6.1: Sensor Library

DISCUSSION 6.1.6 SENSOR DETAIL SECTIONS

For a created sensor there are 5 sections:

• Sensor Libraries table shows a list of libraries, 
categories and sensors

• Sensors Details shows information on sensor ID, 
dimensions, costs, and reliability data

• Sensed Elements show the applicable flows for a 
sensor or sensor category

• Parameters show detailed sensor performance 
details such as POD, specificity, true/false rates, 
likelihood ratios etc.

• Other shows additional sensor information such as 
environmental constraints



Session 6.1: Sensor Library

EXERCISE 6.1.7 CREATE A NEW SENSOR

To create a new sensor in a category:

➢ Select Sample Sensor Category 1

➢ Select the sensor icon     or right-click and select New Sensor from the menu

➢ Uncheck all Sensed Elements and select only Liquid Dynamic pressure and Liquid Static pressure



Session 6.1: Sensor Library

EXERCISE 6.1.7 CREATE A NEW SENSOR (CONTINUED)

➢ Enter the following sensor details:

➢ Name: Pressure Sensor

➢ Part Number: PS1

➢ Vendor: Sensor Company Inc.

➢ Vendor Number: PS1-A

➢ Dimensions: 50.0 (H), 20.0 (W), 20.0 (D)

➢ Dimension Units: Millimetres

➢ Weight: 100.0 grams

➢ Sensor Cost: $100

➢ Cost of Detection: $0.01 (per hour)

➢ MTTF: 100,000 hours

➢ Replacement time: 5 minutes



Session 6.1: Sensor Library

EXERCISE 6.1.7 CREATE A NEW SENSOR (CONTINUED)

➢ Enter the following sensor Parameters:

➢ Estimated POD (Sensitivity): 98%

(Likelihood that sensor correctly detects failure condition)

➢ Estimated Specificity: 90%

(Likelihood that sensor will not suffer a false alarm)

➢ Verify additional fields:

➢ False Negative Rate: 2%

➢ False Alarm Rate: 10%

➢ Balanced Accuracy: 94%

➢ Likelihood Ratio Pos.: 9.80

➢ Likelihood Ratio Neg.: 0.02



Session 6.1: Sensor Library

EXERCISE 6.1.7 CREATE A NEW SENSOR (CONTINUED)

➢ Enter the following into the Additional Sensor Information category:

➢ Description: COTS Fuel Tank Pressure Sensor

➢ Detection Method: Passive

➢ Signal Type: Digital

➢ Operating Environment: Dry environment

➢ Constraints: External temperature not 
exceeding 80 degrees Celsius



Session 6.1: Sensor Library

EXERCISE 6.1.7 CREATE A NEW SENSOR (CONTINUED)

➢Create several more sensors with the following details

Category Flow Property Name Dimensions Units Weight
Sensor 
Cost

Cost of 
Detection

Sample Category 2 Torque Rotary Transformer 15, 10, 30 mm 10 g 3500 0.35

Sample Category 2 Angular Velocity Angular Velocity Sensor 1 10, 10, 10 mm 60 g 6000 0.30

Sample Category 2 Angular Velocity Angular Velocity Sensor 2 5, 15, 20 mm 120 g 2000 0.60

Sample Category 2 Angular Velocity Angular Velocity Sensor 3 15, 15, 15 mm 75 g 3500 0.55

Sample Category 3 Linear Velocity Optical Tracker and Velocimeter 30, 40, 10 mm 90 g 10000 0.30

Sample Category 4 Mass Flow Rate (Gas) Tube Anemometer 4, 10, 8 mm 75 g 1200 2.00

Sample Category 5 Flow Rate (Liquid) Orifice Plate 10, 20, 20 mm 300 g 3000 0.80

Sample Category 6 Continuous Amplitude Amplitude Detector 5, 10, 15 mm 15 g 1500 0.10



Session 6.1: Sensor Library

DISCUSSION 6.1.8 RECEIVER OPERATING CHARACTERISTIC (ROC) CURVES

Receiver Operating Characteristic (ROC) curves use sensor failure data to plot the relationship between True 
Positives and False Positives observed based on a sensor’s test threshold. This aids in:

• Determining the POD and Specificity for a sensor

• Selecting the most appropriate threshold based on the above



Session 6.1: Sensor Library

EXERCISE 6.1.8 RECEIVER OPERATING CHARACTERISTIC (ROC) CURVES

To import ROC setting:

➢ Download the spreadsheet attached to this slide

➢ Select the Tube Anemometer from Sensor Category 4 and 
select                                        from the Parameters section

➢ In the new window click the      button

➢ Select Input Type as Direct Input

➢ Browse for the ROC Curve Import Data.csv

➢ To validate the .csv file, select 

➢ Once validated, select 



Session 6.1: Sensor Library

EXERCISE 6.1.8 RECEIVER OPERATING CHARACTERISTIC (ROC) CURVES (CONTINUED)

➢ ROC Curve will be graphed and allow the user to

determine the FPR Threshold that will define the

Sensitivity and Specificity of the sensor:

➢ Input 0.33 as the threshold and check that the numbers

match as pictured, then select 



Session 6.1: Sensor Library

DISCUSSION 6.1.9 SENSOR SELECTION OPTIMIZER (SSO)

• To aid in the selection and allocation of a specific sensor from the sensor library to a location. 

• This uses the Analytical Hierarchy Process (AHP) to compare otherwise disparate parameters (for example 
weight, cost, and MTTF)



Session 6.1: Sensor Library

EXERCISE 6.1.9 SENSOR SELECTION OPTIMIZER (SSO)

To select the Sensor Selection Optimizer: 

➢ Select the New User Library and select t    under Sensor Selection Optimizers



Session 6.1: Sensor Library

EXERCISE 6.1.9 SENSOR SELECTION OPTIMIZER (SSO) (CONTINUED)

➢ Select the      button and from the pop-up dialogue select the checkboxes for:

➢ Weight

➢ Cost

➢ Cost Of Detection



Session 6.1: Sensor Library

EXERCISE 6.1.9 SENSOR SELECTION OPTIMIZER (SSO) (CONTINUED)



Session 6.1: Sensor Library

EXERCISE 6.1.9 SENSOR SELECTION OPTIMIZER (SSO) (CONTINUED)

➢ Change the Name of the SSO to Training SSO

➢ Select the Criteria Ranking tab

➢ Enter the following values into the Sensor Property Ranking matrix 

➢ Note that only fields above and to the right of the principal diagonal require entry

Weight Cost Cost of 
Detection

Weight 1 0.75 2.00

Cost 1.33 1 4.00

Cost of Detection 0.5 0.25 1



Session 6.1: Sensor Library

EXERCISE 6.1.9 SENSOR SELECTION OPTIMIZER (SSO) (CONTINUED)

➢ Select the                                button and select the Analysis Results tab

➢ The results show that when selecting sensors the priority should be minimizing in the following order: 

➢ Cost

➢ Weight

➢ Cost of Detection

➢ The Normalized Result displays the weightings that will be used when automating the allocation of sensors



Session 6.1: Sensor Library

SESSION 6.1 SUMMARY

✓6.1.1: Sensor Library

✓6.1.2: Access Sensor Library

✓6.1.3: Sensor Library Editor

✓6.1.4: Create a Sensor Library

✓6.1.5: Sensor Library Categories

✓6.1.6: Sensor Detail Sections

✓6.1.7: Creating Sensors

✓6.1.8: ROC Curves

✓6.1.9: SSO



Session 6.2: Test Points

SESSION 6.2 OUTLINE

6.2.1: Test Points

6.2.2: Accessing a Test Point

6.2.3: Test Point Editor

6.2.4: Assigning Test Point Sensors

6.2.5: Allocate a Sensor Using the SSO 

6.2.6: Test Point Report



Session 6.2: Test Points

DISCUSSION 6.2.1 TEST POINTS

• Shows Flow Property & Symptoms of an item

• Test Points are only applicable for subsystem & components

• Allows user to assign Test Point sensors considered in Legacy & Analysis Sensor Sets



Session 6.2: Test Points

EXERCISE 6.2.2 ACCESSING A TEST POINT

To input a Test Point: 

➢ Open the System Model of the ‘Diesel Engine’ 

➢ Right-click on the ‘Injector Pump’ component

➢ Select Test Point from the menu

➢ Alternatively, right-click on the ‘Injector Pump’ in the Project Explorer 
and select Test Point from the menu



Session 6.2: Test Points

DISCUSSION 6.2.3 TEST POINT EDITOR

The editor consists of 5 sections:
1. Details show the name and description of the test point, total sensors, weight and sensitivity

2. Sensor Details show the name, probability of detection (POD) and specificity of a selected sensor

3. Sensor Allocation is the main area displaying flow properties and assigned sensors

4. Sensor Library shows available libraries and sensors

5. Recently Used Sensors shows a list of the latest sensors allocated from all component test points



Session 6.2: Test Points

EXERCISE 6.2.4 ASSIGNING TEST POINT SENSORS

To assign a Test Point:

➢ In the ‘Injector Pump’ Test Point editor, select the Enable Test Point check box under the Details section

➢ Locate Pressure Sensor in New User Library

➢ Select and drag the Pressure Sensor and assign it to the Liquid Dynamic Pressure output

➢ Right-click the sensor and select Method of Sensing → On-line



Session 6.2: Test Points

EXERCISE 6.2.5 ALLOCATE A SENSOR USING THE SSO

Use the previously created Sensor Selection Optimizer (SSO) to automatically allocate the best sensor 
from the library to the requirement sensor location:

➢ Open the ‘Driveline’ system model

➢ Right click on the ‘Differential’ component and select Test Point from the context menu

➢Within the Test Point editor select the Enable Test Point checkbox and then right-click on the Angular Velocity 
allocation area

➢ Select Training SSO from the dialogue 

➢ Select 



Session 6.2: Test Points

EXERCISE 6.2.5 ALLOCATE A SENSOR USING THE SSO (CONTINUED)

➢ In the newly opened SSO editor, select the Sensor Pool tab

➢ Select the checkboxes for the 3 Angular Velocity Sensors in the Included Sensors Summary section



Session 6.2: Test Points

EXERCISE 6.2.5 ALLOCATE A SENSOR USING THE SSO (CONTINUED)

➢ Select the Alternatives Ranking tab and click the                                        button



Session 6.2: Test Points

EXERCISE 6.2.5 ALLOCATE A SENSOR USING THE SSO (CONTINUED)

➢ Go to the Analysis Results tab. Here displayed will be the a table showing the most to least optimal sensors for the 
proposed application. 

➢ Select the highest performing sensor (Angular Velocity Sensor 2) and select 



Session 6.2: Test Points

DISCUSSION 6.2.6 TEST POINT REPORT

The Test Point report consists of several sections:

• Overview table lists components with Test Points sensors assigned

• Sensor Summary table shows flow properties/symptoms, their assigned sensors, methods of sensing and Probability of 
Detection

• Symptom Sensor Coverage Details table lists fault coverage based on assigned symptom sensors

• Sensor Details table lists vendor and reliability data, dimensions and costs for each sensor

• Sensor Parameters table lists percentage and numerical parameters for each sensor



Session 6.2: Test Points

EXERCISE 6.2.6 TEST POINT REPORT

To generate a Test Point report: 

➢ Select Reports → Report Wizard from the main menu

➢ Select Component Test Point Report then

➢ Select the ‘Injector Pump’ component from the list

➢ Select         to go through report formatting options 

➢ Select                   to generate the report



Session 6.2: Test Points

SESSION 6.2 SUMMARY

✓6.2.1: Test Points

✓6.2.2:Accessing a Test Point

✓6.2.3: Test Point Editor

✓6.2.4: Assigning Test Point Sensors

✓6.2.5: Allocate a Sensor Using the SSO 

✓6.2.6: Test Point Report



Session 6.3: Automated Diagnostic Analysis

SESSION 6.3 OUTLINE

6.3.1: Diagnostic Analysis

6.3.2: Overview/Management

6.2.3: Diagnostic Analysis (Landing Page)

6.3.4: Propagation Table

6.3.5: Diagnostic Inclusions

6.3.6: Diagnostic Exclusions

6.3.7: Sensor Set Analysis

6.3.8: Ambiguity Groups

6.3.9: Sensor Allocation

6.3.10: Sensor Parameters

6.3.11: Diagnostic Sets

6.3.12: Metric Optimisation

6.3.13: Sensor Set Comparison



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.1 DIAGNOSTIC ANALYSIS

• Used to analyse coverage of system failures using allocated sensors

• Two main analysis types:

• Automated Diagnostic Analysis: Uses a proprietary algorithm to generate sensor sets that provide maximum 
system coverage when allocated with sensors. This analysis also captures legacy (component/subsystem test 
point) sensors if present.

• User-defined Diagnostic Analysis: Provides users with the ability to freely allocate sensors throughout a selected 
system, or allocate sensors based on an optimised solution from the automated diagnostic analysis.



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.1 DIAGNOSTIC ANALYSES (CONTINUED)

Recommended Sensor Analysis approach: 

1. Automated Diagnostic Analysis: Analyse effectiveness of legacy (component/subsystem test point) sensors

2. Automated Diagnostic Analysis: Analyse potential sensor combinations and perform trade-studies for a desired 
performance metric. For example:

a. Optimising for Cost

b. Optimising for Weight

c. Optimising for Coverage

3. Automated Diagnostic Analysis: Define final (optimised) sensor configuration



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.1 ACCESSING DIAGNOSTIC ANALYSIS EDITOR

To access the Diagnostic Analysis Editor:

➢ Open the System Model of the ‘Power Generation’ subsystem

➢ Right-click the canvas and select Diagnostic Analysis from the menu options

➢ Alternatively, select Analyses→ Diagnostic Analysis from the main menu



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.2 OVERVIEW/MANAGEMENT

• Used to create all new diagnostic analyses

• Lists all diagnostic analyses conducted on the model

• Provides summary of diagnostic details: 

• Type

• Threshold

• Focus

• Coverage

• # of Sensor Sets



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.2 CREATING A NEW DIAGNOSTIC ANALYSIS

To create a new Diagnostic Analysis: 

➢ Select                 to open the Create a Diagnostic Analysis dialog

➢ Expand the ‘Power Generation’ system and select the check box for the following items: 

➢ ‘Vehicle System’

➢ ‘Power Generation’ 

➢ ‘Diesel Engine’

➢ Set the Type of Diagnostic Analysis to Automated

➢ Select  to proceed



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.2 CREATING A NEW DIAGNOSTIC ANALYSIS (CONTINUED)

➢ Populate the details of the Diagnostic Analysis with the following details: 

➢ Name: Diagnostic Analysis 1

➢ Description: Analysis of sensor configuration for the 
Power Generation System.

➢ Set the Propagation Type to FCM

➢ Select                  to close the dialog and create the analysis



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.3 DIAGNOSTIC ANALYSIS (LANDING PAGE)

• Used to view basic analysis details, indenture selection & propagation focuses



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.3 DIAGNOSTIC ANALYSIS (LANDING PAGE)

➢ Verify information in Basic Details section & Indenture dialog (from dialog)

➢ Name: Diagnostic Analysis 1

➢ Description: Analysis of sensor configuration for the Power Generation System.

➢ Type: Automated

➢ Propagation Type: FCM

➢ Response State: Steady and Transient States

➢ Verify Propagation Focuses: None selected  (By default meaning all flow types are considered)



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.4 PROPAGATION TABLE

• Shows item failures (rows) vs item responses to those failures (header)

• Failure responses  (high),     (low) &      (nominal) at intersections show for connected items.

• Example: Lift Pump failing Low will cause the Injector Pump to show a Low response

• Table is configured based on system model and diagnostic analysis page (propagation focuses, LOI)



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.4 PROPAGATION TABLE

➢Verify that when ‘Fuel Tank’ static pressure decreases it causes ‘Diesel Engine’ torque to show a Low failure

➢ This shows that there is one or more flow connections/downstream impact

➢Verify that ‘Primary Fuel Filter’ flow rate decreases will have a nominal effect on ‘Air Filter’ mass flow rate

➢ This shows that there is no flow connection/downstream impact



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.5 DIAGNOSTIC INCLUSIONS

• Enables user to specify sensor locations that must be included in generated sensor sets 

• Specify failures that must be covered by any generated sensor sets



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.5 DIAGNOSTIC INCLUSIONS

To include failure detection in the diagnostic analysis, in the Inclusions tab: 
➢ Under the Must Cover Failures section, select

➢ From the dialog box select ‘Air Filter’ to include in the analysis

➢ Select      to move the item to the Included Failure Modes table

➢ Select



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.5 DIAGNOSTIC INCLUSIONS (CONTINUED)

In the Must Use Sensor Locations section:

➢ Select       and select ‘Fuel Tank’

➢ Select       to move the item to the Must Use Sensor Locations

➢ Select



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.5 DIAGNOSTIC INCLUSIONS (CONTINUED)

In the Legacy Sensor Set Section:

➢ Select Use TP sensors and locations check box to include the Legacy Test Point sensors in the analysis



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.6 DIAGNOSTIC EXCLUSIONS

• Enables user to threshold (exclude) sensor locations based on criticality, flow property type or item

• Exclusions are not considered in Sensor Set Analysis



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.6 DIAGNOSTIC EXCLUSIONS

To assign an exclusion to the diagnostic analysis, in the Detectable Cause Exclusions Section:

➢ Select      and select ‘Secondary Fuel Filter’

➢ Select      to move the item to the Excluded Failure Modes table

➢ Select                  



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.6 DIAGNOSTIC EXCLUSIONS (CONTINUED)

➢ Sensor Location Exclusion Selection works the same as the previous inclusion and exclusion editors

➢ For the purpose of this demonstration we will not exclude any failure modes



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.7 SENSOR SET ANALYSIS

• Main page to analyse the propagation table then calculates and generates possible sensor sets

• User sets the analysis parameters
• No restrictions = maximum coverage with least number of sensor locations

• Defines the minimal failure coverage

• The Include Legacy Sensor Set checkbox allows the displays the Legacy Sensors as a set

• Test point number limiting within a defined range

• Number of unique sensor sets generated

• Optimization level of analyses



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.7 SENSOR SET ANALYSIS

To generate a Sensor Set analysis: 
➢ Select the Sensor Set Analysis tab 

➢ Set Number of Sets to 10

➢ Set Depth of Analysis to Moderate

➢ Select to generate the diagnostic sets



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.7 SENSOR SET ANALYSIS (CONTINUED)

➢ Review Sensor Sets Table

➢ Select Set 1 and select      to save and advance the workflow status for the set

➢ Comment: Sensor set is feasible and is saved for further analysis. 



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.7 SENSOR SET ANALYSIS (CONTINUED)

➢ Select       to view the fitness chart for the analysis

➢ Use left-click an drag to rotate Fitness chart

➢ Select                                                   again



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.8 AMBIGUITY GROUPS

• Shows failures from each sensor set that cannot be distinguished by currently allocated sensors
• Example: Legacy Sensor Set has two Ambiguity Groups

• Failures are resolved by exclusion, reconfiguring the system or adding sensors (user-defined analysis)



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.8 AMBIGUITY GROUPS

To view the Ambiguities Groups of the generated diagnostic sets: 

➢ Select the Ambiguity Group tab 

➢ Select Analysis 1 – Set 1, Ambiguity Group 2

➢ Identify ambiguities between 5 items that have ambiguous failures (see below)



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.9 SENSOR ALLOCATION

• Used to identify item functional flows i.e. sensor locations

• Sections: Sensor Library, Recently Used Sensors, Sensor Allocation & Items

• Shows sensor libraries & sensors – these can be filtered based on flow type selected



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.9 SENSOR ALLOCATION

To allocate sensors to the system: 
➢ Select the Sensor Allocations tab

➢ Expand all items in the Items list

➢ Expand User Sensor Library and select flow-specific sensors to each item flow

➢ Allocate the previously created sensors according to the table below

Flow Property Name

Torque Rotary Transformer

Angular Velocity Angular Velocity Sensor 1

Amplitude Amplitude Detector

Mass Flow Rate (Gas) Tube Anemometer

Linear Velocity Optical Tracker and Velocimeter

Flow Rate (Liquid) Orifice Plate

Static Pressure Pressure Sensor



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.10 SENSOR PARAMETERS

• This page enables the user to edit each sensor parameter selected

• Sections: Allocated Sensors, Sensor Details, Parameters & Additional Sensor Information



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.10 SENSOR PARAMETERS

To edit the Sensor Parameters: 

➢ Select the Rotary Transformer of the ‘Diesel Engine’ and enter/modify the following sensor details:

➢ Dimensions: 30.0 (H), 20.0 (W), 20.0 (D)

➢ Dimension units: Millimetres

➢ Weight: 10.0 grams

➢ Sensor Cost: $1500

➢ Cost of Detection: $0.01 (per hour)

➢ MTTF: 200,000 hours

➢ MTTR: 1 minute

➢Estimated POD: 95%

➢Estimated Specificity: 92%

➢Description: COTS sensor

➢Detection method: Passive

➢Signal type: Digital

➢Operating Environment: -

➢Constraints: -



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.11 DIAGNOSTIC SETS

• Page shows the failure diagnosis based on the sensor set selected

• Shows how to diagnose an item or ambiguity group using Diagnostic Rules



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.11 DIAGNOSTIC SETS

To access the Diagnostic rules: 

➢ Select the Diagnostic Sets tab

➢ Select an analysis set in the Diagnostic Sets section

➢ Select the ‘Air Filter’ component and read the diagnostic rule



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.12 METRIC OPTIMISATION

• Lists all Sensor Sets shows the details of sensed test points

• Provides filters (cost, weight, coverage) for user to optimise sensor set selection



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.12 METRIC OPTIMIZATION

To set the metric optimization for the generated sensor sets: 

➢ Select the Metric Optimization tab

➢ Verify that Legacy Sensor Sets are included (check box selected)

➢ Under the Filters section:

➢ Select check box for Max Cost and enter: $20000

➢ Select check box for Min Coverage and enter: 50%



Session 6.3: Automated Diagnostic Analysis

DISCUSSION 6.3.13 SENSOR SET COMPARISON

• This page allows users to compare sensor sets based on criteria which includes:
• Coverage

• Number of Sensors

• Cost of Sensors

• Weight of Sensors

• Probability of Detection

• Cost of Detection

• Multiple sensors sets can be compared

• All charts can be exported



Session 6.3: Automated Diagnostic Analysis

EXERCISE 6.3.13 SENSOR SET COMPARISONS

To compare sensor sets: 

➢ Select the Comparisons tab

➢ Select the analysis sets to be compared

➢ The graphs can be used to visually compare the following metrics:

➢ Coverage

➢ LRU Coverage

➢ Number of Sensors

➢ Cost

➢ Weight

➢ Probability of Detection

➢ Cost of Detection



Session 6.3: Automated Diagnostic Analysis

SESSION 6.3 SUMMARY

✓ 6.3.1: Diagnostic Analysis

✓ 6.3.2: Overview/Management

✓ 6.3.3: Diagnostic Analysis (Landing Page)

✓ 6.3.4: Propagation Table

✓ 6.3.5: Diagnostic Inclusions

✓ 6.3.6: Diagnostic Exclusions

✓ 6.3.7: Sensor Set Analysis

✓6.3.8: Ambiguity Groups

✓6.3.9: Sensor Allocation

✓6.3.10: Sensor Parameters

✓6.3.11: Diagnostic Sets

✓6.3.12: Metric Optimisation

✓6.3.13: Sensor Set Comparison



Session 6.4: User-Defined Diagnostic Analysis

SESSION 6.4 OUTLINE

6.4.1: Create a User-defined Sensor Analysis

6.4.2: Export a Sensor Set from an Automated Analysis

6.4.3: Sensor Set Details Report



Session 6.4: User-Defined Sensor Analysis

DISCUSSION 6.4.1 CREATE A USER-DEFINED ANALYSIS

There are two methods to create a user-defined analysis:

Method 1: Use the ‘Create a Diagnostic Analysis

• Open the Overview/Management page 

• Select                  to open the Create a Diagnostic Analysis dialog

• Select the check box for the ‘Vehicle system’ level of indenture

• Set the Type of Diagnostic Analysis to User-defined

• Select                    to proceed to the final dialog page to enter the 
analysis name, description & propagation type

❖Note: This method follows the same process as the Automated diagnostic analysis



Session 6.4: User-Defined Sensor Analysis

DISCUSSION 6.4.2 EXPORT A SENSOR SET FROM AN AUTOMATED ANALYSIS

Method 2: Export a sensor set from Automated diagnostic Analysis

• Allows user to select a candidate sensor set and export it into its own analysis

• This analysis only focuses on the exported sensor set – no additional sets can be created

• Exported sensor set can be compared to legacy sensor set

• Additional information can be used to populate sensor parameters



Session 6.4: User-Defined Sensor Analysis

EXERCISE 6.4.2 EXPORT A SENSOR SET FROM AN AUTOMATED ANALYSIS

Using method 2: Export a sensor set from Automated diagnostic Analysis by: 

➢ Selecting the Sensor Set Analysis page

➢ Select the starred analysis set in the table

➢ Select        to export the analysis

➢ Verify that a new analysis has been created

➢ Check tabs on left for Exported Group



Session 6.4: User-Defined Sensor Analysis

DISCUSSION 6.4.3 SENSOR SET DETAILS REPORT

The Sensor Set Details report consists of several sections:

• Sensor Set Group provides an overview of the Sensor Analysis details

• Sensor Sets Overview table shows sensor data for each analysis set

• Test Points/Sensors table shows sensor data for the legacy sensor set

• Diagnostic Sets table lists diagnostic data for each analysis set

• Ambiguity Groups table lists each ambiguity group and corresponding causes & criticality



EXERCISE 6.4.3 SENSOR SET DETAILS REPORT

To generate a Sensor Set Details report: 

➢ Select Reports → Report Wizard from the main menu

➢ Select Sensor Set Details Report then

➢ Set the Diagnostic Analysis to Exported Group – Diagnostic Analysis 1

➢ Select both the Legacy Sensor Set and Analysis 1 – Set 1

➢ Select     to go through report formatting options

➢ Select   to generate the report

Session 6.4: Component Test Points



Session 6.4: Automated Diagnostic Analysis

SESSION 6.4 SUMMARY

✓6.4.1: Create a User-defined Sensor Analysis

✓6.4.2: Export a Sensor Set from an Automated Analysis

✓6.4.3: Sensor Set Details Report



Session 6.5: Modeling for PHM and Additional Features

SESSION 6.5 OUTLINE

6.5.1: Create Diagnostic Groups in the Model

6.5.2: Add Symptoms to Failure Diagrams

6.5.3: Use Diagnostic Groups and Symptoms in Diagnostic Analyses



Session 6.5: Modeling for PHM and Additional Features

DISCUSSION 6.5.1: CREATE DIAGNOSTIC GROUPS IN THE MODEL

• Diagnostic Groups in MADe are groupings of failures that do not require complete diagnostic coverage, 
rather the failures may acceptably be ambiguous with one another.

• Failure would be grouped due to several circumstances:

• Items are in an LRU (entire group is replaced at one time so further specific diagnosis is not required)

• Items are physically close to one another so any maintenance that is directed by the diagnostic suite will allow 
access to further testing by maintenance personnel

• Sensor numbers are limited and grouping failures gives greater control over where the inevitable ambiguities end 
up as a result



Session 6.5: Modeling for PHM and Additional Features

EXERCISE 6.5.1: CREATE DIAGNOSTIC GROUPS IN THE MODEL

To turn on the preference for Diagnostic Groups to be included in analysis:

➢ Select Preferences → Application Preferences from the main menu

➢ Go to the Propagation Table section and within select the preference set Use LRU Groups in PHM Analysis to Yes
(this option may have already been selected) 

➢ Select                    to apply the changes and close the dialog



Session 6.5: Modeling for PHM and Additional Features

EXERCISE 6.5.1: CREATE DIAGNOSTIC GROUPS IN THE MODEL (CONTINUED)

To create Diagnostic Groups in the model:

➢ Open the ‘Driveline’ system model

➢ Select the ‘Transmission’ component 

➢ From the Properties viewer select      from the Maintainability section

➢ In the LRU Groups dialog, select   

➢ Select the checkboxes for the following items: 

➢ ‘Transmission’

➢ ‘Driveshaft’

➢ ‘Differential’

➢ Select          and then                  to close the dialog



Session 6.5: Modeling for PHM and Additional Features

EXERCISE 6.5.1: CREATE DIAGNOSTIC GROUPS IN THE MODEL (CONTINUED)

➢ Repeat so that the following groupings are created:

➢ Group 1: Transmission, Driveshaft, Differential

➢ Group 2: Wheel Rear, Wheel Resistance Rear

➢ Group 3: Planetary Gearbox Front, Planetary Gearbox Rear



Session 6.5: Modeling for PHM and Additional Features

DISCUSSION 6.5.2: CREATE SYMPTOMS AND SYMPTOM GROUPS IN THE MODEL

• Symptoms are physical events that occur due to a failure and may be used to provide or aid in the diagnosis 
of failures. 

• Symptoms are added into the model via the Failure Diagram and will then appear in the PHM Propagation 
Table and Analysis given certain conditions are met.

1. Does the symptom provide observability of all paths that lead to each failure mode it (the symptom) interacts with?

If yes; include the symptom in the propagation table as a column (used for coverage and syndrome POD calculations)

If no; go to test 2

2. Does the symptom have ambiguity between multiple failure modes? (i.e. the associated faults are connected to 
multiple failure modes)

If no; include in path POD (then used in overall POD calculation)

If yes; invalid symptom (not used in coverage or POD)



Session 6.5: Modeling for PHM and Additional Features

DISCUSSION 6.5.2: CREATE SYMPTOMS AND SYMPTOM GROUPS IN THE MODEL (CONTINUED)

• Symptom Groups are when two or more symptoms are grouped for the purpose of failure detection and 
diagnosis. 

• This is to represent the circumstance where multiple failures manifest the same physical symptom and that 
the symptom may potentially be sensed using the one sensor (or location).

• An example of this may be two similar components with common failure modes in the system resulting in 
the same vibration. 

• This vibration could potentially be sensed at either location and may indicate that either of the similar 
components have failed.



Session 6.5: Modeling for PHM and Additional Features

EXERCISE 6.5.2: CREATE SYMPTOMS AND SYMPTOM GROUPS IN THE MODEL

Create a Symptom Group in the model:

➢ Open the ‘Driveline’ system model

➢ Right-click the ‘Planetary Gearbox Front’ component and select the Failure Diagram from the menu

➢ Select      in the Failure Concepts window 

➢ Select Vibration and place it onto the Failure Diagram canvas 

➢ Connect the Functional Failure Mode to the Vibration concept

➢ Repeat for the ‘Planetary Gearbox Rear’ component



Session 6.5: Modeling for PHM and Additional Features

EXERCISE 6.5.2: CREATE SYMPTOMS AND SYMPTOM GROUPS IN THE MODEL (CONTINUED)

➢ Select one of the Vibration concepts

➢ In the Properties viewer go to the Symptom Groups tab and select

➢ From the dialogue, select New Group

➢ In the Symptom field drop down menu, select Vibration

➢Within the Items section select the two Vibration symptom check boxes 

➢ Select          and then select 



Session 6.5: Modeling for PHM and Additional Features

EXERCISE 6.5.3: RUN A DIAGNOSTIC ANALYSIS WITH THE UPDATED MODEL

To run a Diagnostic Analysis:

➢ Select Analyses → Diagnostic Analyses from the main menu

➢ Select    

➢ In the dialogue,  select the following: 

➢ Indenture Selection: ‘Driveline’

➢ Type of Diagnostic Analysis: Automated

➢ Select 

➢ Enter the following details for the Analysis: 

➢ Name: Driveline PHM Analysis

➢ Propagation Type: Bond 

➢ Check the Include symptom information check box 

➢ Select 



Session 6.5: Modeling for PHM and Additional Features

EXERCISE 6.5.3: RUN A DIAGNOSTIC ANALYSIS WITH THE UPDATED MODEL (CONTINUED)

➢ Select the Optimize LRU Coverage check box 

➢ Under Analysis Options set Number of Sets to 10

➢ Select 

➢ If there are errors in the bond model, a warning message will appear. 



Session 6.5: Modeling for PHM and Additional Features

SESSION 6.5 SUMMARY

✓6.5.1: Create Diagnostic Groups in the Model

✓6.5.2: Add Symptoms to Failure Diagrams

✓6.5.3: Use Diagnostic Groups and Symptoms in Diagnostic Analyses



Session 6: Prognostics & Health Management Analyses

SESSION 6 SUMMARY

✓6.1: Sensor Library

✓6.2: Test Points

✓6.3: Automated Diagnostic Analysis

✓6.4: User-defined Diagnostic Analysis

✓6.5: Modeling for PHM and Additional Features



Conclusion: Using MADe

CONSOLIDATING TRAINING SESSIONS 1 – 6

• Understand MADe capabilities

• Understand how MADe can be used/applied

• Informing PHM Technology of which features/processes are of most interest

• Identify projects that MADe can be used

• Use existing material to expedite modeling process

• Request for modeling assistance from PHMT (follow-up support, reviews etc.)

• Set project targets and identify deliverables that MADe will be used for

• Consult PHMT engineering with deliverables you expect to meet

• Request PHMT for custom reports and templates for software outputs



❑ 1: MADe Modeling
❑ 1.1: Navigation
❑ 1.2: Project Creation
❑ 1.3: Mission Profile Definition
❑ 1.5: Functional Modeling (FHA)
❑ 1.6: System Modeling
❑ 1.7: MADe Library
❑ 2: Failure Simulation
❑ 2.1: Annotations
❑ 2.2: Failure Simulation
❑ 2.3: Mission Profile Groups
❑ 2.4: Failure Analysis
❑ 2.5: Features & Characteristics

❑ 3: Safety Analyses
❑ 3.1: FMEA
❑ 3.2: Criticality Analysis
❑ 3.3: Revised FMECA
❑ 3.4: Critical Item Analysis
❑ 3.5: Failure Conditions (FHA)
❑ 3.6: Common Mode Analysis (CMA)
❑ 3.7: Functional Fault Tree Analysis
❑ 4: Reliability Analyses
❑ 4.1: Reliability Block Diagram
❑ 4.2: Reliability Allocation
❑ 4.3: Reliability Editing
❑ 4.4: Failure Rate Prediction
❑ 4.5: Markov Analysis
❑ 4.6: Hardware Fault Tree Analysis

❑ 5: Maintenance Analyses
❑ 5.1: Maintenance Cost Estimates
❑ 5.2: Maintenance Properties
❑ 5.3: Reliability Centered Maintenance (Classic)
❑ 5.4: Reliability Centered Maintenance (Back-Fit)
❑ 6: PHM Analyses
❑ 6.1: Sensor Library
❑ 6.2: Test Points
❑ 6.3: Automated Diagnostic Analysis
❑ 6.4: User-Defined Sensor Analysis
❑ 6.5: Modeling for PHM and Additional Features

Conclusion: MADe Feature Check List



Conclusion: MADe Workflows
WHAT CAN MADE DO?

MADe covers several analyses & deliverables including:

• Functional modeling (FBDs)

• Failure Analysis (Root Cause Analysis)

• Failure Simulations

• Failure Mode Effects Analysis

• Criticality Analysis

• Mission Profile (Usage Profile, Mission Scenarios)

• Reliability Allocation

• Markov Analysis

• Failure Rate Prediction

• Fault Tree Analysis

• Maintenance Cost Estimation

• Reliability Centered Maintenance

• Back-fit Reliability Centered Maintenance

• Maintenance Task Analysis

• Inherent Diagnostic Capability (Testability)

• Functional Hazards Assessment

• Common Mode Analysis



Conclusion: MADe Processes
HOW CAN MADE BE USED?

MADe can be used to facilitate numerous engineering processes:

• FMEA Process

• FMECA Process

• ARP Safety Process

• RAM Analysis Process

• Safety Integrity Process

• FRACAS Process

• Defect Remediation Process

• More in Development…



Conclusion: MADe Roadmap
WHAT IS PLANNED FOR THE FUTURE?

• The MADe software is continually growing using customer feedback

• We provide customers visibility to review and comment engineering specifications

• Specifications currently on the Roadmap include:

General

• New reporting templates (Delta 
Reports, FMEA reports, FMECA, 
Reliability)

• Customisable reporting (more export 
formats, ability to trim down reports)

• Analysis Quality Index (AQI)

• Upgrades to Annotations (embedded 
annotations, review capabilities)

Criticality

• New criticality methods (ASIL, IDAL, 
SAE, AIAG)

• Hazard Analysis (taxonomy and 
diagram)

• Fuzzy Fault Tree (LPIC)

Reliability

• Reliability Simulation

• Level Of Repair Analysis (LORA)

• LSAR Export (B-Tables)



Conclusion: MADe Example Systems
REFERENCING EXEMPLAR ITEMS/SYSTEMS

• MADe Palette
• Generic components

• Generic parts

• MADe Models (Example Library)
• Generic systems

• In-progress or unreleased systems

• Used as a guide/reference for modeling

• Domains of Interest
• Electrical

• Mechanical

• Hydraulics

• Pneumatic

• Software



Conclusion: Additional Resources
ADDITIONAL INFORMATION

• PHMT website - http://www.phmtechnology.com/resources/
• Technical Papers

• Published Papers

• Presentations given at conferences

• Training

• Currently available training courses

• Build Updates and Guides: http://www.phmtechnology.com/resources/downloads.html

• MADe HELP

• MADe Glossary

http://www.phmtechnology.com/resources/
http://www.phmtechnology.com/resources/downloads.html


Conclusion: Ongoing Support
WHAT IF WE HAVE QUESTIONS?

• Training Feedback
• Records training course

• Attendees

• Questions

• Bugs

• Enhancements

• Follow-up Meetings 
• Teleconferencing

• Model Validation

• Workflow Consolidation

• General Q&A

• Specification/Implementation Review



Conclusion: Certification
COURSE COMPLETION

• All attendees can be provided with MADe Training certification

• Soft/Hard Copy Available

• Congratulations!


